Support
Thank you for selecting NETGEAR products.
After installing your device, locate the serial number on the label of your product and use it to register your product at https://my.netgear.com. You must register your product before you can use NETGEAR telephone support. NETGEAR recommends registering your product through the NETGEAR website.
For product updates and web support, visit http://support.netgear.com. 
Phone (US & Canada only): 1–888–NETGEAR. 
Phone (Other Countries): Check the list of phone numbers at http://support.netgear.com/general/contact/default.aspx.

Compliance
For regulatory compliance information, visit http://www.netgear.com/about/regulatory. 
See the regulatory compliance document before connecting the power supply.

Trademarks
© NETGEAR, Inc., NETGEAR and the NETGEAR Logo are trademarks of NETGEAR, Inc. Any non-NETGEAR trademarks are used for reference purposes only.
Contents

Chapter 1 Hardware Overview of the Modem Router
  Unpack Your Modem Router ................................................................. 10
  Front Panel with LEDs ................................................................. 11
  Back Panel with Ports, Buttons, and Connector ............................ 13
  Right Side Panel with WPS and WiFi On/Off Buttons and USB Port ...... 14
  Bottom Panel Product Label ............................................................ 15

Chapter 2 Install and Access the Modem Router and Its Network
  Position Your Modem Router ............................................................ 17
  Connect to the Modem Router .......................................................... 18
    Connect to the Modem Router Through an Ethernet Cable ............... 18
    Join the WiFi Network of the Modem Router .................................. 18
  Types of Logins ............................................................................... 19
  Automatic Internet Setup ................................................................. 20
  Set Up Your Modem Router for DSL Service ..................................... 21
    DSL Service ................................................................................. 21
    Cable the Modem Router for DSL Service and Access the Modem Router . 22
  Set Up Your Modem Router for Cable or Fiber Service .................... 29
  Log In to the Modem Router After Setup to View or Change Settings .... 35
  Change the Language ...................................................................... 37
  Change the admin Password ............................................................. 37
  Set Up Password Recovery ............................................................... 38
  Let the Modem Router Automatically Update Its Firmware ............ 39
  Access the Modem Router with the NETGEAR genie App ............... 40

Chapter 3 Manage the Internet Settings Manually
  Use the Internet Setup Wizard After Initial Setup ............................. 42
  Manually Set Up an ADSL Internet Connection .................................. 47
    Specify an ADSL Connection Without a Login Requirement ............... 47
    Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service ................................................. 52
  Manually Set Up a VDSL Internet Connection .................................. 57
    Specify a VDSL Connection Without a Login Requirement ................ 57
    Specify a VDSL Connection with a Login Requirement and PPPoE Service ................................................................. 61
  Manually Set Up a Cable of Fiber Internet Connection .................... 66
    Specify a Cable or Fiber Connection Without a Login Requirement .... 66
    Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service ....................................................... 71
AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Specify an IPv6 Internet Connection ........................................ 75
IPv6 Internet Connections and IPv6 Addresses ................................. 75
Set Up an IPv6 Connection Through Auto Detect ............................. 76
Set Up an IPv6 6to4 Tunnel Connection ....................................... 78
Set Up an IPv6 Pass-Through Connection ..................................... 79
Set Up an IPv6 Fixed Connection .............................................. 80
Set Up an IPv6 DHCP Connection ............................................... 82
Set Up an IPv6 PPPoE Connection ............................................. 84
Set Up an IPv6 Connection Through Auto Config ............................ 86
Set Up an IPv6 6rd Tunnel Connection ....................................... 88
Manage the MTU Size .............................................................. 90
MTU Concepts ................................................................. 90
Change the MTU Size ........................................................... 91

Chapter 4  Manage the WiFi Network Settings

Manage the Basic WiFi Settings and WiFi Security of the Main Network .. 93
View or Change the Basic WiFi Settings ......................................... 93
Configure WPA/WPA2 Enterprise WiFi Security ............................... 98
Configure WEP Legacy WiFi Security ........................................... 100
Use WPS to Add a Device to the WiFi Network ................................. 102
Use WPS with the Push Button Method ......................................... 102
Use WPS with the PIN Method .................................................. 103
Manage the Basic WiFi Settings and WiFi Security of the Guest Network . 105
Set Up and Enable a Guest Network ............................................. 105
Configure WEP Legacy WiFi Security for the Guest WiFi Network .......... 108
Control the WiFi Radios ......................................................... 110
Use the WiFi On/Off Button ..................................................... 110
Enable or Disable the WiFi Radios ............................................ 111
Set Up a WiFi Schedule ......................................................... 112
Manage the WPS Settings ...................................................... 114
Manage Advanced WiFi Features ............................................... 115
Use the Modem Router as a WiFi Access Point ............................... 117

Chapter 5  Control Access to the Internet

Set Up Parental Controls ......................................................... 120
Allow or Block Access to Your Network ....................................... 121
Enable and Manage Network Access Control ................................ 121
Manage Network Access Control Lists ....................................... 123
Use Keywords to Block Internet Sites .......................................... 126
Set Up Blocking ................................................................. 126
Remove a Keyword or Domain from the Blocked List ......................... 128
Remove All Keywords and Domains from the Blocked List .................. 128
Specify a Trusted Computer ................................................... 129
Manage Simple Outbound Firewall Rules for Services and Applications . 130
Add an Outbound Firewall Rule ............................................... 130
Add an Outbound Firewall Rule for a Custom Service or Application .. 132
Chapter 6  Optimize Performance

Optimize Traffic with Internet Access QoS .................................. 141
Manage Default and Custom QoS Rules .................................... 142
View the Default QoS Rules ..................................................... 142
Create a Custom QoS Rule for an Application or Online Game .... 143
Create a Custom QoS Rule for a Modem Router LAN Port ....... 145
Create a Custom QoS Rule for a MAC Address ..................... 146
Change a Default or Custom QoS Rule ................................. 149
Remove a QoS Rule ............................................................. 151
Remove All QoS Rules ......................................................... 151
Manage Wi-Fi Multimedia Quality of Service ....................... 152
Manage Implicit Beamforming .............................................. 153
Improve Network Connections with Universal Plug and Play ... 154

Chapter 7  Share a Storage Device

USB Device Requirements ..................................................... 157
Connect a USB Device to the Modem Router ....................... 157
Access a Storage Device Connected to the Modem Router .... 158
Back Up Windows Computers with ReadySHARE Vault ......... 159
Back Up Mac Computers with Time Machine ....................... 159
Set Up a USB Hard Drive on a Mac ................................. 159
Prepare to Back Up a Large Amount of Data .................... 160
Use Time Machine to Back Up onto a Storage Device .......... 161
Manage Access to a Storage Device ................................... 162
Enable FTP Access Within Your Network ......................... 164
View Network Folders on a Device ................................. 165
Add a Network Folder on a Storage Device ..................... 166
Change a Network Folder, Including Read and Write Access, on a USB Drive ................................. 168
Approve USB Devices ......................................................... 170
Safely Remove a USB Device ................................................. 171

Chapter 8  Access Storage Devices Through the Internet

Set Up and Manage Dynamic DNS .................................... 174
Your Personal FTP Server ................................................. 174
Set Up a New Dynamic DNS Account ............................. 175
Specify a DNS Account That You Already Created .......... 176
Access Storage Devices Through the Internet .................... 177
Set Up FTP Access Through the Internet .......................... 177
Access Storage Devices Through the Internet with FTP ...... 179
Chapter 9 Use the Modem Router as a Media Server

Specify ReadyDLNA Media Server Settings ........................................ 182
Play Media from a USB Device on TiVo ........................................... 183

Chapter 10 Share a USB Printer

Install the Printer Driver and Cable the Printer .................................. 186
Download the ReadySHARE Printer Utility ........................................ 186
Install the ReadySHARE Printer Utility ............................................. 187
Use the Shared Printer ....................................................................... 188
View or Change the Status of a Printer .............................................. 189
Use the Scan Feature of a Multifunction USB Printer .......................... 190
Change NETGEAR USB Control Center Settings ................................. 191
Change the NETGEAR USB Control Center Language ....................... 192
Specify the Time-out ......................................................................... 192

Chapter 11 Manage the WAN and LAN Network Settings

Change the Physical WAN Connection Preference ............................... 194
Enable and Configure a VLAN .......................................................... 194
Set Up a Bridge for a Port Group or VLAN Tag Group ......................... 196
  Set Up a Bridge for a Port Group ..................................................... 197
  Set Up a Bridge for a VLAN Tag Group .......................................... 198
Enable Bridge Mode for an IPTV Device ............................................ 200
Manage the WAN Security Settings .................................................. 201
Set Up a Default DMZ Server .......................................................... 202
Manage IGMP Proxying ...................................................................... 203
Manage NAT Filtering ....................................................................... 204
Manage the SIP Application-Level Gateway ...................................... 205
Manage the Modem Router’s LAN IP Address Settings ....................... 205
Manage the Router Information Protocol Settings ............................... 207
Manage Reserved LAN IP Addresses ............................................... 208
  Reserve a LAN IP address ............................................................. 208
  Change a Reserved IP Address ....................................................... 210
  Remove a Reserved IP Address Entry ............................................. 210
Change the Modem Router’s Device Name ......................................... 211
Manage the DHCP Server Address Pool ............................................ 211
Disable the Built-In DHCP Server ..................................................... 213
Set Up and Manage Custom Static Routes ......................................... 213
  Set Up a Static Route ...................................................................... 214
  Change a Static Route ................................................................... 216
  Remove a Static Route ................................................................... 217

Chapter 12 Manage the Modem Router and Monitor the Traffic

Update the Firmware of the Modem Router ....................................... 219
Check for New Firmware and Update the Modem Router ................... 219
Manually Upload New Firmware and Update the Modem Router ........... 220
Manage the Configuration File of the Modem Router ..................... 222
Back Up the Settings ........................................ 222
Restore the Settings ......................................... 222
Recover the admin Password .................................. 223
Return the Modem Router to Its Factory Default Settings .......... 224
Use the Reset Button ....................................... 224
Erase the Settings .......................................... 225
View the Status and Statistics of the Modem Router .............. 226
View Information About the Modem Router and the Internet,
Modem, and WiFi Settings .................................. 226
View the Traffic Statistics ..................................... 230
View, Renew, or Release a TCP/IP Internet Connection ......... 232
View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection ...... 234
Manage the Activity Log ..................................... 235
Specify Which Activities Are Logged ............................ 237
View Devices Currently on the Network ............................ 237
Monitor and Meter Internet Traffic .............................. 238
Start the Traffic Meter Without Traffic Volume Restrictions .... 238
View the Traffic Statistics and Traffic Status ..................... 239
Restrict Internet Traffic by Volume ............................. 240
Restrict Internet Traffic by Connection Time .................... 242
Unblock the Traffic Meter After the Traffic Limit Is Reached .... 244
Manage the Modem Router Remotely .............................. 244
Remotely Access the Modem Router Using the genie App ........ 246
Configure the Modem Router as a DSL Modem Only ............. 246

Chapter 13  Use VPN to Access Your Network

Set Up a VPN Connection ....................................... 249
Specify VPN Service in the Modem Router ....................... 249
Install OpenVPN Software on Your Computer .................... 250
Use a VPN Tunnel ............................................. 252
Use VPN to Access the Modem Router’s USB Device and Media .... 253
Use VPN to Access Your Internet Service at Home ............... 254
Set Up VPN Client Internet Access in the Modem Router ........ 254
Block VPN Client Internet Access in the Modem Router ........ 255
Use a VPN Tunnel to Access Your Internet Service at Home .... 256

Chapter 14  Manage Port Forwarding and Port Triggering

Manage Port Forwarding to a Local Server for Services and Applications ... 258
Forward Incoming Traffic for a Default Service or Application .... 258
Add a Port Forwarding Rule with a Custom Service or Application .... 259
Change a Port Forwarding Rule ................................ 261
Remove a Port Forwarding Rule ................................ 262
Application Example: Make a Local Web Server Public ........... 263
How the Modem Router Implements the Port Forwarding Rule ...... 264
Manage Port Triggering for Services and Applications ............. 264
Chapter 15 Troubleshooting

Quick Tips for Troubleshooting ........................................ 273
Troubleshoot with the LEDs ........................................... 274
  Power LED Remains Solid Amber ................................. 274
  Power LED Is Off ..................................................... 275
  WiFi LED Is Off ...................................................... 275
You Cannot Log In to the Modem Router ......................... 275
Troubleshoot the Internet Connection ............................. 276
  Troubleshoot the DSL Link ....................................... 276
  Internet LED Is Off ............................................... 277
Obtain an Internet IP Address ......................................... 277
Troubleshoot PPPoE or PPPoA ..................................... 278
Troubleshoot Internet Browsing .................................... 279
Changes Are Not Saved ................................................ 280
Troubleshoot the WiFi Connectivity ............................... 280
Troubleshoot Your Network Using the Ping Utility .......... 281
  Test the LAN Path to Your Modem Router ................. 281
  Test the Path from Your Computer to a Remote Device 282

Appendix A Supplemental Information

Factory Settings .......................................................... 284
Technical Specifications ............................................... 286
Hardware Overview of the Modem Router

The NETGEAR® AC1600 WiFi VDSL/ADSL Modem Router Model D6400, in this manual referred to as the modem router, delivers WiFi connection speeds up to¹ 300 Mbps on 2.4 GHz 802.11n and up to 1300 Mbps on 5 GHz 802.11ac. Both 2.4 GHz and 5 GHz bands can be active simultaneously. The modem router is compatible with most major DSL Internet service providers and also supports cable or fiber Internet service.

The chapter contains the following sections:

- Unpack Your Modem Router
- Front Panel with LEDs
- Back Panel with Ports, Buttons, and Connector
- Right Side Panel with WPS and WiFi On/Off Buttons and USB Port
- Bottom Panel Product Label

**Note:** For more information about the topics that are covered in this manual, visit the support website at support.netgear.com.

**Note:** Firmware updates with new features and bug fixes are made available from time to time at downloadcenter.netgear.com. You can check for and download new firmware manually. If the features or behavior of your product does not match what is described in this guide, you might need to update your firmware.

**Note:** In this manual, the terms *wireless* and *WiFi* are interchangeable.

---

¹ Actual data throughput and WiFi coverage will vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate and WiFi coverage. NETGEAR makes no express or implied representations or warranties about this product’s compatibility with any future standards.
Unpack Your Modem Router

Your package contains the following items.

- Power adapter (varies by region)
- Ethernet cable
- Phone cable
- DSL or ADSL filter (varies by region)

Figure 1. Package contents for the modem router

Your package might contain more items. The filter or phone cable provided depends on the region, and in some locations, a CD is included.
Front Panel with LEDs

The modem router displays status LEDs on the front panel.

Figure 2. Modem router front panel view
The following table describes the LEDs from right to left and their behavior. For information about how to troubleshoot with the LEDs, see Troubleshoot with the LEDs on page 274.

Table 1. LED descriptions

<table>
<thead>
<tr>
<th>LED</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Power  | ![Power Icon](power_icon.png) | • **Solid green.** The power is on and the modem router is functioning normally.  
• **Solid amber.** The modem router is booting. After about one minute and 10 seconds, the Power LED turns solid green.  
If the LED does not turn green, a power-on self-test (POST) failure occurred or the modem router is malfunctioning. For more information, see Power LED Remains Solid Amber on page 274.  
• **Blinking amber.** The Reset button on the back panel is pressed.  
When you release the Reset button, the Power LED blinks amber three times and then turns green as the modem router resets to the factory defaults.  
• **Off.** The modem router is not receiving power. |
| DSL    | ![DSL Icon](dsl_icon.png) | • **Solid green.** The modem router is providing a DSL connection. In technical terms, the DSL port is synchronized with an ISP’s network-access device.  
• **Blinking green.** The modem router is negotiating the best possible speed on the DSL line.  
• **Off.** The modem router is not negotiating the speed on the DSL line and is not providing a DSL connection. |
| Internet | ![Internet Icon](internet_icon.png) | • **Solid green.** The modem router is connected to the Internet.  
• **Solid amber.** The modem router failed to connect to the Internet. For more information, see Troubleshoot the Internet Connection on page 276.  
• **Alternating green and amber.** The traffic meter is enabled and the traffic limit was reached.  
• **Off.** The modem router did not detect an Internet connection or functions in bridge mode (that is, an external device handles the IP connection). |
| WiFi   | ![WiFi Icon](wifi_icon.png) | • **Solid blue.** One or both WiFi radios are enabled and the modem router is providing WiFi connectivity.  
• **Blinking blue.** WPS (Wi-Fi Protected Setup) is active.  
• **Off.** Both WiFi radios are disabled and the modem router is not providing WiFi connectivity. You can still plug an Ethernet cable into one of the LAN ports to get wired connectivity. |
| USB    | ![USB Icon](usb_icon.png) | • **Solid blue.** A USB device is connected to a USB port and is ready.  
• **Blinking blue.** A USB device is connected to a USB port and is trying to connect.  
• **Off.** No USB device is connected or someone clicked the Safely Remove Hardware button, and it is now safe to remove the attached USB device. |
Back Panel with Ports, Buttons, and Connector

The back panel of the modem router provides ports, buttons, and a DC power connector. The following figure shows only part of the back panel.

![Modem router back panel](image)

**Figure 3. Modem router back panel**

Viewed from left to right, the back panel contains the following components:

- **USB port.** One USB 2.0 port. (Another USB 2.0 port is located on the right side panel.)
- **DSL port.** One RJ-11 asynchronous DSL port for connecting the modem router to an ADSL or VDSL line. This port is colored gray.
- **Ethernet LAN ports.** Four Gigabit Ethernet RJ-45 LAN ports to connect the modem router to LAN devices. These ports are colored yellow.
- **Internet port.** One Gigabit Ethernet RJ-45 port to connect the modem router to a fiber or cable modem. This port is colored red.

**Note:** You can use either the DSL port or the Internet port for WAN connectivity. You cannot use both simultaneously.

- **Reset button.** For information about using the Reset button, see *Use the Reset Button* on page 224.
- **Power On/Off button.** Press the Power On/Off button to provide power to the modem router or to turn it off.
- **DC power connector.** Connect the power adapter that came in the product package to the DC power connector.
Right Side Panel with WPS and WiFi On/Off Buttons and USB Port

The right side panel provides the WiFi On/Off button, the WPS button, and a USB port.

![Modem router right side panel](image)

Figure 4. Modem router right side panel

The following table describes the buttons and port.

Table 2. Button and port descriptions

<table>
<thead>
<tr>
<th>Button or port</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WiFi On/Off</td>
<td><img src="image" alt="Icon" /></td>
<td>By default, the 2.4 GHz and 5 GHz WiFi radios are enabled. Pressing this button for three seconds turns off both radios. Pressing the button again for three seconds turns on both radios. If you turn off the radios, the WiFi LED on the front panel turns off too. If you turn on the radios, the WiFi LED on the front panel lights blue.</td>
</tr>
<tr>
<td>WPS</td>
<td><img src="image" alt="Icon" /></td>
<td>Pressing this button for three seconds activates WPS (Wi-Fi Protected Setup) to let you add a WiFi device to the WiFi network without typing the WiFi password. While WPS is active, the WiFi LED on the front panel blinks blue. For more information about using WPS, see the following sections:  • Join the WiFi Network of the Modem Router on page 18  • Use WPS to Add a Device to the WiFi Network on page 102</td>
</tr>
<tr>
<td>USB</td>
<td>(n/a)</td>
<td>One 2.0 USB port. (Another USB port is located on the back panel.)</td>
</tr>
</tbody>
</table>
Bottom Panel Product Label

The product label on the bottom panel of the modem router lists the login information, WiFi network name (SSID) and password (network key), serial number, and MAC address of the modem router.

Figure 5. Modem router product label
This chapter describes how you can install and access the modem router and its network.

The chapter contains the following sections:

- Position Your Modem Router
- Connect to the Modem Router
- Types of Logins
- Automatic Internet Setup
- Set Up Your Modem Router for DSL Service
- Set Up Your Modem Router for Cable or Fiber Service
- Log In to the Modem Router After Setup to View or Change Settings
- Change the Language
- Change the admin Password
- Set Up Password Recovery
- Let the Modem Router Automatically Update Its Firmware
- Access the Modem Router with the NETGEAR genie App
Position Your Modem Router

The modem router lets you access your network anywhere within the operating range of your WiFi network. However, the operating distance or range of your WiFi connection can vary significantly depending on the physical placement of your modem router. For example, the thickness and number of walls the WiFi signal passes through can limit the range.

Additionally, other WiFi access points in and around your home might affect your modem router’s signal. WiFi access points are routers, repeaters, WiFi range extenders, and any other device that emits a WiFi signal for network access.

Position your modem router according to the following guidelines:

• Place your modem router near the center of the area where your computers and other devices operate and within line of sight to your WiFi devices.

• Make sure that the modem router is within reach of an AC power outlet and near Ethernet cables for wired computers.

• Place the modem router in an elevated location, minimizing the number walls and ceilings between the modem router and your other devices.

• Place the modem router away from electrical devices such as these:
  - Ceiling fans
  - Home security systems
  - Microwaves
  - Computers
  - Base of a cordless phone
  - 2.4 GHz cordless phone
  - 5 GHz cordless phone

• Place the modem router away from large metal surfaces, large glass surfaces, insulated walls, and items such as these:
  - Solid metal door
  - Aluminum studs
  - Fish tanks
  - Mirrors
  - Brick
  - Concrete

If you are using adjacent access points, use different radio frequency channels to reduce interference.
Connect to the Modem Router

During and after installation, you can connect to the modem router’s network through a wired or WiFi connection. If you set up your computer to use a static IP address, change the settings of your computer so that it uses Dynamic Host Configuration Protocol (DHCP).

Connect to the Modem Router Through an Ethernet Cable

You can connect your computer to the modem router using an Ethernet cable and join the modem router’s local area network (LAN).

➢ To connect your computer to the modem router with an Ethernet cable:
  1. Make sure that the modem router has power (its Power LED is lit).
  2. Connect an Ethernet cable to an Ethernet port on your computer.
  3. Connect the other end of the Ethernet cable to one of the numbered Ethernet ports.

Your computer connects to the local area network (LAN). A message might display on your computer screen to notify you that an Ethernet cable is connected.

Join the WiFi Network of the Modem Router

Choose either the manual or the WPS method to add a WiFi device such as a computer, iPhone, iPad, or gaming device to the WiFi network of the modem router.

Manual Method

➢ To connect a device manually to the WiFi network of the modem router:
  1. Make sure that the modem router has power (its Power LED is lit).
  2. On the WiFi device that you want to connect to your modem router, open the software application that manages your WiFi connections.

This software scans for all WiFi networks in your area.

  3. Look for your network and select it.

If you did not change the name of your network during the setup process, look for the default WiFi network name (SSID) and select it. The default SSID is on the product label.

  4. Enter the modem router password.
The default WiFi password (also referred to as the network key or passphrase) is also on the product label.

5. Click the Connect button.
   The device connects to the WiFi network of the modem router.

**Wi-Fi Protected Setup Method**

Wi-Fi Protected Setup (WPS) is a standard for easily adding computers and other devices to a home network while maintaining security. To use WPS (Push 'N' Connect), make sure that all WiFi devices to be connected to the network are Wi-Fi certified and support WPS. During the connection process, the client gets the security settings from the modem router so that every device in the network supports the same security settings.

- **To use WPS to connect a device to the WiFi network of the modem router:**
  1. Make sure that the modem router has power (its Power LED is lit).
  2. Check the WPS instructions for your computer or wireless device.
  3. Press the WPS button on the side panel of the modem router for three seconds.
  4. Within two minutes, press the WPS button on your WiFi device, or follow the WPS instructions that came with the device.

   The WPS process automatically sets up the device with the network password and connects the device to the WiFi network of the modem router.

   For more information, see *Use WPS to Add a Device to the WiFi Network* on page 102.

**Types of Logins**

Separate types of logins serve different purposes. This section describes the differences so that you know which login to use when.

Types of logins:

- **ISP login.** The login that your Internet service provider (ISP) gave you logs you in to your Internet service. Your ISP gave you this login information in a letter or some other way. If you cannot find this login information, contact your ISP.

- **WiFi network key or password.** Your modem router is preset with a unique WiFi network name (SSID) and password for WiFi access. This information is on the product label. Use this information to connect a WiFi device to the WiFi network of the modem router.

- **Modem router login.** This logs you in to the modem router interface from a web browser as admin.
Automatic Internet Setup

You can use NETGEAR genie to set up the modem router automatically, or you can use the modem router’s web pages to set up the modem router manually. Automatic Internet setup with NETGEAR genie functions with both types of Internet service that the modem router supports:

- **DSL service.** If you install your modem router for DSL service (the modem router supports ADSL and VDSL service), you can set up your modem router with NETGEAR genie, which launches the first time that you set up the Internet connection for your modem router. NETGEAR genie runs on any device with a web browser.

  For more information, see *Set Up Your Modem Router for DSL Service* on page 21.

- **Cable or fiber service.** If you install your modem router for cable or fiber service, you can set up your modem router with NETGEAR genie, which launches the first time that you set up the Internet connection for your modem router. NETGEAR genie runs on any device with a web browser.

  For more information, see *Set Up Your Modem Router for Cable or Fiber Service* on page 29.

**Note:** After initial installation and setup, the NETGEAR genie Setup Wizard is always accessible to assist you with setting up an installation with DSL service or an installation with cable or fiber service. For more information, see *Use the Internet Setup Wizard After Initial Setup* on page 42.

Whether you install your modem router for DSL service or for cable or fiber service, you can always use the modem router’s web pages to set up your modem router manually.

Before you start the setup process, get your ISP information and make sure that the settings that are described here are specified for the computers and devices in the network.

When your Internet service starts, your Internet service provider (ISP) typically gives you all the information that you need to connect to the Internet. For DSL service, you might need the following information to set up your modem router:

- The ISP configuration information for your DSL account
- ISP login name and password
- Fixed or static IP address settings (special deployment by ISP; this setting is rare)

If you cannot locate this information, ask your ISP to provide it. When your Internet connection is working, you no longer need to launch the ISP login program on your computer to access the Internet. When you start an Internet application, your modem router automatically logs you in.
Set Up Your Modem Router for DSL Service

You can install your modem router for DSL service or for cable or fiber (Ethernet WAN) service. If you use a DSL modem, follow the procedure that is described in Cable the Modem Router for DSL Service and Access the Modem Router on page 22. If you use a cable or fiber modem, follow the procedure that is described in Set Up Your Modem Router for Cable or Fiber Service on page 29.

DSL Service

Make sure that your ADSL or VDSL service is active before you install the modem router. You need the following information to install your DSL modem and connect to the Internet:

- **DSL user name and password.** This information is included in the welcome letter your DSL ISP sent you when you signed up for your service. Record your DSL Internet service account user name and password.

- **Your telephone number or DSL account number.** If you do not use voice service, you can use your DSL account number in place of a phone number.

If you do not know or cannot locate your DSL user name and password, call your DSL Internet service provider (ISP). Be specific when speaking with your DSL Internet service provider. For example, you could say, “I need my DSL service user name and password. Can you help me?”

---

**Note:** If your provider says that they do not support NETGEAR services, tell them that you need only your DSL user name and password; you do not need support.
Cable the Modem Router for DSL Service and Access the Modem Router

The following figure shows the cabling of your modem router for DSL service.

![Diagram of Modem Router Cabling for DSL Service](image)

**Figure 6. Modem router cabling for DSL service**

- **To connect your modem router to a DSL service:**
  1. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.
  2. If your DSL modem includes a battery backup, remove the battery.
  3. Install an ADSL or DSL microfilter between the phone line and the phone.
     - The product package contains either an ADSL or a DSL microfilter.
  4. Use a phone cable to connect the microfilter to the gray DSL port on the modem router.
     - The product package contains a phone cable.
  5. If your DSL modem includes a battery backup, reinsert the battery.
  6. Plug in your DSL modem’s power and turn on your DSL modem.
7. Connect the power adapter to the modem router and plug it into an electrical outlet. Wait for the Power LED to light solid green, which takes about one minute.

8. If the Power LED does not light, press the Power On/Off button.

9. Wait for the WiFi LED to light blue. If the WiFi LED does not light, press the WiFi On/Off button.

10. Check the DSL LED. If the modem router is connected to a DSL service, the DSL LED lights green.

11. Connect a computer to the modem router by one of the following methods:

   - **Ethernet cable.** Use an Ethernet cable to connect your computer to a yellow Ethernet LAN port on the modem router.
     The product package contains a yellow Ethernet cable.
     Your computer connects to the modem router’s LAN.

   - **WiFi.** Connect to the default WiFi network of the modem router:
     a. On your computer or WiFi device, find and select the WiFi network. The WiFi network name (SSID) is on the product label.
     b. Join the WiFi network and enter the WiFi password. The password (network key) is on the product label.
     Your computer or WiFi device connects to the modem router’s WiFi network.

**Note:** If the computer is set to a static (fixed) IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static IP address in the 192.168.0.2–192.168.0.254 range.

12. Launch a web browser.
    The Configuring the Internet Connection page displays.
If the Configuring the Internet Connection page displays, skip to Step 14. If it does not display, do the following:

a. In the address field of the web browser, enter www.routerlogin.net.
b. When prompted, enter admin for the user name and password for the password.

If the Configuring the Internet Connection page displays, skip to Step 14. If it still does not display, see Step 13.

13. If the browser cannot display the web page, do the following:
   • Make sure that the computer is connected to one of the four Ethernet LAN ports or over WiFi to the modem router.
   • Make sure that the Power LED of the modem router is lit green.
   • Make sure that your browser does not cache the previous page by closing and reopening the browser.
   • Clear the browser cache.
   • If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.0.2–192.168.0.254 range.

14. From the Country menu, select the country in which you use the modem router.
15. From the ISP menu, select the ISP that you are using.
   If your ISP is not in the menu, select Other.
16. Select the Yes radio button.
17. Click the Next button.
   The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration.
Note: If you are connected over WiFi to the modem router, you might be disconnected during the setup process. If this situation occurs, just reconnect to the modem router and refresh the modem router’s web page.

When the modem router is connected to the Internet, the Congratulations! page displays, and you successfully completed the setup process.

If the Congratulations! page does not display, other pages might display and you might need to provide more information, in which case you must continue with the next step. The pages that display depend on your type of ISP connection and configuration.

18. (Only if you are using an ADSL connection and the following page displays) Specify a full scan to let the Setup Wizard find the PVC protocol.

   The page that displays might ask you if you need the Setup Wizard to do a full scan to find the PVC protocol. If this page does not display, continue with the next step.
Do the following:

**a.** Select the **Yes** radio button.

**b.** Click the **Next** button.

The Setup Wizard performs a full scan, which might take up to six minutes.

19. *(Only if the following page displays)* Specify how to manage problems with the detection of the Internet connection.

The page that might display states that a problem occurred while the wizard was detecting the Internet connection. If this page does not display, continue with the next step.

**Note:** The option for the Ethernet cable connection that is stated onscreen applies to a cable or fiber Internet connection only (see *Set Up Your Modem Router for Cable or Fiber Service* on page 29).

Take one of the following actions:

- If you already power cycled the DSL modem (see *Step 1 through Step 6*), do the following:
  **a.** Select the **None of the above** radio button.
  **b.** Click the **Next** button.
If you did not yet power cycle the DSL modem, do the following:

a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.

b. If your DSL modem includes a battery backup, remove the battery.

c. Wait 10 seconds.

d. If your DSL modem includes a battery backup, reinsert the battery.

e. Plug in your DSL modem’s power and turn on your DSL modem.

f. Wait two minutes.

g. Select the I just power cycled the modem and waited for 2 minutes radio button.

h. Click the Next button.

20. (Only if the following page displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

The page that might display states that a problem occurred while the wizard was detecting the Internet connection IP address.

Take one of the following actions:

- If your ISP assigned you a fixed (static) IP address, do the following:
  a. Select the Yes radio button.
  b. Click the Next button.
c. Enter the address information that your ISP gave you for your fixed IP address configuration.

d. Click the Next button.

• If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the No or the I don’t know radio button.
  b. Click the Next button.

c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

21. If the Congratulations! page still does not display and the modem router still does not connect to the Internet, do the following:
  a. Review all your settings.
     Make sure that you selected the correct options and entered everything correctly.
  b. Run the Setup Wizard one more time.
c. Contact your ISP to verify that you are using the correct configuration information.
d. Read Troubleshoot the Internet Connection on page 276.
e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

When the modem router connects to the Internet, you are prompted to download and install the free NETGEAR Desktop genie app and the free ReadySHARE Vault app.

**Set Up Your Modem Router for Cable or Fiber Service**

You can install your modem router for cable or fiber (Ethernet WAN) service or for DSL service. If you use a cable or fiber modem, follow the procedure that is described in this section. If you use a DSL modem, follow the procedure that is described in Cable the Modem Router for DSL Service and Access the Modem Router on page 22.

The following figure shows the cabling of your modem router for cable or fiber service.

---

**Figure 7. Modem router cabling for cable or fiber service**
To connect your modem router to a cable or fiber service:

1. Unplug your cable or fiber modem’s power, leaving the modem connected to the wall jack for your Internet service.
2. If your cable or fiber modem includes a battery backup, remove the battery.
3. Use an Ethernet cable to connect the cable or fiber modem to the red Internet port on the modem router.
4. If your cable or fiber modem includes a battery backup, reinsert the battery.
5. Plug in and turn on your cable or fiber modem.
6. Connect the power adapter to the modem router and plug it into an electrical outlet.
   
   Wait for the Power LED  to light solid green, which takes about one minute.
7. If the Power LED does not light, press the Power On/Off button.
8. Wait for the WiFi LED  to light blue.
   
   If the WiFi LED does not light, press the WiFi On/Off button.
9. Connect a computer to the modem router by one of the following methods:
   
   • **Ethernet cable.** Use an Ethernet cable to connect your computer to a yellow Ethernet LAN port on the modem router.
      
      The product package contains a yellow Ethernet cable.
      
      Your computer connects to the modem router’s LAN.
   
   • **WiFi.** Connect to the default WiFi network of the modem router:
     
     a. On your computer or WiFi device, find and select the WiFi network.
        
        The WiFi network name (SSID) is on the product label.
     b. Join the WiFi network and enter the WiFi password.
        
        The password (network key) is on the product label.

      Your computer or WiFi device connects to the modem router’s WiFi network.

**Note:** If the computer is set to a static (fixed) IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static IP address in the 192.168.0.2–192.168.0.254 range.

10. Launch a web browser.

   The Configuring the Internet Connection page displays.
If the Configuring the Internet Connection page displays, skip to Step 12. If it does not display, do the following:

a. In the address field of the web browser, enter www.routerlogin.net.
   b. When prompted, enter admin for the user name and password for the password.

   If the Configuring the Internet Connection page displays, skip to Step 12. If it still does not display, see Step 11.

11. If the browser cannot display the web page, do the following:
    • Make sure that the computer is connected to one of the four Ethernet LAN ports or over WiFi to the modem router.
    • Make sure that the Power LED of the modem router is lit green.
    • Make sure that your browser does not cache the previous page by closing and reopening the browser.
    • Clear the browser cache.
    • If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.0.2–192.168.0.254 range.

12. From the Country menu, select the country in which you use the modem router.
13. From the ISP menu, select the ISP that you are using.
    If your ISP is not in the menu, select Other.
14. Select the Yes radio button.
15. Click the Next button.
   The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration.
Note: If you are connected over WiFi to the modem router, you might be disconnected during the setup process. If this situation occurs, just reconnect to the modem router and refresh the modem router’s web page.

When the modem router is connected to the Internet, the Congratulations! page displays, and you successfully completed the setup process.

If the Congratulations! page does not display, other screens might display and you might need to provide more information, in which case you must continue with the next step. The screens that display depend on your type of ISP connection and configuration.

16. (Only if the following page displays) Specify how to manage problems with the detection of the Internet connection.

The page that might display states that a problem occurred while the wizard was detecting the Internet connection. If this page does not display, continue with the next step.
Note: The option for power cycling the modem router that is stated onscreen applies to a DSL Internet connection only (see Set Up Your Modem Router for DSL Service on page 21).

Take one of the following actions:

- If the yellow Ethernet cable is fully inserted in the correct places at the cable or fiber modem and at the modem router, do the following:
  a. Select the None of the above radio button.
  b. Click the Next button.
- If the yellow Ethernet cable is not fully inserted or is inserted at a wrong place, do the following:
  a. Fully insert the Ethernet cable in the correct port on the cable or fiber modem and in the red Internet port on the modem router.
  b. Select the I corrected a problem with the Ethernet cable radio button.
  c. Click the Next button.

17. (Only if the following page displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

The page that might display states that a problem occurred while the wizard was detecting the Internet connection IP address.
Install and Access the Modem Router and Its Network

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Take one of the following actions:

• If your ISP assigned you a fixed (static) IP address, do the following:
  a. Select the Yes radio button.
  b. Click the Next button.
  c. Enter the address information that your ISP gave you for your fixed IP address configuration.
  d. Click the Next button.

• If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the No or the I don't know radio button.
  b. Click the Next button.
c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the **Next** button.

18. If the Congratulations! page still does not display and the modem router still does not connect to the Internet, do the following:

   a. Review all your settings.
      Make sure that you selected the correct options and entered everything correctly.

   b. Run the Setup Wizard one more time.

   c. Contact your ISP to verify that you are using the correct configuration information.

   d. Read *Troubleshoot the Internet Connection* on page 276.

   e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

When the modem router connects to the Internet, you are prompted to download and install the free NETGEAR Desktop genie app and the free ReadySHARE Vault app.

---

**Log In to the Modem Router After Setup to View or Change Settings**

After you set up the modem router for DSL, cable, or fiber service, you can view or change the settings for the modem router by accessing NETGEAR genie.

➢ **To log in to the modem router:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.

   **Note:** You can also type **http://www.routerlogin.com** or **http://192.168.0.1**. The procedures in this manual use **http://www.routerlogin.net**.
The nature of the login window that opens depends on your web browser.

3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.

The BASIC Home page displays a dashboard that lets you see the status of your Internet connection and network at a glance. You can click any of the six sections of the dashboard to view more detailed information. The left column displays the menus, and at the top is an ADVANCED tab that you can use to access more menus and screens.
Change the Language

By default, the language is set as Auto. You can change the language.

➢ To change the language:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
      A login window opens.
   3. Enter the modem router user name and password.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   4. Click the OK button.
      The BASIC Home page displays.
   5. In the upper right corner, select a language from the menu.
   6. When prompted, click the OK button to confirm this change.
      The page refreshes with the language that you selected.

Change the admin Password

NETGEAR recommends that you change the default password that you use to log in to the modem router to a more secure password. This is the password that you use to log in to the modem router with the user name admin.

The ideal password contains no dictionary words from any language and contains uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters.

Note: This admin password is not the password that you use for WiFi access. The label on your modem router shows your unique WiFi network name (SSID) and password for WiFi access.

➢ To change the password for the user name admin:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
      A login window opens.
   3. Enter the user name and password for the modem router.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   4. Click the OK button.
      The BASIC Home page displays.
5. Select **ADVANCED > Administration > Set Password.**

   ![Set Password](image)

6. Enter the old password.
7. Enter the new password twice.
8. Click the **Apply** button.

   Your settings are saved.

---

**Set Up Password Recovery**

NETGEAR recommends that you enable password recovery if you change the password for the modem router user name **admin.** Then you can recover the password if it is forgotten. This recovery process is supported in Internet Explorer, Firefox, and Chrome browsers, but not in the Safari browser.

➢ **To set up password recovery:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net.**
   
   A login window opens.
3. Enter the modem router user name and password.
   
   The user name is **admin.** The default password is **password.** The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Administration > Set Password.**
   
   The Set Password page displays.
6. Select the **Enable Password Recovery** check box.
Let the Modem Router Automatically Update Its Firmware

When you set up your modem router and are connected to the Internet, the modem router automatically checks for you to see if newer firmware is available. If it is, a message is displayed at the top of the page. For information about manually upgrading firmware, see Update the Firmware of the Modem Router on page 219.

➢ To automatically update the firmware:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Wait for the modem router to check if newer firmware is available.
   This process might take a few minutes. If the modem router detects new firmware, the modem router displays a message at the top of the page.
6. Click the message.
7. To upgrade the modem router with the latest firmware, click the Yes button.
   After the upgrade, the modem router restarts.

WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.
Access the Modem Router with the NETGEAR genie App

The genie app is the easy dashboard for managing, monitoring, and repairing your home network from a smartphone, tablet, or computer. The genie app can help you with the following:

- Automatically repair common WiFi network problems.
- Easily manage modem router features such as Live Parental Controls, guest access, Internet traffic meter, speed test, and more.
- Share and stream music or videos.

To use the genie app to access the modem router:

1. Visit the NETGEAR genie web page at netgear.com/genie.
2. Follow the onscreen instructions to install the app on your smartphone, tablet, or computer.
3. Launch the genie app.
   The genie app dashboard screen displays.

The following figure shows the genie app dashboard for a Windows computer.
This chapter describes how you can manage the Internet settings of the modem router manually.

Usually, the quickest way to set up the modem router is to allow NETGEAR genie to detect the Internet connection when you first access the modem router with a web browser. These options are described in Chapter 2, Install and Access the Modem Router and Its Network. You can also customize or specify your Internet settings manually.

The chapter contains the following sections:

- Use the Internet Setup Wizard After Initial Setup
- Manually Set Up an ADSL Internet Connection
- Manually Set Up a VDSL Internet Connection
- Manually Set Up a Cable of Fiber Internet Connection
- Specify an IPv6 Internet Connection
- Manage the MTU Size
Use the Internet Setup Wizard After Initial Setup

Whether you use DSL service or cable or fiber service, you can use the Setup Wizard to detect your Internet settings and automatically set up your modem router.

---

Note: The Setup Wizard is the same as NETGEAR genie that launches the first time that you connect to your modem router.

---

To use the Setup Wizard:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup Wizard.

![Diagram of the Setup Wizard interface]

6. From the Country menu, select the country in which you use the modem router.
7. From the Internet Service Provider menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select Other.
8. Select the Yes radio button.
   If you select the No radio button, you are taken to the Internet Setup page after you click the Next button (see Manually Set Up an ADSL Internet Connection on page 47).
9. Click the Next button.
The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration.

When the modem router is connected to the Internet, the Congratulations! page displays, and you successfully completed the setup process.

If the Congratulations! page does not display, other screens might display and you might need to provide more information, in which case you must continue with the next step. The screens that display depend on your type of ISP connection and configuration.

10. (Only if the following page displays) Specify a full scan to let the Setup Wizard find the PVC protocol.

The page that might display asks you if you need the Setup Wizard to do a full scan to find the PVC protocol. If this page does not display, continue with the next step.

Do the following:

a. Select the **Yes** radio button.

b. Click the **Next** button.
The Setup Wizard performs a full scan, which might take up to six minutes.

11. (Only if the following page displays) Specify how to manage problems with the detection of the Internet connection.

The page that might display states that a problem occurred while detecting the Internet connection. If this page does not display, continue with the next step.

Take one of the following actions:

- If your setup includes a DSL modem, power cycle the DSL modem:
  a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.
  b. If your DSL modem includes a battery backup, remove the battery.
  c. Wait 10 seconds.
  d. If your DSL modem includes a battery backup, reinsert the battery.
  e. Plug in your DSL modem’s power and turn on your DSL modem.
  f. Wait two minutes.
  g. Select the I just power cycled the modem and waited for 2 minutes radio button.
  h. Click the Next button.
• If your setup includes a cable or fiber modem, see if the yellow Ethernet cable is not fully inserted or is inserted at the wrong place. If necessary, do the following:
  a. Fully insert the Ethernet cable in the correct port on the cable or fiber modem and in the red Internet port on the modem router.
  b. Select the **I corrected a problem with the Ethernet cable** radio button.
  c. Click the **Next** button.

• If you do not need to power cycle the DSL modem or the Ethernet cable is already fully inserted in the correct ports, do the following:
  a. Select the **None of the above** radio button.
  b. Click the **Next** button.

12. (Only if the following page displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

   The page that might display states that a problem occurred while detecting the Internet connection IP address.

   Take one of the following actions:

   • If your ISP assigned you a fixed (static) IP address, do the following:
     a. Select the **Yes** radio button.
     b. Click the **Next** button.
c. Enter the address information that your ISP gave you for your fixed IP address configuration.

d. Click the Next button.

- If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the No or the I don't know radio button.
  b. Click the Next button.

   ![Fixed Internet IP Settings](image)

   c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.

   You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

   d. Click the Next button.

13. If the Congratulations! page still does not display and the modem router still does not connect to the Internet, do the following:

   a. Review all your settings.
       Make sure that you selected the correct options and entered everything correctly.

   b. Run the Setup Wizard one more time.
c. Contact your ISP to verify that you are using the correct configuration information.
d. Read Troubleshoot the Internet Connection on page 276.
e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

When the modem router connects to the Internet, you are prompted to download and install the free NETGEAR Desktop genie app and the free ReadySHARE Vault app.

**Manually Set Up an ADSL Internet Connection**

You can view or change the modem router’s ADSL Internet connection settings manually. The following sections describe the options that are available to you to manually set up the ADSL Internet connection:

- Specify an ADSL Connection Without a Login Requirement on page 47
- Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service on page 52

**Note:** Some ISPs require that you register on their website before you can obtain Internet service. Follow the directions that your ISP gave you.

**Specify an ADSL Connection Without a Login Requirement**

If you want to manually configure the ADSL connection settings, use the information that your ISP gave you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.

**Note:** If you must configure the IPTV interface, first use the following procedure to configure the Internet. If you must configure the IPTV interface, first use the following procedure to configure the Internet. Then, repeat the procedure to configure the IPTV interface.

➢ **To view or specify the settings for an ADSL Internet connection that does not require a login:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   A login window opens.
3. Enter the modem router user name and password.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **Internet**.
   The Internet Setup page displays.

6. From the **Select Country** menu, select the country in which you use the modem router.
   The **Select Country** menu is not available in all countries and might be masked out.

7. From the **Select Internet Service Provider** menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select **Other**.

8. From the **Transfer Mode** menu, select **ATM**.

9. From the **DSL Mode** menu, select the ADSL mode that your ISP provided you:
   - **Auto**. The modem router detects the DSL mode automatically. (This is the default setting.)
   - **ADSL**. Legacy version of ADSL.
   - **ADSL2**. Legacy version of ADSL2.
   - **ADSL2+**. ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and ADSL.

10. Select the virtual interface:
    - **Internet interface**. From the menu above the **Enable This Interface** check box, leave the default menu selection at Internet.
        In most situations, you only need to configure the Internet interface.
    - **IPTV interface**. From the menu above the **Enable This Interface** check box, select **IPTV**.
        If you use an IPTV device, you might need to configure the IPTV interface.

11. Make sure that the **Enable This Interface** check box is selected.

12. Scroll down to the Does your Internet connection require a login? section and select the **No** radio button.
    As an example, the following figure shows the settings that display when you configure an ADSL connection for the Internet interface and your Internet connection does not require a login.
13. Enter the ADSL settings as described in the following table.

| Field                        | Description                                                                                                                                 |
|------------------------------|----------------------------------------------------------------*******************************************************************************|
| Multiplexing Method          | Select **LLC-BASED** or **VC-BASED**, as indicated by your ISP.  
The multiplexing method can either be virtual circuit (VC) based or logical link control (LLC) based. |
| VPI                          | Enter a number between 0 and 255 for the virtual circuit number for the virtual path identifier (VPI), as indicated by your ISP.  
If your ISP did not provide you with a VPI setting, leave the default setting (0). The VPI might be required not only for a VC-based connection but also for an LLC-based connection. |
| VCI                          | Enter a number between 32 and 65535 for the virtual circuit number for the virtual channel identifier (VCI), as indicated by your ISP.  
If your ISP did not provide you with a VCI setting, leave the default setting (35). The VCI might be required not only for a VC-based connection but also for an LLC-based connection. |
| Use VLANID                   | Select the **Use VLANID** check box and enter the VLAN ID, as indicated by your ISP.  
A VLAN ID might be required if you subscribe to both Internet service and IPTV service. If your ISP did not provide you with a VLAN ID, leave the **Use VLANID** check box cleared, which is the default setting.  
For information about setting up VLAN tag groups, see *Set Up a Bridge for a VLAN Tag Group* on page 198. |
| Priority (802.1p)            | If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7.  
You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0). |
| Bridge Mode (bind LAN4 to WAN2) | This setting is an option that applies to the IPTV interface only.  
To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the **Bridge Mode (bind LAN4 to WAN2)** check box.  
For more information, see *Enable Bridge Mode for an IPTV Device* on page 200. |
| Account Name (If Required)   | Enter the account name, as indicated by your ISP. This name might also be called the host name.  
If your ISP did not provide you with an account name or host name, leave this field blank. |
| Domain Name (If Required)    | Enter the domain name, as indicated by your ISP.  
If your ISP did not provide you with a domain name, leave this field blank. |
| Internet IP Address          | **Get Dynamically from ISP**  
Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses. |
|                              | **Use Static IP Address**  
Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects. |
14. Click the **Apply** button.

Your settings are saved.

15. Click the **Test** button to test your Internet connection.

If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.
Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service

If you want to manually configure the ADSL connection settings, use the information that your ISP gave you to log in and connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.

---

**Note:** If you must configure the IPTV interface, first use the following procedure to configure the Internet interface. Then, repeat the procedure to configure the IPTV interface.

---

To view or specify the settings for an ADSL Internet connection that requires a login and uses a PPPoE or PPPoA service:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **Internet**.
   The Internet Setup page displays.
6. From the **Select Country** menu, select the country in which you use the modem router.
   The **Select Country** menu is not available in all countries and might be masked out.
7. From the **Select Internet Service Provider** menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select **Other**.
8. From the **Transfer Mode** menu, select **ATM**.
9. From the **DSL Mode** menu, select the ADSL mode that your ISP provided you:
   - **Auto**. The modem router detects the DSL mode automatically. (This is the default setting.)
   - **ADSL**. Legacy version of ADSL.
• **ADSL2.** Legacy version of ADSL2.

• **ADSL2+.** ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and ADSL.

10. Select the virtual interface:

• **Internet interface.** From the menu above the **Enable This Interface** check box, leave the default menu selection at Internet.

   In most situations, you only need to configure the Internet interface.

• **IPTV interface.** From the menu above the **Enable This Interface** check box, select **IPTV**.

   If you use an IPTV device, you might need to configure the IPTV interface.

11. Make sure that the **Enable This Interface** check box is selected.

12. Scroll down to the Does your Internet connection require a login? section and select the **Yes** radio button.

   As an example, the following figure shows the settings that display when you configure an ADSL connection for the Internet interface and your Internet connection requires a login.
Manage the Internet Settings Manually
13. Enter the ADSL settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplexing Method</td>
<td>Select <strong>LLC-BASED</strong> or <strong>VC-BASED</strong>, as indicated by your ISP. The multiplexing method can either be virtual circuit (VC) based or logical link control (LLC) based.</td>
</tr>
<tr>
<td>VPI</td>
<td>Enter a number between 0 and 255 for the virtual circuit number for the virtual path identifier (VPI), as indicated by your ISP. If your ISP did not provide you with a VPI setting, leave the default setting (0). The VPI might be required not only for a VC-based connection but also for an LLC-based connection.</td>
</tr>
<tr>
<td>VCI</td>
<td>Enter a number between 32 and 65535 for the virtual circuit number for the virtual channel identifier (VCI), as indicated by your ISP. If your ISP did not provide you with a VCI setting, leave the default setting (35). The VCI might be required not only for a VC-based connection but also for an LLC-based connection.</td>
</tr>
<tr>
<td>Use VLANID</td>
<td>Select the <strong>Use VLANID</strong> check box and enter the VLAN ID, as indicated by your ISP. A VLAN ID might be required if you subscribe to both Internet service and IPTV service. If your ISP did not provide you with a VLAN ID, leave the <strong>Use VLANID</strong> check box cleared, which is the default setting. For information about setting up VLAN tag groups, see Set Up a Bridge for a VLAN Tag Group on page 198.</td>
</tr>
<tr>
<td>Priority (802.1p)</td>
<td>If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7. You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0).</td>
</tr>
<tr>
<td>Bridge Mode (bind LAN4 to WAN2)</td>
<td>This setting is an option that applies to the IPTV interface only. To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the <strong>Bridge Mode (bind LAN4 to WAN2)</strong> check box. For more information, see Enable Bridge Mode for an IPTV Device on page 200.</td>
</tr>
</tbody>
</table>
| Encapsulation                 | Select the encapsulation, as indicated by your ISP:  
  * **PPPoE**. Your Internet connection uses PPP over Ethernet.  
  * **PPPoA**. Your Internet connection uses PPP over ATM. |
| Login                         | Enter the login name that you use to log in to your Internet service, as indicated by your ISP. This login name is often an email address. |
| Password                      | Enter the password that you use to log in to your Internet service, as indicated by your ISP. |
| Service Name (If Required)    | Enter the service name that you use to log in to your Internet service, as indicated by your ISP. Often, a service name is not required. **Note:** This field does not display if your selection from the **Encapsulation** menu is **PPPoA**. |
## Manage the Internet Settings Manually

**Field** | **Description**
---|---
Connection Mode | Select how the Internet connection functions:  
• **Always On**. Once the Internet connection is established, it remains on. This is the default setting.  
• **Dial on Demand**. When someone attempts to connect to the Internet, the Internet connection is established. When the idle time-out period expires, the Internet connection is terminated.  
• **Manually Connect**. You must connect to the Internet manually (see View, Renew, or Release a TCP/IP Internet Connection on page 232 or View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection on page 234).

Idle Timeout (In Minutes) | If you select **Dial on Demand** from the Connection Mode menu, enter the idle time-out period in minutes. The idle time-out specifies how long the modem router keeps the Internet connection active when no one on the network is using the Internet connection. The default is 5 minutes. To disable the idle time-out, enter 0. (When you disable the idle time-out, the connection is not terminated automatically).

Internet IP Address |  
Get Dynamically from ISP | Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.  
Use Static IP Address | Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects.

Domain Name Server (DNS) Address | The DNS server is used to look up site addresses based on their domain names.  
Get Automatically from ISP | Your ISP uses DHCP to assign your DNS servers. Your ISP automatically assigns this address.  
Use These DNS Servers | If you know that your ISP does not automatically transmit DNS addresses to the modem router during login, select this option and enter the IP address of your ISP primary DNS server. If a secondary DNS server address is available, enter it also.

NAT (Network Address Translation) | NAT allows computers on your home network to share the modem router Internet connection. NAT is enabled by default because it is required in most situations. Select the NAT setting:  
• **Enable**. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT exists.  
• **Disable**. NAT is disabled.

Router MAC Address | The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC address of the network interface card in your computer when your account is first opened. They accept traffic only from the MAC address of that computer. This feature allows your modem router to use your computer’s MAC address (also called cloning).  
Use Default Address | Use the default MAC address.
14. Click the **Apply** button.

Your settings are saved.

15. Click the **Test** button to test your Internet connection.

   If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.

**Manually Set Up a VDSL Internet Connection**

You can view or change the modem router’s VDSL Internet connection settings manually. The following sections describe the options that are available to you to manually set up the VDSL Internet connection:

- *Specify a VDSL Connection Without a Login Requirement* on page 57
- *Specify a VDSL Connection with a Login Requirement and PPPoE Service* on page 61

**Note:** Some ISPs require that you register on their website before you can obtain Internet service. Follow the directions that your ISP gave you.

**Specify a VDSL Connection Without a Login Requirement**

If you want to manually configure the VDSL connection settings, use the information that your ISP gave you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.

**Note:** If you must configure the IPTV interface, first use the following procedure to configure the Internet interface. Then, repeat the procedure to configure the IPTV interface.
To view or specify the settings for a VDSL Internet connection that does not require a login:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type \texttt{http://www.routerlogin.net}.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is \texttt{admin}. The default password is \texttt{password}. The user name and password are case-sensitive.
4. Click the \texttt{OK} button.
   The BASIC Home page displays.
5. Select \texttt{Internet}.
   The Internet Setup page displays.
6. From the Select Country menu, select the country in which you use the modem router.
   The Select Country menu is not available in all countries and might be masked out.
7. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select Other.
8. From the Transfer Mode menu, select PTM.
   When you select PTM from the Transfer Mode menu, the only option in the DSL Mode menu is VDSL2.
9. Select the virtual interface:
   • Internet interface. From the menu above the Enable This Interface check box, leave the default menu selection at Internet.
     In most situations, you only need to configure the Internet interface.
   • IPTV interface. From the menu above the Enable This Interface check box, select IPTV.
     If you use an IPTV device, you might need to configure the IPTV interface.
10. Make sure that the Enable This Interface check box is selected.
11. Scroll down to the Does your Internet connection require a login? section and select the No radio button.
   As an example, the following figure shows the settings that display when you configure a VDSL connection for the Internet interface and your Internet connection does not require a login.
Manage the Internet Settings Manually

### Internet Setup

**Select Country**
- **USA**

**Select Internet Service Provider**
- **Other**

**Transfer Mode**
- **PTM**

**DSL Mode**
- **VDSL2**

**Internet**
- **Enable**

**Multiplexing Method**
- **VC-BASED**

**VPI**
- 0

**VCI**
- 35

**Use VLANID**
- **No**

**Priority (802.1p)**
- 0

**Does your Internet connection require a login?**
- **No**

**Account Name (if Required)**

**Domain Name (if Required)**

**Internet IP Address**
- **Dynamically from ISP**
- **Static IP Address**
  - **IP Address**
    - 192.168.100.150
  - **IP Subnet Mask**
    - 255.255.255.0
  - **Gateway IP Address**
    - 192.168.1.1

**Use IP Over ATM (IPoA)**
- **No**

**Domain Name Server (DNS) Address**
- **Dynamically from ISP**
- **Static DNS**
  - **Primary DNS**
    - 192.168.100.1
  - **Secondary DNS**
    - 

**MAT (Network Address Translation)**
- **Enable**

**Router MAC Address**
- **Use Default Address**
- **Use Computer MAC Address**
- **Use This MAC Address**
  - 00:13:77:56:51:EC

**DHCP Options**
- **Vendor Class identifier String (option 60)**
- **Class Identifier String (option 51)**

---

**AC1600 WiFi VDSL/ADSL Modem Router Model D6400**
12. Enter the VDSL settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplexing Method</td>
<td>These settings are disabled because they do not apply to a VDSL connection.</td>
</tr>
<tr>
<td>VPI</td>
<td></td>
</tr>
<tr>
<td>VCI</td>
<td></td>
</tr>
<tr>
<td>Use VLANID</td>
<td>Select the <strong>Use VLANID</strong> check box and enter the VLAN ID, as indicated by your ISP. A VLAN ID might be required if you subscribe to both Internet service and IPTV service. In some unusual situations, a VLAN ID is required for VDSL Internet service. If your ISP did not provide you with a VLAN ID, leave the <strong>Use VLANID</strong> check box cleared, which is the default setting. For information about setting up VLAN tag groups, see <em>Set Up a Bridge for a VLAN Tag Group</em> on page 198.</td>
</tr>
<tr>
<td>Priority (802.1p)</td>
<td>If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7. You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0).</td>
</tr>
<tr>
<td>Bridge Mode (bind LAN4 to WAN2)</td>
<td>This setting is an option that applies to the IPTV interface only. To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the <strong>Bridge Mode (bind LAN4 to WAN2)</strong> check box. For more information, see <em>Enable Bridge Mode for an IPTV Device</em> on page 200.</td>
</tr>
<tr>
<td>Account Name (If Required)</td>
<td>Enter the account name, as indicated by your ISP. This name might also be called the host name. If your ISP did not provide you with an account name or host name, leave this field blank.</td>
</tr>
<tr>
<td>Domain Name (If Required)</td>
<td>Enter the domain name, as indicated by your ISP. If your ISP did not provide you with a domain name, leave this field blank.</td>
</tr>
<tr>
<td>Internet IP Address</td>
<td></td>
</tr>
<tr>
<td>Get Dynamically from ISP</td>
<td>Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.</td>
</tr>
<tr>
<td>Use Static IP Address</td>
<td>Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects.</td>
</tr>
<tr>
<td>Use IP over ATM (IPoA)</td>
<td>Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for IPoA service. The gateway is the ISP router to which your modem router connects.</td>
</tr>
<tr>
<td>Domain Name Server (DNS) Address</td>
<td>The DNS server is used to look up site addresses based on their domain names.</td>
</tr>
<tr>
<td>Get Automatically from ISP</td>
<td>Your ISP uses DHCP to assign your DNS servers. Your ISP automatically assigns this address.</td>
</tr>
</tbody>
</table>
13. Click the **Apply** button.
Your settings are saved.

14. Click the **Test** button to test your Internet connection.
If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.

### Specify a VDSL Connection with a Login Requirement and PPPoE Service

If you want to manually configure the VDSL connection settings, use the information that your ISP gave you to log in and connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use These DNS Servers</td>
<td>If you know that your ISP does not automatically transmit DNS addresses to the modem router during login, select this option and enter the IP address of your ISP primary DNS server. If a secondary DNS server address is available, enter it also.</td>
</tr>
</tbody>
</table>
| **NAT (Network Address Translation)** | NAT allows computers on your home network to share the modem router Internet connection. NAT is enabled by default because it is required in most situations. Select the NAT setting:  
  - **Enable**: NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT exists.  
  - **Disable**: NAT is disabled. |
| **Router MAC Address**         | The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC address of the network interface card in your computer when your account is first opened. They accept traffic only from the MAC address of that computer. This feature allows your modem router to use your computer’s MAC address (also called cloning). |
| Use Default Address           | Use the default MAC address.                                                                                                                                                                           |
| Use Computer MAC Address      | The modem router captures and uses the MAC address of the computer that you are now using. You must use the one computer that is registered by the ISP.                                                     |
| Use This MAC Address          | Enter the MAC address that you want to use. By default, the field displays the MAC address of the Internet port.                                                                                         |
| **DHCP Options**              |                                                                                                                                                                                                          |
| Vendor Class Identifier String (option 60) | Enter the vendor class identifier (VCI) string, as indicated by your ISP. If your ISP did not provide you with a VCI string, leave this field blank.                                                            |
| Client Identifier String (option 61) | Enter the client identifier (client ID) string, as indicated by your ISP. If your ISP did not provide you with a client ID string, leave this field blank.                                                    |
The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.

---

**Note:** If you must configure the IPTV interface, first use the following procedure to configure the Internet interface. Then, repeat the procedure to configure the IPTV interface.

---

➢ To view or specify the settings for a VDSL Internet connection that requires a login and uses a PPPoE service:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **Internet**.
   The Internet Setup page displays.
6. From the **Select Country** menu, select the country in which you use the modem router.
   The **Select Country** menu is not available in all countries and might be masked out.
7. From the **Select Internet Service Provider** menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select **Other**.
8. From the **Transfer Mode** menu, select **PTM**.
   When you select **PTM** from the **Transfer Mode** menu, the only option in the **DSL Mode** menu is **VDSL2**.
9. Select the virtual interface:
   • **Internet interface.** From the menu above the **Enable This Interface** check box, leave the default menu selection at Internet.
     In most situations, you only need to configure the Internet interface.
   • **IPTV interface.** From the menu above the **Enable This Interface** check box, select **IPTV**.
     If you use an IPTV device, you might need to configure the IPTV interface.
10. Make sure that the **Enable This Interface** check box is selected.
11. Scroll down to the Does your Internet connection require a login? section and select the Yes radio button.

As an example, the following figure shows the settings that display when you configure a VDSL connection for the Internet interface and your Internet connection requires a login.
12. Enter the VDSL settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplexing Method</td>
<td>These settings are disabled because they do not apply to a VDSL connection.</td>
</tr>
<tr>
<td>VPI</td>
<td></td>
</tr>
<tr>
<td>VCI</td>
<td></td>
</tr>
<tr>
<td>Use VLANID</td>
<td>Select the <strong>Use VLANID</strong> check box and enter the VLAN ID, as indicated by your ISP.</td>
</tr>
<tr>
<td></td>
<td>A VLAN ID might be required if you subscribe to both Internet service and IPTV service. In some unusual situations, a VLAN ID is required for VDSL Internet service. If your ISP did not provide you with a VLAN ID, leave the <strong>Use VLANID</strong> check box cleared, which is the default setting. For information about setting up VLAN tag groups, see <a href="#"><em>Set Up a Bridge for a VLAN Tag Group</em></a> on page 198.</td>
</tr>
<tr>
<td>Priority (802.1p)</td>
<td>If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7.</td>
</tr>
<tr>
<td></td>
<td>You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0).</td>
</tr>
<tr>
<td>Bridge Mode (bind LAN4 to WAN2)</td>
<td>This setting is an option that applies to the IPTV interface only. To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the <strong>Bridge Mode (bind LAN4 to WAN2)</strong> check box. For more information, see <a href="#"><em>Enable Bridge Mode for an IPTV Device</em></a> on page 200.</td>
</tr>
<tr>
<td>Encapsulation</td>
<td>For a PPP over Ethernet (PPPoE) connection, select <strong>PPPoE</strong> from the menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> PPP over ATM (PPPoA) is not supported for a VDSL connection.</td>
</tr>
<tr>
<td>Login</td>
<td>Enter the login name that you use to log in to your Internet service, as indicated by your ISP.</td>
</tr>
<tr>
<td></td>
<td>This login name is often an email address.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that you use to log in to your Internet service, as indicated by your ISP.</td>
</tr>
<tr>
<td>Service Name (If Required)</td>
<td>Enter the service name that you use to log in to your Internet service, as indicated by your ISP.</td>
</tr>
<tr>
<td></td>
<td>Often, a service name is not required.</td>
</tr>
<tr>
<td>Connection Mode</td>
<td>Select how the Internet connection functions:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always On.</strong> Once the Internet connection is established, it remains on. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Dial on Demand.</strong> When someone attempts to connect to the Internet, the Internet connection is established. When the idle time-out period expires, the Internet connection is terminated.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manually Connect.</strong> You must connect to the Internet manually (see <a href="#"><em>View, Renew, or Release a TCP/IP Internet Connection</em></a> on page 232 or <a href="#"><em>View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection</em></a> on page 234).</td>
</tr>
</tbody>
</table>
13. Click the **Apply** button.
    Your settings are saved.

14. Click the **Test** button to test your Internet connection.

### Manage the Internet Settings Manually

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle Timeout (In Minutes)</td>
<td>If you select <strong>Dial on Demand</strong> from the <strong>Connection Mode</strong> menu, enter the idle time-out period in minutes. The idle time-out specifies how long the modem router keeps the Internet connection active when no one on the network is using the Internet connection. The default is 5 minutes. To disable the idle time-out, enter 0. (When you disable the idle time-out, the connection is not terminated automatically).</td>
</tr>
<tr>
<td>Internet IP Address</td>
<td><strong>Get Dynamically from ISP</strong> Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses. <strong>Use Static IP Address</strong> Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects.</td>
</tr>
<tr>
<td>Domain Name Server (DNS) Address</td>
<td><strong>Get Automatically from ISP</strong> Your ISP uses DHCP to assign your DNS servers. Your ISP automatically assigns this address. <strong>Use These DNS Servers</strong> If you know that your ISP does not automatically transmit DNS addresses to the modem router during login, select this option and enter the IP address of your ISP primary DNS server. If a secondary DNS server address is available, enter it also.</td>
</tr>
<tr>
<td><strong>NAT (Network Address Translation)</strong></td>
<td>NAT allows computers on your home network to share the modem router Internet connection. NAT is enabled by default because it is required in most situations. Select the NAT setting: • <strong>Enable</strong>. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT exists. • <strong>Disable</strong>. NAT is disabled.</td>
</tr>
<tr>
<td>Router MAC Address</td>
<td><strong>Use Default Address</strong> Use the default MAC address. <strong>Use Computer MAC Address</strong> The modem router captures and uses the MAC address of the computer that you are now using. You must use the one computer that is registered by the ISP. <strong>Use This MAC Address</strong> Enter the MAC address that you want to use. By default, the field displays the MAC address of the Internet port.</td>
</tr>
</tbody>
</table>
If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.

**Manually Set Up a Cable of Fiber Internet Connection**

You can view or change the modem router’s cable or fiber Internet connection settings manually. The following sections describe the options that are available to you to manually set up the cable or fiber Internet connection:

- *Specify a Cable or Fiber Connection Without a Login Requirement* on page 66
- *Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service* on page 71

**Note:** Some ISPs require that you register on their website before you can obtain Internet service. Follow the directions that your ISP gave you.

**Note:** If you connect both a DSL modem and a cable or fiber modem to the modem router and you want to manually specify the settings for a cable or fiber Internet connection, you must first set the WAN connection preference manually to the Ethernet WAN port (see *Change the Physical WAN Connection Preference* on page 194). If you do not, the DSL settings take precedence over the cable or fiber settings. However, NETGEAR recommends that you connect only the modem that you intend to use for your Internet connection: a DSL modem, cable modem, or fiber modem.

**Specify a Cable or Fiber Connection Without a Login Requirement**

If you want to manually configure the cable or fiber connection settings, use the information that your ISP gave you to connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.
To view or specify the settings for a cable or fiber Internet connection that does not require a login:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select Internet.
   The Internet Setup page displays.
6. From the Select Country menu, select the country in which you use the modem router.
   The Select Country menu is not available in all countries and might be masked out.
7. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select Other.
8. Select the virtual interface:
   • Internet interface. From the menu above the Enable This Interface check box, leave the default menu selection at Internet.
     In most situations, you only need to configure the Internet interface.
   • IPTV interface. From the menu above the Enable This Interface check box, select IPTV.
     If you use an IPTV device, you might need to configure the IPTV interface.
9. Make sure that the Enable This Interface check box is selected.
10. Scroll down to the Does your Internet connection require a login? section and select the No radio button.
    As an example, the following figure shows the settings that display when you configure a cable or fiber connection for the Internet interface and your Internet connection does not require a login.
These settings do not apply.

These settings do not apply.
11. Enter the cable or fiber settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Mode</td>
<td>Unless you changed the physical WAN interface settings so that the modem router must use the Ethernet WAN interface (see Change the Physical WAN Connection Preference on page 194) these settings are not disabled. However, these settings do not apply to a cable or fiber connection and you can ignore them.</td>
</tr>
<tr>
<td>DSL Mode</td>
<td></td>
</tr>
<tr>
<td>Multiplexing Method</td>
<td>VPI</td>
</tr>
<tr>
<td></td>
<td>VCI</td>
</tr>
<tr>
<td>Use VLANID</td>
<td>Select the <strong>Use VLANID</strong> check box and enter the VLAN ID, as indicated by your ISP. A VLAN ID might be required if you subscribe to both Internet service and IPTV service. If your ISP did not provide you with a VLAN ID, leave the <strong>Use VLANID</strong> check box cleared, which is the default setting. For information about setting up VLAN tag groups, see Set Up a Bridge for a VLAN Tag Group on page 198.</td>
</tr>
<tr>
<td>Priority (802.1p)</td>
<td>If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7. You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0).</td>
</tr>
<tr>
<td>Bridge Mode (bind LAN4 to WAN2)</td>
<td>This setting is an option that applies to the IPTV interface only. To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the <strong>Bridge Mode (bind LAN4 to WAN2)</strong> check box. For more information, see Enable Bridge Mode for an IPTV Device on page 200.</td>
</tr>
<tr>
<td>Account Name (If Required)</td>
<td>Enter the account name, as indicated by your ISP. This name might also be called the host name. If your ISP did not provide you with an account name or host name, leave this field blank.</td>
</tr>
<tr>
<td>Domain Name (If Required)</td>
<td>Enter the domain name, as indicated by your ISP. If your ISP did not provide you with a domain name, leave this field blank.</td>
</tr>
</tbody>
</table>

**Internet IP Address**

<table>
<thead>
<tr>
<th>Get Dynamically from ISP</th>
<th>Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Static IP Address</td>
<td>Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects.</td>
</tr>
<tr>
<td>Use IP over ATM (IPoA)</td>
<td>Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for IPoA service. The gateway is the ISP router to which your modem router connects.</td>
</tr>
</tbody>
</table>
12. Click the **Apply** button.  
Your settings are saved.

13. Click the **Test** button to test your Internet connection.  
If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.
Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service

If you want to manually configure the cable or fiber connection settings, use the information that your ISP gave you to log in and connect to your Internet service. If you cannot find this information, contact your ISP. Entering incorrect information might prevent the modem router from connecting to the Internet.

The modem router provides a virtual Internet interface and a virtual IPTV interface. In most situations, you only need to configure the Internet interface. If you use an IPTV device, you might also need to configure the IPTV interface. Follow the directions that your ISP gave you.

Note: If you must configure the IPTV interface, first use the following procedure to configure the Internet interface. Then, repeat the procedure to configure the IPTV interface.

To view or specify the settings for a cable or fiber Internet connection that requires a login and uses a PPPoE service:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type \http://www.routerlogin.net\.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is \admin\. The default password is \password\. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select Internet.
   The Internet Setup page displays.
6. From the Select Country menu, select the country in which you use the modem router.
   The Select Country menu is not available in all countries and might be masked out.
7. From the Select Internet Service Provider menu, select the Internet service provider (ISP) that you are using.
   If your ISP is not in the menu, select Other.
8. Select the virtual interface:
   • Internet interface. From the menu above the Enable This Interface check box, leave the default menu selection at Internet.
     In most situations, you only need to configure the Internet interface.
   • IPTV interface. From the menu above the Enable This Interface check box, select IPTV.
If you use an IPTV device, you might need to configure the IPTV interface.

9. Make sure that the **Enable This Interface** check box is selected.

10. Scroll down to the Does your Internet connection require a login? section and select the **Yes** radio button.

As an example, the following figure shows the settings that display when you configure a cable or fiber connection for the Internet interface and your Internet connection requires a login.
11. Enter the cable or fiber settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Mode</td>
<td>Unless you changed the physical WAN interface settings so that the modem router must use the Ethernet WAN interface (see Change the Physical WAN Connection Preference on page 194) these settings are not disabled. However, these settings do not apply to a cable or fiber connection and you can ignore them.</td>
</tr>
<tr>
<td>DSL Mode</td>
<td>Multiplexing Method</td>
</tr>
<tr>
<td>VPI</td>
<td>Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated by your ISP. A VLAN ID might be required if you subscribe to both Internet service and IPTV service. If your ISP did not provide you with a VLAN ID, leave the Use VLANID check box cleared, which is the default setting. For information about setting up VLAN tag groups, see Set Up a Bridge for a VLAN Tag Group on page 198.</td>
</tr>
<tr>
<td>VCI</td>
<td>Priority (802.1p) If your ISP provided you with a VLAN ID and a priority value, enter the priority value, which is a number from 0 to 7. You can enter a priority value only in combination with a VLAN ID. If your ISP did not provide you with a priority value, leave the default setting (0).</td>
</tr>
<tr>
<td>Bridge Mode (bind LAN4 to WAN2)</td>
<td>This setting is an option that applies to the IPTV interface only. To bind LAN port 4 to the IPTV interface (that is, the WAN2 virtual interface), select the Bridge Mode (bind LAN4 to WAN2) check box. For more information, see Enable Bridge Mode for an IPTV Device on page 200.</td>
</tr>
<tr>
<td>Encapsulation</td>
<td>For a PPP over Ethernet (PPPoE) connection, select PPPoE from the menu. Note: PPP over ATM (PPPoA) is not supported for a cable or fiber connection.</td>
</tr>
<tr>
<td>Login</td>
<td>Enter the login name that you use to log in to your Internet service, as indicated by your ISP. This login name is often an email address.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that you use to log in to your Internet service, as indicated by your ISP.</td>
</tr>
<tr>
<td>Service Name (If Required)</td>
<td>Enter the service name that you use to log in to your Internet service, as indicated by your ISP. Often, a service name is not required.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Connection Mode | Select how the Internet connection functions:  
  • **Always On**. Once the Internet connection is established, it remains on. This is the default setting.  
  • **Dial on Demand**. When someone attempts to connect to the Internet, the Internet connection is established. When the idle time-out period expires, the Internet connection is terminated.  
  • **Manually Connect**. You must connect to the Internet manually (see View, Renew, or Release a TCP/IP Internet Connection on page 232 or View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection on page 234). |
| Idle Timeout (In Minutes) | If you select **Dial on Demand** from the **Connection Mode** menu, enter the idle time-out period in minutes. The idle time-out specifies how long the modem router keeps the Internet connection active when no one on the network is using the Internet connection. The default is 5 minutes. To disable the idle time-out, enter 0. (When you disable the idle time-out, the connection is not terminated automatically). |
| Internet IP Address |  
  **Get Dynamically from ISP** Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.  
  **Use Static IP Address** Enter the IP address, IP subnet mask, and gateway IP address that your ISP assigned you for static IP address service. The gateway is the ISP router to which your modem router connects. |
| Domain Name Server (DNS) Address | The DNS server is used to look up site addresses based on their domain names.  
  **Get Automatically from ISP** Your ISP uses DHCP to assign your DNS servers. Your ISP automatically assigns this address.  
  **Use These DNS Servers** If you know that your ISP does not automatically transmit DNS addresses to the modem router during login, select this option and enter the IP address of your ISP primary DNS server. If a secondary DNS server address is available, enter it also. |
| NAT (Network Address Translation) | NAT allows computers on your home network to share the modem router Internet connection. NAT is enabled by default because it is required in most situations. Select the NAT setting:  
  • **Enable**. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT exists.  
  • **Disable**. NAT is disabled. |
| Router MAC Address | The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC address of the network interface card in your computer when your account is first opened. They accept traffic only from the MAC address of that computer. This feature allows your modem router to use your computer’s MAC address (also called cloning).  
  **Use Default Address** Use the default MAC address. |
12. Click the **Apply** button.

Your settings are saved.

13. Click the **Test** button to test your Internet connection.

If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 276.

### Specify an IPv6 Internet Connection

If you want to use an IPv6 Internet connection, you must specify the settings manually. NETGEAR genie does not detect an IPv6 Internet connection automatically.

**IPv6 Internet Connections and IPv6 Addresses**

The modem router can support an IPv6 Internet connection through the following connection types:

- **Auto Detect.** For more information, see *Set Up an IPv6 Connection Through Auto Detect* on page 76.
- **6to4 tunnel.** For more information, see *Set Up an IPv6 6to4 Tunnel Connection* on page 78.
- **Pass-through.** For more information, see *Set Up an IPv6 Pass-Through Connection* on page 79.
- **Fixed.** For more information, see *Set Up an IPv6 Fixed Connection* on page 80.
- **DHCP.** For more information, see *Set Up an IPv6 DHCP Connection* on page 82.
- **PPP over Ethernet.** For more information, see *Set Up an IPv6 PPPoE Connection* on page 84.
- **Auto Config.** For more information, see *Set Up an IPv6 Connection Through Auto Config* on page 86.
- **6rd tunnel.** For more information, see *Set Up an IPv6 6rd Tunnel Connection* on page 88.
Which connection type you must use depends on your IPv6 ISP. Follow the directions that your IPv6 ISP gave you.

- If your ISP did not provide details, use the 6to4 tunnel connection type (see Set Up an IPv6 6to4 Tunnel Connection on page 78).
- If you are not sure what type of IPv6 connection the modem router uses, use the Auto Detect connection type, which lets the modem router detect the IPv6 type that is in use (see Set Up an IPv6 Connection Through Auto Detect on page 76).
- If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or pass-through but is IPv6, use the Auto Config connection type, which lets the modem router autoconfigure its IPv6 connection (see Set Up an IPv6 Connection Through Auto Config on page 86).

When you enable IPv6 and select any connection type other than IPv6 pass-through, the modem router starts the stateful packet inspection (SPI) firewall function on the WAN interface. The modem router creates connection records and checks every inbound IPv6 packet. If the inbound packet is not destined to the modem router itself and the modem router does not expect to receive such a packet, or the packet is not in the connection record, the modem router blocks this packet. This function works in two modes: In secured mode, the modem router inspects both TCP and UDP packets. In open mode, the modem router inspects UDP packets only.

IPv6 addresses are denoted by eight groups of hexadecimal quartets that are separated by colons. You can reduce any four-digit group of zeros within an IPv6 address to a single zero or omit it. The following errors invalidate an IPv6 address:

- More than eight groups of hexadecimal quartets
- More than four hexadecimal characters in a quartet
- More than two colons in a row

**Set Up an IPv6 Connection Through Auto Detect**

If you are not sure what type of IPv6 connection the modem router uses, use the Auto Detect connection type, which lets the modem router detect the IPv6 type that is in use.

➢ To set up an IPv6 Internet connection through auto detection:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   - A login window opens.
3. Enter the modem router user name and password.
   - The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   - The BASIC Home page displays.

The IPv6 page displays.

6. From the Internet Connection Type menu, select Auto Detect.

![IPv6 Setup Screen](image)

The modem router automatically detects the information in the following fields:

- **Connection Type.** This field indicates the connection type that is detected.
- **Router’s IPv6 Address on WAN.** This field shows the IPv6 address that is acquired for the modem router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.
- **Router’s IPv6 Address on LAN.** This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

7. Select an IP Address Assignment radio button:

   - **Use DHCP Server.** The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function.

   - **Auto Config.** This is the default setting.

8. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the **Use This Interface ID** check box, and enter the interface ID.

   If you do not specify an ID here, the modem router generates one automatically from its MAC address.

9. Click the Apply button.

   Your settings are saved.
Set Up an IPv6 6to4 Tunnel Connection

With an IPv6 connection, your modem router creates a 6to4 tunnel to a remote relay router. Make sure that the IPv4 Internet connection is working before you apply the 6to4 tunnel settings for the IPv6 connection.

Note: Follow the directions that your IPv6 ISP gave you.

➢ To set up an IPv6 Internet connection by using a 6to4 tunnel:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the modem router user name and password. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
6. From the Internet Connection Type menu, select 6to4 Tunnel.
The modem router automatically detects the information in the Router’s IPv6 Address On LAN field. This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address.

7. Select a Remote 6to4 Relay Router radio button:
   • Auto. Your modem router uses any remote relay modem router that is available on the Internet. This is the default setting.
   • Static IP Address. Enter the static IPv4 (not IPv6) address of the remote relay modem router. Your IPv6 ISP usually provides this address.

8. Select an IPv6 Domain Name Server (DNS) Address radio button:
   • Get Automatically from ISP. The ISP’s DHCP server automatically assigns IPv6 DNS server addresses.
   • Use These DNS Servers. Enter the static IPv6 (not IPv4) DNS server addresses that your ISP provided to you.

9. Select an IP Address Assignment radio button:
   • Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function. This is the default setting.
   • Auto Config. The modem router automatically configures its IPv6 address based on the IPv6 protocol.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the Use This Interface ID check box, and enter the interface ID.
    If you do not specify an ID here, the modem router generates one automatically from its MAC address.

11. Click the Apply button.
    Your settings are saved.

**Set Up an IPv6 Pass-Through Connection**

In IPv6 pass-through mode, the modem router works as a Layer 2 Ethernet switch with two ports (LAN and WAN Ethernet ports) for IPv6 packets. The modem router does not process any IPv6 header packets.

---

**Note:** Follow the directions that your IPv6 ISP gave you.

➢ To set up an IPv6 pass-through Internet connection:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   A login window opens.
3. Enter the modem router user name and password. The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button. The BASIC Home page displays.


6. From the Internet Connection Type menu, select Pass Through. The page adjusts, but no additional fields display.

7. Click the Apply button. Your settings are saved.

Set Up an IPv6 Fixed Connection

A fixed IPv6 connection is based on a static or fixed IPv6 address that your IPv6 ISP gave you.

---

**Note:** Follow the directions that your IPv6 ISP gave you.

---

➢ To set up a fixed IPv6 Internet connection:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the modem router user name and password. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
6. From the Internet Connection Type menu, select Fixed.
7. Configure the fixed IPv6 addresses for the WAN connection:
   • **IPv6 Address/Prefix Length.** The IPv6 address and prefix length of the modem router WAN interface that your ISP provided to you.
   • **Default IPv6 Gateway.** The IPv6 address of the default IPv6 gateway for the modem router's WAN interface that your ISP provided to you.
   • **Primary DNS.** The primary DNS server that resolves IPv6 domain name records for the modem router that your ISP provided to you.
   • **Secondary DNS.** The secondary DNS server that resolves IPv6 domain name records for the modem router that your ISP provided to you.

   **Note:** If you do not specify the DNS servers, the modem router uses the DNS servers that are configured for the IPv4 Internet connection on the Internet Setup page (see *Manually Set Up an ADSL Internet Connection* on page 47).

8. Select an IP Address Assignment radio button:
   • **Use DHCP Server.** The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function. This is the default setting.
   • **Auto Config.** The modem router automatically configures its IPv6 address based on the IPv6 protocol.

9. In the **IPv6 Address/Prefix Length** fields, specify the static IPv6 address and prefix length of the modem router's LAN interface.
If you do not specify an address here, the modem router generates one automatically from its MAC address.

10. Click the **Apply** button.
    
    Your settings are saved.

### Set Up an IPv6 DHCP Connection

An IPv6 DHCP connection is based on a dynamic IPv6 address that a DHCPv6 server assigns to the modem router.

---

**Note:** Follow the directions that your IPv6 ISP gave you.

➢ **To set up an IPv6 Internet connection with a DHCP server:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   
   A login window opens.
3. Enter the modem router user name and password.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > IPv6**.
   
   The IPv6 page displays.
6. From the **Internet Connection Type** menu, select **DHCP**.
The modem router automatically detects the information in the following fields:

- **Router’s IPv6 Address On WAN.** This field shows the IPv6 address that is acquired for the modem router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

- **Router’s IPv6 Address On LAN.** This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

7. If your IPv6 ISP gave you a specific host name, in the **User Class (If Required)** field, enter the host name.

   If your IPv6 ISP did not give you a specific host name, you can leave this field blank.

8. To specify a domain name, in the **Domain Name (If Required) field**, enter a domain name.

   If your ISP gave you a specific domain name, enter it in this field. (For example, Earthlink Cable might require a host name of home, and Comcast sometimes supplies a domain name.)

   If your ISP did not give you a specific domain name, you can either leave this field blank or enter the domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4 ISP here.) For example, if your ISP’s mail server is mail.xxx.yyy.zzz, enter xxx.yyy.zzz as the domain name.
9. Select an IP Address Assignment radio button:
   • **Use DHCP Server.** The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function. This is the default setting.
   • **Auto Config.** The modem router automatically configures its IPv6 address based on the IPv6 protocol.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the **Use This Interface ID** check box, and enter the interface ID.
    
    If you do not specify an ID here, the modem router generates one automatically from its MAC address.

11. Click the **Apply** button.
    
    Your settings are saved.

### Set Up an IPv6 PPPoE Connection

An IPv6 PPPoE connection is based on a dynamic IPv6 address that a PPPoE service assigns to the modem router.

---

**Note:** Follow the directions that your IPv6 ISP gave you.

➢ **To set up an IPv6 PPPoE Internet connection:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net.**
   
   A login window opens.
3. Enter the modem router user name and password.
   
   The user name is **admin.** The default password is **password.** The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > IPv6.**
   
   The IPv6 page displays.
6. From the **Internet Connection Type** menu, select **PPPoE.**
The modem router automatically detects the information in the following fields:

- **Router’s IPv6 Address On WAN.** This field shows the IPv6 address that is acquired for the modem router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

- **Router’s IPv6 Address On LAN.** This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

7. In the **Login** field, enter the login information for the ISP connection.
   
   This is usually the name that you use in your email address. For example, if your main mail account is JerAB@ISP.com, you would enter JerAB in this field. Some ISPs (such as Earthlink) require that you use your full email address when you log in. If your ISP requires your full email address, enter it in this field.

8. In the **Password** field, enter the password for the ISP connection.

9. In the **Service Name** field, enter a service name.
   
   If your ISP did not provide a service name, leave this field blank.

**Note:** The default setting of the **Connection Mode** menu is **Always On** to provide a steady IPv6 connection. The modem router never terminates the connection. If the connection is terminated, for example, when the modem is turned off, the modem router attempts to reestablish the connection immediately after the PPPoE connection becomes available again.
10. Select an IP Address Assignment radio button:
   • **Use DHCP Server.** The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function. This is the default setting.
   • **Auto Config.** The modem router automatically configures its IPv6 address based on the IPv6 protocol.

11. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the **Use This Interface ID** check box, and enter the interface ID.

   If you do not specify an ID here, the modem router generates one automatically from its MAC address.

12. Click the **Apply** button.

   Your settings are saved.

**Set Up an IPv6 Connection Through Auto Config**

If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or pass-through but is IPv6, use the Auto Config connection type, which lets the modem router autoconfigure its IPv6 connection.

➢ **To set up an IPv6 Internet connection through auto-configuration:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.

   A login window opens.
3. Enter the modem router user name and password.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.

   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > IPv6**.

   The IPv6 page displays.
6. From the **Internet Connection Type** menu, select **Auto Config**.
The modem router automatically detects the information in the following fields:

- **Router’s IPv6 Address on WAN.** This field shows the IPv6 address that is acquired for the modem router’s WAN (or Internet) interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

- **Router’s IPv6 Address on LAN.** This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

7. If your ISP gave you a specific host name, in the **DHCP User Class (If Required)** field, enter the host name.
   
   If your ISP did not give you a specific host name, leave this field blank.

8. To specify a domain name, in the **DHCP Domain Name (If Required) field**, enter a domain name.
   
   If your ISP gave you a specific domain name, enter it in this field. (For example, Earthlink Cable might require a host name of *home*, and Comcast sometimes supplies a domain name.)

   If your ISP did not give you a specific domain name, you can either leave this field blank or enter the domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4 ISP here.) For example, if your ISP’s mail server is mail.xxx.yyy.zzz, enter xxx.yyy.zzz as the domain name.
9. Select an IP Address Assignment radio button:
   • **Use DHCP Server.** The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function.
   • **Auto Config.** This is the default setting.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the **Use This Interface ID** check box, and enter the interface ID.
    If you do not specify an ID here, the modem router generates one automatically from its MAC address.

11. Click the **Apply** button.
    Your settings are saved.

---

**Set Up an IPv6 6rd Tunnel Connection**

The 6rd protocol makes it possible to deploy IPv6 to sites using a service provider’s IPv4 network. 6rd uses the service provider’s own IPv6 address prefix. This limits the operational domain of 6rd to the service provider’s network and is under direct control of the service provider. The IPv6 service that is provided is equivalent to native IPv6.

The 6rd mechanism relies on an algorithmic mapping between the IPv6 and IPv4 addresses that are assigned for use within the service provider’s network. This mapping allows for automatic determination of IPv4 tunnel endpoints from IPv6 prefixes, enabling stateless operation of 6rd.

➢ **To set up an IPv6 6rd tunnel connection:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > IPv6**.
   The IPv6 page displays.
6. From the **Internet Connection Type** menu, select **6rd Tunnel**.
The modem router automatically detects the information in the **Router's IPv6 Address on LAN** field. This field shows the IPv6 address that is acquired for the modem router’s LAN interface. The number after the slash (/) is the length of the prefix, which is also indicated by the underline (_) under the IPv6 address. If no address is acquired, the field displays Not Available.

7. In the 6rd Configuration section, configure the 6rd settings:
   - **6rd Prefix**. Enter the IPv6 prefix that your ISP gave you.
   - **6rd Prefix Length**. Enter the IPv6 prefix length that your ISP gave you.
   - **6rd Border Relay Address**. Enter the border router’s IPv4 address that your ISP gave you.
   - **6rd Address Mask Length**. Enter the IPv4 mask length that your ISP gave you.

8. Select an IPv6 Domain Name Server (DNS) Address radio button:
   - **Get Automatically from ISP**. The ISP’s DHCP server automatically assigns IPv6 DNS server addresses.
   - **Use These DNS Servers**. Enter the static IPv6 (*not* IPv4) DNS server addresses that your ISP provided to you.

9. Select an IP Address Assignment radio button:
   - **Use DHCP Server**. The modem router assigns IPv6 addresses to the devices on your home network (the LAN) through a DHCP server. This method passes more information to LAN devices, but some IPv6 systems might not support the DHCPv6 client function. This is the default setting.
   - **Auto Config**. The modem router automatically configures its IPv6 address based on the IPv6 protocol.
10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select the **Use This Interface ID** check box, and enter the interface ID.

    If you do not specify an ID here, the modem router generates one automatically from its MAC address.

11. Click the **Apply** button.

    Your settings are saved.

**Manage the MTU Size**

The maximum transmission unit (MTU) is the largest data packet a network device transmits.

**MTU Concepts**

When one network device communicates across the Internet with another, the data packets travel through many devices along the way. If a device in the data path uses a lower MTU setting than the other devices, the data packets must be split or “fragmented” to accommodate the device with the smallest MTU.

The best MTU setting for NETGEAR equipment is often the default value. In some situations, changing the value fixes one problem but causes another.

Leave the MTU unchanged unless one of these situations occurs:

- You experience problems connecting to your ISP or other Internet service, and the technical support of either the ISP or NETGEAR recommends changing the MTU setting. These web-based applications might require an MTU change:
  - A secure website that does not open or displays only part of a web page
  - Yahoo email
  - MSN portal
  - America Online’s DSL service
- You use VPN and experience severe performance problems.
- You used a program to optimize MTU for performance reasons and now you are experiencing connectivity or performance problems.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are willing to experiment, you can gradually reduce the MTU from the maximum value of 1500 until the problem goes away. The following table describes common MTU sizes and applications.
Table 3. Common MTU sizes

<table>
<thead>
<tr>
<th>MTU</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>The largest Ethernet packet size. This setting is typical for connections that do not use PPPoE or VPN and is the default value for NETGEAR modem routers, adapters, and switches.</td>
</tr>
<tr>
<td>1492</td>
<td>Used in PPPoE environments.</td>
</tr>
<tr>
<td>1472</td>
<td>Maximum size to use for pinging. (Larger packets are fragmented.)</td>
</tr>
<tr>
<td>1468</td>
<td>Used in some DHCP environments.</td>
</tr>
<tr>
<td>1460</td>
<td>Usable by AOL if you do not send or receive large email attachments, for example.</td>
</tr>
<tr>
<td>1436</td>
<td>Used in PPTP environments or with VPN.</td>
</tr>
<tr>
<td>1400</td>
<td>Maximum size for AOL DSL.</td>
</tr>
</tbody>
</table>

Change the MTU Size

**WARNING:**
An incorrect MTU setting can cause Internet communication problems. For example, you might not be able to access certain websites, frames within websites, secure login pages, or FTP or POP servers. Change the MTU only if you are sure that it is necessary for your ISP connection.

To change the MTU size:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the modem router user name and password. The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
5. Select **ADVANCED > Setup > WAN Setup**. The WAN Setup page displays.
6. In the **MTU Size** field, enter a value from 616 to 1500. The normal MTU value for most Ethernet networks is 1500 bytes, 1492 bytes for PPPoE connections, or 1436 for PPTP connections.
7. Click the Apply button. Your change is saved.
This chapter describes how you can manage the WiFi network settings of the modem router.

The chapter includes the following sections:

- Manage the Basic WiFi Settings and WiFi Security of the Main Network
- Use WPS to Add a Device to the WiFi Network
- Manage the Basic WiFi Settings and WiFi Security of the Guest Network
- Control the WiFi Radios
- Set Up a WiFi Schedule
- Manage the WPS Settings
- Manage Advanced WiFi Features
- Use the Modem Router as a WiFi Access Point
Manage the Basic WiFi Settings and WiFi Security of the Main Network

The modem router comes with preset security. This means that the WiFi network name (SSID), network key (password), and security option (encryption protocol) are preset in the factory. The preset SSID and password are uniquely generated for every device to protect and maximize your WiFi security. You can find the preset SSID and password on the product label (see Bottom Panel Product Label on page 15).

**IMPORTANT:**

NETGEAR recommends that you do **not** change your preset security settings. If you decide to change your preset security settings, make a note of the new settings and store the note in a safe place where you can easily find it.

View or Change the Basic WiFi Settings

You can view or change the basic WiFi settings and WiFi security. The modem router simultaneously supports the 2.4 GHz band for 802.11b/g/n devices and the 5 GHz band for 802.11a/n/ac devices.

**Tip:** If you decide to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

➢ **To view or change the basic WiFi settings:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   
   A login window opens.
3. Enter the user name and password for the modem router.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the OK button.
   
   The BASIC Home page displays.
5. Select **Wireless**.
6. View or change the basic WiFi settings and security settings.

The following table describes the fields on the Wireless Setup page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Region Selection</strong></td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td>From the menu, select the region in which the modem router operates.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It might not be legal to operate the modem router in a region other than the regions listed in the menu. If your country or region is not listed, check with your local government agency.</td>
</tr>
<tr>
<td><strong>Wireless Network (2.4GHz b/g/n)</strong></td>
<td></td>
</tr>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the Enable SSID Broadcast check box. Turning off the SSID broadcast provides additional WiFi security, but users must know the SSID to be able to join the WiFi network of the modem router.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Name (SSID) | The SSID is the WiFi network name. If you did not change the SSID, the default SSID displays. The default SSID is also printed on the product label (see Bottom Panel Product Label on page 15).

**Note:** NETGEAR recommends that you do not change the default SSID. If you must change the SSID, enter a 32-character (maximum), case-sensitive name in this field.

Channel | From the Channel menu, select Auto for automatic channel selection or select an individual channel. The default selection is Auto.

**Note:** In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this situation occurs, experiment with different channels to see which one is the best.

**Note:** If you use multiple WiFi access points (APs), reduce interference by selecting different channels for adjacent APs. NETGEAR recommends a channel spacing of four channels between adjacent APs (for example, use Channels 1 and 5, or 6 and 10).

Mode | From the Mode menu, select one of the following modes:

- **Up to 54 Mbps.** Legacy mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network but limits 802.11n devices to functioning at up to 54 Mbps.

- **Up to 145 Mbps.** Neighbor-friendly mode for reduced interference with neighboring WiFi networks. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network but limits 802.11n devices to functioning at up to 145 Mbps. This mode is the default mode.

- **Up to 300 Mbps.** Performance mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network and allows 802.11n devices to function at up to 300 Mbps.

**Note:** WEP security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WEP security limits their speed to 54 Mbps.
Security Options
This information applies to the 2.4 GHz WiFi network.

**Note:** NETGEAR recommends that you do not change your preset security settings (WPA2-PSK [AES]).

If you must change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network. NETGEAR recommends that you do not use an open WiFi network.

- **WEP.** Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you select Up to 54 Mbps from the Mode menu. For information about configuring WEP, see Configure WEP Legacy WiFi Security on page 100.

- **WPA2-PSK [AES].** This type of security is the default setting and enables WiFi devices that support WPA2 to join the modem router’s 2.4 GHz WiFi network. If you did not change the passphrase, the default passphrase displays. The default passphrase is printed on the product label (see Bottom Panel Product Label on page 15). WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

  NETGEAR recommends that you do not change the default passphrase. If you must change the passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s WiFi network, a user must enter this passphrase.

- **WPA-PSK [TKIP] + WPA2-PSK [AES].** This type of security enables WiFi devices that support either WPA or WPA2 to join the modem router’s 2.4 GHz WiFi network. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

  To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s WiFi network, a user must enter this passphrase.

- **WPA/WPA2 Enterprise.** This type of security requires that your WiFi network can access a RADIUS server. For information about configuring WPA/WPA2 Enterprise WiFi Security, see Configure WPA/WPA2 Enterprise Security on page 98.

### Wireless Network (5GHz 802.11a/n/ac)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the Enable SSID Broadcast check box. Turning off the SSID broadcast provides additional WiFi security, but users must know the SSID to be able to join the WiFi network of the modem router.</td>
</tr>
<tr>
<td>Enable Video Network</td>
<td>If you want to stream high-definition video, select this check box. When this option is selected, the modem router uses video reliability algorithms to reduce jitter and packet loss during video presentations. If you do not stream videos, leave this check box cleared.</td>
</tr>
</tbody>
</table>
| Name (SSID)            | The SSID is the WiFi network name. If you did not change the SSID, the default SSID displays. The default SSID is also printed on the product label (see Bottom Panel Product Label on page 15).  

  **Note:** NETGEAR recommends that you do not change the default SSID. If you must change the SSID, enter a 32-character (maximum), case-sensitive name in this field. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Channel     | From the Channel menu, select Auto for automatic channel selection or select an individual channel. The default channel depends on your selection from the Region menu.  
  **Note:** In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this situation occurs, experiment with different channels to see which one is the best.  
  **Note:** If you use multiple WiFi access points (APs), reduce interference by selecting different channels for adjacent APs. NETGEAR recommends a channel spacing of four channels between adjacent APs. |
| Mode        | From the Mode menu, select one of the following modes:  
  • **Up to 289 Mbps.** Legacy mode. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network but limits 802.11ac and 802.11na devices to functioning at up to 289 Mbps.  
  • **Up to 600 Mbps.** Neighbor-friendly mode for reduced interference with neighboring WiFi networks. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network, allows 802.11na devices to function at up to 600 Mbps, and limits 802.11ac devices to functioning at up to 600 Mbps.  
  • **Up to 1300 Mbps.** Performance mode. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network and allows 802.11ac devices to function at up to 1300 Mbps.  
  The default mode depends on your selection from the Region menu. |
| Security Options | This information applies to the 5 GHz WiFi network.  
  **Note:** NETGEAR recommends that you do not change your preset security settings (WPA2-PSK [AES]).  
  If you must change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi network:  
  • **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network.  
    NETGEAR recommends that you do not use an open WiFi network.  
  • **WPA2-PSK [AES].** This type of security is the default setting and enables WiFi devices that support WPA2 to join the modem router’s 2.4 GHz WiFi network. If you did not change the passphrase, the default passphrase displays. The default passphrase is printed on the product label (see Bottom Panel Product Label on page 15). WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.  
    NETGEAR recommends that you do not change the default passphrase. If you must change the passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s WiFi network, a user must enter this passphrase.  
  • **WPA-PSK [TKIP] + WPA2-PSK [AES].** This type of security enables WiFi devices that support either WPA or WPA2 to join the modem router’s 2.4 GHz WiFi network. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.  
    To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s WiFi network, a user must enter this passphrase.  
  • **WPA/WPA2 Enterprise.** This type of security requires that your WiFi network can access a RADIUS server. For information about configuring WPA/WPA2 Enterprise WiFi Security on page 98. |

7. Click the Apply button.  
Your settings are saved.
If you connected over WiFi to the network and you changed the SSID, you are disconnected from the network.

8. Make sure that you can reconnect over WiFi to the network with its new settings.

If you cannot connect over WiFi, check the following:

• If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.

• If your computer or WiFi device is trying to connect to your network with its old settings (before you changed the settings), update the WiFi network selection in your computer or WiFi device to match the current settings for your network.

• Does your WiFi device display as an attached device? (See View Devices Currently on the Network on page 237.) If it does, it is connected to the network.

• Are you using the correct network name (SSID) and password?

### Configure WPA/WPA2 Enterprise WiFi Security

Remote Authentication Dial In User Service (RADIUS) is an enterprise-level method for centralized Authentication, Authorization, and Accounting (AAA) management. To provide WPA/WPA2 enterprise WiFi security, the WiFi network that the modem router provides must be able to access a RADIUS server.

---

**Note:** WPS and WPA/WPA2 enterprise security cannot function together. When you enable WPA/WPA2 enterprise security, WPS is disabled.

---

**Tip:** If you want to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

➢ To configure WPA/WPA2 enterprise security:

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.

   A login window opens.

3. Enter the user name and password for the modem router.

   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.

4. Click the OK button.

   The BASIC Home page displays.

5. Select **Wireless**.
The Wireless Setup page displays.

6. In the Security Options section, select the **WPA/WPA2 Enterprise** radio button.

![Security Options screenshot]

7. In the Security Options (WPA/WPA2 Enterprise) section, enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WPA Mode</td>
<td>From the <strong>WPA Mode</strong> menu, select the enterprise mode:</td>
</tr>
<tr>
<td></td>
<td>• <strong>WPA2 [AES]</strong>. WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support only WPA. If your network includes such older devices, select WPA [TKIP] + WPA2 [AES] security.</td>
</tr>
<tr>
<td></td>
<td>• <strong>WPA [TKIP] +WPA2 [AES]</strong>. This type of security enables WiFi devices that support either WPA or WPA2 to join the modem router's WiFi network.</td>
</tr>
<tr>
<td>Group Key Update Interval</td>
<td>Enter the interval in seconds after which the RADIUS group key is updated. The default interval is 3600 seconds.</td>
</tr>
<tr>
<td>RADIUS server IP Address</td>
<td>Enter the IPv4 address of the RADIUS server to which the WiFi network can connect.</td>
</tr>
<tr>
<td>RADIUS server Port</td>
<td>Enter the number of the port on the modem router that is used to access the RADIUS server for authentication. The default port number is 1812.</td>
</tr>
<tr>
<td>RADIUS server Shared Secret</td>
<td>Enter the shared secret (RADIUS password) that is used between the modem router and the RADIUS server during authentication of a WiFi user.</td>
</tr>
</tbody>
</table>

8. Click the **Apply** button.

Your settings are saved.

9. Make sure that you can reconnect over WiFi to the network with its new security settings.

If you cannot connect over WiFi, check the following:

- If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.

- If your computer or WiFi device is trying to connect to your network with its old settings (before you changed the settings), update the WiFi network selection in your computer or WiFi device to match the current settings for your network.
• Does your WiFi device display as an attached device? (See View Devices Currently on the Network on page 237.) If it does, it is connected to the network.
• Are you using the correct network name (SSID) and password?

Configure WEP Legacy WiFi Security

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. WEP limits the WiFi transmission speed to 54 Mbps (the modem router is capable of speeds of up 300 Mbps).

---

Note: WPS and WEP security cannot function together. When you enable WEP security, WPS is disabled.

Tip: If you want to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

➢ To configure WEP security:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select Wireless.
   The Wireless Setup page displays.
6. From the Mode menu, select Up to 54 Mbps.
   The page adjusts to display the WEP radio button.
7. In the Security Options section, select the WEP radio button.
8. From the **Authentication Type** menu, select one of the following types:
   • **Automatic**. Clients can use either Open System or Shared Key authentication.
   • **Shared Key**. Clients can use only Shared Key authentication.
9. From the **Encryption Strength** menu, select the encryption key size:
   • **64-bit**. Standard WEP encryption, using 40/64-bit encryption.
   • **128-bit**. Standard WEP encryption, using 104/128-bit encryption. This selection provides higher encryption security.
10. Specify the active key by selecting the **Key 1**, **Key 2**, **Key 3**, or **Key 4** radio button. Only one key can be the active key.
11. Enter the value for the key:
   • For 64-bit WEP, enter 10 hexadecimal digits (any combination of 0–9, A–F). The key values are not case-sensitive.
   • For 128-bit WEP, enter 26 hexadecimal digits (any combination of 0–9, A–F). The key values are not case-sensitive.

   To join the modem router's WiFi network, a user must enter the key value for the key that you specified as the active key.
12. Click the **Apply** button.

   Your settings are saved.
13. Make sure that you can reconnect over WiFi to the network with its new security settings.
   If you cannot connect over WiFi, check the following:
   • If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the
modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.

- If your computer or WiFi device is trying to connect to your network with its old settings (before you changed the settings), update the WiFi network selection in your computer or WiFi device to match the current settings for your network.
- Does your WiFi device display as an attached device? (See View Devices Currently on the Network on page 237.) If it does, it is connected to the network.
- Are you using the correct network name (SSID) and password?

**Use WPS to Add a Device to the WiFi Network**

WPS (Wi-Fi Protected Setup) lets you connect a computer or WiFi device to the modem router’s network without entering the WiFi network passphrase or key. Instead, you use a WPS button or enter a PIN to connect.

If you use the push button method, the WiFi device that you are trying to connect must provide either a physical button or a software button. If you use the PIN method, you must know the PIN of the WiFi device that you are trying to connect.

WPS supports WPA and WPA2 WiFi security. If your modem router network is open (no WiFi security is set, which is not the default setting for the modem router), connecting with WPS automatically sets WPA + WPA2 WiFi security on the modem router network and generates a random passphrase. You can view this passphrase (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93).

---

**Note:** WPS and WPA/WPA2 enterprise security or WEP security cannot function together. When you enable WPA/WPA2 enterprise security or WEP security, WPS is disabled.

---

**Use WPS with the Push Button Method**

For you to use the push button method to connect a WiFi device to the modem router’s WiFi network, the WiFi device that you are trying to connect must provide either a physical button or a software button. You can use the physical button and software button to let a WiFi device join only the main WiFi network, not the guest WiFi network.

➢ **To let a WiFi device join the modem router’s main WiFi network using WPS with the push button method:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   
   A login window opens.
3. Enter the user name and password for the modem router.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

   The BASIC Home page displays.

5. Select **ADVANCED > WPS Wizard**.

   The page displays a description of the WPS method.

6. Click the **Next** button.

    ![Advanced WPS Wizard](image)

    By default, the **Push Button (recommended)** radio button is selected.

7. Either click the 🌿 button onscreen or press the **WPS** button on the right side panel of the modem router for three seconds.

   For two minutes, the modem router attempts to find the WiFi device (that is, the client) that you want to join the modem router’s main WiFi network.

   During this time, the WiFi LED on the front panel of the modem router blinks blue.

8. Within two minutes, go to the WiFi device and press its **WPS** button to join the modem router’s main WiFi network without entering a password.

   After the modem router establishes a WPS connection, the WiFi LED lights solid blue and the Add WPS Client page displays a confirmation message.

9. To verify that the WiFi device is connected to the modem router’s main WiFi network, select **BASIC > Attached Device**.

   The WiFi device displays onscreen.

**Use WPS with the PIN Method**

To use the PIN method to connect a WiFi device to the modem router’s WiFi network, you must know the PIN of the WiFi device that you are trying to connect.
To let a WiFi device join the modem router’s WiFi network using WPS with the PIN method:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > WPS Wizard.
   The page displays a description of the WPS method.
6. Click the Next button.
   The Add WPS Client page adjusts.
   The Push Button (recommended) radio button is selected by default.
7. Select the PIN Number radio button.
8. In the Enter Client’s PIN field, enter the PIN number of the WiFi device.
9. Click the Next button.
   For four minutes, the modem router attempts to find the WiFi device (that is, the client) that you want to join the modem router’s main WiFi network.
   During this time, the WiFi LED on the front panel of the modem router blinks blue.
10. Within four minutes, go to the WiFi device and use its WPS software to join the network without entering a password.
    When the modem router establishes a WPS connection, the WiFi LED lights solid blue and the Add WPS Client page displays a confirmation message.
11. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC > Attached Device.
    The WiFi device displays onscreen.
Manage the Basic WiFi Settings and WiFi Security of the Guest Network

A guest network allows visitors to use the Internet without using your WiFi security key. By default, the guest WiFi network is disabled. You can enable and configure the guest WiFi network for each WiFi band: 2.4 GHz b/g/n and 5.0 GHz a/n/ac.

Set Up and Enable a Guest Network

The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For example, if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band, the guest WiFi network also functions in the Up to 54 Mbps mode in the 2.4 GHz band. For information about configuring the WiFi mode, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93.

➢ To set up a guest network:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
   The BASIC Home page displays.
4. Select Guest Network.
5. Enable the guest network and configure its WiFi settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wireless Network (2.4GHz b/g/n) - Profile</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Guest Network</td>
<td>By default, the guest WiFi network is disabled. To enable the guest WiFi network for the 2.4 GHz WiFi band, select the <strong>Enable Guest Network</strong> check box.</td>
</tr>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID of the 2.4 GHz WiFi band so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast for the 2.4 GHz WiFi band for the guest WiFi network, clear the <strong>Enable SSID Broadcast</strong> check box.</td>
</tr>
<tr>
<td>Allow guests to see each other and access my local network</td>
<td>By default, WiFi clients that are connected to the 2.4 GHz WiFi band of the guest WiFi network cannot access WiFi devices or Ethernet devices that are connected to the main WiFi network. To allow access to the main WiFi network, select the <strong>Allow guests to see each other and access my local network</strong> check box.</td>
</tr>
<tr>
<td>Guest Wireless Network Name (SSID)</td>
<td>The SSID is the 2.4 GHz WiFi band name. If you did not change the SSID, the default SSID displays, which is NETGEAR-Guest. If you want to change the SSID in the 2.4 GHz WiFi band for the guest WiFi network, enter a 32-character (maximum), case-sensitive name in this field.</td>
</tr>
</tbody>
</table>
Manage the WiFi Network Settings

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Security Options - Profile

If you want to change the WiFi security, select one of the following WiFi security options for the 2.4 GHz band of the guest WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the 2.4 GHz band of the guest WiFi network. This is the default setting for the guest WiFi network.

- **WEP.** Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93). For information about configuring WEP, see Configure WEP Legacy WiFi Security for the Guest WiFi Network on page 108.

- **WPA2-PSK [AES].** WPA2 provides a secure and fast connection but some older WiFi devices do not detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect to the 2.4 GHz band of the guest WiFi network at the fastest speed. If your network includes older devices that do not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

  To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

- **WPA-PSK [TKIP] + WPA2-PSK [AES].** This type of security enables WiFi devices that support either WPA or WPA2 to join the 2.4 GHz band of the guest WiFi network. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

  To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

**Wireless Network (5GHz a/n/ac) - Profile**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Guest Network</td>
<td>By default, the guest WiFi network is disabled. To enable the guest WiFi network for the 5 GHz WiFi band, select the Enable Guest Network check box.</td>
</tr>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID of the 5 GHz WiFi band so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast for the 5 GHz WiFi band for the guest WiFi network, clear the Enable SSID Broadcast check box.</td>
</tr>
<tr>
<td>Allow guests to see each other and access my local network</td>
<td>By default, WiFi clients that are connected to the 5 GHz WiFi band of the guest WiFi network cannot access WiFi devices or Ethernet devices that are connected to the main WiFi network. To allow access to the main WiFi network, select the Allow guests to see each other and access my local network check box.</td>
</tr>
<tr>
<td>Guest Wireless Network Name (SSID)</td>
<td>The SSID is the 5 GHz WiFi band name. If you did not change the SSID, the default SSID displays, which is NETGEAR-5G-Guest. If you want to change the SSID in the 5 GHz WiFi band for the guest WiFi network, enter a 32-character (maximum), case-sensitive name in this field.</td>
</tr>
</tbody>
</table>
6. Click the Apply button.
   Your settings are saved.

7. Make sure that you can reconnect over WiFi to the guest network.
   If you cannot connect over WiFi, check the following:
   • If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.
   • Does your WiFi device display as an attached device? (See View Devices Currently on the Network on page 237.) If it does, it is connected to the network.
   • Are you using the correct network name (SSID) and password?

### Configure WEP Legacy WiFi Security for the Guest WiFi Network

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. WEP supports speeds of up to 54 Mbps (the modem router is capable of speeds of up to 300 Mbps in the 2.4 GHz band).
IMPORTANT:

The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For you to be able to configure WEP in the guest WiFi network, first configure the mode for the main WiFi network as Up to 54 Mbps. For information about configuring the WiFi mode, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 93.

To configure WEP security for the guest WiFi network:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. In the address field of your browser, enter `http://routerlogin.net`. A login window opens.
3. Type `admin` for the user name and type your password. If you did not yet personalize your password, type `password` for the password.
4. Click the OK button. The BASIC Home page displays.
5. Select **BASIC > Guest Network**. The Guest Network Settings page displays.
6. In the Security Options section, select the **WEP** radio button.
7. From the **Authentication Type** menu in the Security Encryption (WEP) section, select one of the following types:
   - **Shared Key**. Clients can use only Shared Key authentication.
   - **Automatic**. Clients can use either Open System or Shared Key authentication.
8. From the **Encryption Strength** menu in the Security Encryption (WEP) section, select the encryption key size:

   - **64-bit**. Standard WEP encryption, using 40/64-bit encryption.
   - **128-bit**. Standard WEP encryption, using 104/128-bit encryption. This selection provides stronger encryption security.

9. In the Security Encryption (WEP) Key section, generate the key automatically:
   a. In the **Passphrase** field, enter a passphrase.
   b. Click the **Generate** button.

      For 64-bit WEP, four different WEP keys are generated and the four key fields are populated with different WEP keys. For 128-bit WEP, only one WEP key is generated and the four key fields are populated with the same WEP key.

   c. Specify the active key by selecting the **Key 1**, **Key 2**, **Key 3**, or **Key 4** radio button.

      Only one key can be the active key.

      To join the guest WiFi network, a user must enter the key value for the key that you specified as the active key.

10. Click the **Apply** button.

    Your settings are saved.

---

**Control the WiFi Radios**

The modem router provides internal WiFi radios that broadcast signals in the 2.4 GHz and 5 GHz ranges. By default, they are on so that you can connect over WiFi to the modem router. When the WiFi radios are off, you can still use an Ethernet cable for a LAN connection to the modem router.

You can turn the WiFi radios on and off with the **WiFi On/Off** button on the modem router, or you can log in to the modem router and enable or disable the WiFi radios through the web management interface. If you are close to the modem router, it might be easier to press the **WiFi On/Off** button. If you are away from the modem router or already logged in, it might be easier to enable or disable the radios through the web management interface. You can also turn the WiFi radios off and on based on a schedule. (See **Set Up a WiFi Schedule** on page 112.)

**Tip:** If you want to disable the WiFi radios of the modem router, use a wired connection to avoid being disconnected when the WiFi radios turn off.

**Use the WiFi On/Off Button**

**To turn the WiFi radios off and on with the WiFi On/Off button:**

Press the **WiFi On/Off** button on the right side panel of the modem router for three seconds.

If you turned off the WiFi radios, the WiFi LED turns off. If you turned on the WiFi radios, the WiFi LED lights solid blue after about half a minute.
Enable or Disable the WiFi Radios

If you used the WiFi On/Off button to turn off the WiFi radios, you cannot log in to the modem router over a WiFi connection to turn them back on. You must press the WiFi On/Off button again for three seconds to turn the WiFi radios back on.

To enable or disable the WiFi radios:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.

The previous figure does not show the bottom of the Wireless Settings page.
6. Do one of the following in the Advanced Wireless Settings (2.4GHz b/g/n) section, Advanced Wireless Settings (5GHz 802.11a/n/ac) section, or both sections:
   - **Turn off the radio.** Clear the **Enable Wireless Router Radio** check box.
     If both radios are disabled, the WiFi LED turns off (see Front Panel with LEDs on page 11).
   - **Turn on the radio.** Select the **Enable Wireless Router Radio** check box.
     If you enable at least one radio, the WiFi LED lights solid blue after about half a minute.

7. Click the **Apply** button.
   Your settings are saved.

**Set Up a WiFi Schedule**

You can use this feature to turn off the WiFi signal from your modem router at times when you do not need a WiFi connection. For example, you might turn it off for the weekend if you leave town. You can set up separate schedules for the 2.4 GHz and 5 GHz bands.

- **To set up the WiFi schedule:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     A login window opens.
  3. Enter the modem router user name and password.
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
     The BASIC Home page displays.
  4. Select **ADVANCED > Advanced Setup > Wireless Settings**.
5. Either in the Advanced Wireless Settings (2.4GHz b/g/n) section or the Advanced Wireless Settings (5GHz 802.11a/n/ac) section, click the Add a new period button.

6. Use the menus, radio buttons, and check boxes to set up a period during which you want to turn off the WiFi signal and specify whether the schedule is recurrent.

7. Click the Apply button.

The Wireless Settings page displays.

8. Select the Turn off wireless signal by schedule check box to activate the schedule.

9. Click the Apply button.

Your settings are saved.
Manage the WPS Settings

Wi-Fi Protected Setup (WPS) lets you join the WiFi network without typing the WiFi password. You can change the WPS default and security settings.

➢ To manage WPS settings:

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type http://www.routerlogin.net.
   A login window opens.

3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
   The BASIC Home page displays.

   The Wireless Settings page displays.

5. Scroll down to the bottom of the page.

   The Router’s PIN field displays the fixed PIN that you use to configure the modem router’s WiFi settings from another platform through WPS.

6. To disable the PIN, clear the Enable Router’s PIN check box.

   By default, the Enable Router’s PIN check box is selected and the modem router’s PIN is enabled. For enhanced security, you can disable the modem router’s PIN by clearing the Enable Router’s PIN check box. However, when you disable the modem router’s PIN, WPS is not disabled because you can still use the physical WPS button.

7. To keep the PIN enabled and change the number of times that a PIN connection is allowed to fail before the PIN is automatically disabled, enter a number in the field.

   By default, the PIN is automatically disabled after three failed connection attempts. If the PIN is automatically disabled, the WiFi LED on the front panel of the modem router blinks blue. The PIN remains disabled until you restart the modem router.

   Note: The PIN function might temporarily be disabled automatically if the modem router detects suspicious attempts to break into the modem router’s WiFi settings by using the modem router’s PIN through WPS.
8. To keep the PIN enabled but disable the PIN failure security, clear the To prevent PIN compromise check box.

9. To allow the WiFi settings to be changed automatically when you use WPS, do the following:
   • To allow the WiFi settings to be changed for the 2.4 GHz band, clear the Keep Existing Wireless Settings (2.4GHz b/g/n) check box.
   • To allow the WiFi settings to be changed for the 5 GHz band, clear the Keep Existing Wireless Settings (5GHz a/n/ac) check box.

By default, these check boxes are selected. NETGEAR recommends that you leave them selected. If you clear these check boxes, the next time that a new WiFi client uses WPS to connect to the modem router, the WiFi settings of the modem router change to an automatically generated random SSID and passphrase for the band to which the client connects. For information about viewing this SSID and passphrase, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93.

Clear the Keep Existing Wireless Settings (2.4GHz b/g/n) or Existing Wireless Settings (5GHz a/n/ac) check box only if you want to allow the WPS process to change the SSID and passphrase for WiFi access for the WiFi band.

**WARNING:**
If you clear the Keep Existing Wireless Settings check box for a WiFi band and use WPS to add a computer or WiFi device to that band of the modem router’s WiFi network, the SSID and passphrase are automatically generated and other WiFi devices that are already connected to the band of the modem router’s WiFi network might be disconnected.

10. Click the Apply button.
    Your settings are saved.

**Manage Advanced WiFi Features**

For most WiFi networks, the advanced WiFi features work fine and you do not need to change the settings.

**Tip:** If you want to change the WiFi settings of the modem router's main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

➢ To manage advanced WiFi features:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
A login window opens.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Wireless Settings**.

The previous figure does not show the bottom of the Wireless Settings page.

6. Enter the settings as described in the following table.

   Except for the description of 20/40 MHz coexistence, the descriptions in the table (not the settings onscreen) apply to both the Advanced Wireless Settings (2.4GHz b/g/n) section and the Advanced Wireless Settings (5GHz 802.11a/n/ac) section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable 20/40 MHz Coexistence</td>
<td>By default, 20/40 MHz coexistence is enabled to prevent interference between WiFi networks in your environment at the expense of the WiFi speed. If no other WiFi networks are present in your environment, you can clear the <strong>Enable 20/40 MHz Coexistence</strong> check box to increase the WiFi speed to the maximum supported speed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> 20/40 MHz coexistence applies to the 2.4 GHz band only.</td>
</tr>
</tbody>
</table>
7. Click the **Apply** button.
Your settings are saved.

**Use the Modem Router as a WiFi Access Point**

You can set up the modem router to function as a WiFi access point (AP) on the same local network as another router. When the modem router functions as a WiFi AP, many router-related features are disabled.

**Tip:** If you want to change the modem router’s function, use a wired connection to avoid being disconnected when the new function takes effect.

➢ **To set up the modem router as an AP:**

1. Use an Ethernet cable to connect the Internet port of the modem router to a LAN port on the other router.

   ![Diagram](image)

   **Cable the red Internet port to a LAN port on another router**

2. Launch a web browser from a computer or WiFi device that is connected to the network.

3. Type `http://www.routerlogin.net`.

   A login window opens.

4. Enter the modem router user name and password.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Wireless AP**.

6. Select the **Enable AP Mode** check box.

   The page adjusts.

7. Scroll down and select the radio button for the IP address setting that you want to use:
   - **Get dynamically from existing router**. The other router on the network assigns an IP address to the modem router while the modem router functions in access point mode.
   - **Enable fixed IP settings on this device (not recommended)**. Use this setting if you want to manually assign a specific IP address to the modem router while it functions in access point mode. Using this option effectively requires advanced network experience.

   **Note**: To avoid interference with other routers or gateways on your network, NETGEAR recommends that you use different WiFi settings on each router. You can also turn off the WiFi radio on the other router or gateway and use the modem router only for WiFi client access.

8. Click the **Apply** button.

   The IP address of the modem router changes, and you are disconnected.

9. To reconnect, close your browser, restart your browser, and type **http://www.routerlogin.net**.
The modem router comes with a built-in firewall that helps protect your home network from unwanted intrusions from the Internet.

This chapter includes the following sections:

- Set Up Parental Controls
- Allow or Block Access to Your Network
- Use Keywords to Block Internet Sites
- Manage Simple Outbound Firewall Rules for Services and Applications
- Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
- Set Up Security Event Email Notifications

For information about more advanced ways to configure Internet security, see *Chapter 14, Manage Port Forwarding and Port Triggering.*
Set Up Parental Controls

The first time that you select **Parental Controls** from the BASIC Home page, your browser goes to the **Parental Controls** website. You learn more about Parental Controls or download the application.

➢ **To set up Parental Controls:**
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type `http://www.routerlogin.net`.
      A login window opens.
   3. Enter the user name and password for the modem router.
      The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
   4. Click the **OK** button.
      The BASIC Home page displays.
   5. Select **Parental Controls**.
      The **Parental Controls** website opens.
   6. Click the button for the app or version that you want to download and use.
   7. Follow the onscreen instructions to download and install the app.
   8. Open the app and select **Parental Controls**.
      After installation, Live Parental Controls automatically starts.

   ![Live Parental Controls](image)

   9. Click the **Next** button, read the note, and click the **Next** button again.
Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log in or create a free account.

10. Select a radio button as follows:
   • If you already own an OpenDNS account, leave the Yes radio button selected.
   • If you did not yet create an OpenDNS account, select the No radio button.
     If you are creating an account, the Create a free OpenDNS account page displays.
     Do the following:
     a. Complete the fields.
     b. Click the Next button.

   After you log on or create your account, the filtering level page displays.

11. Select the radio button for the filtering level that you want and click the Next button.

   The Setup is complete page displays.

12. Click the Take me to the status screen button.

   The Status page displays. Parental Controls are now set up for the modem router.

13. To enable Parental Controls, click the Enable Live Parental Controls button.

Allow or Block Access to Your Network

You can use access control to block or allow access of devices to your network. You define access by selecting or specifying the MAC addresses of the wired and WiFi devices that can either access your entire network or are blocked from accessing your entire network.

Enable and Manage Network Access Control

When you enable access control, you must select whether new devices are allowed to access the network or blocked from accessing the network. By default, currently connected devices are allowed to access the network, but you can also block these devices from accessing the network.

➢ To set up network access control:
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type http://www.routerlogin.net.
Control Access to the Internet

A login window opens.

3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home page displays.

5. Select ADVANCED > Security > Access Control.

6. Select the Turn on Access Control check box.
   You must select this check box before you can specify an access rule and use the Allow and Block buttons. When this check box is cleared, all devices are allowed to connect, even if the device is in the list of blocked devices.

7. Click the Apply button.
   Your settings are saved.

8. Select an access rule for new devices:
   • Allow all new devices to connect. With this setting, if you add a new device, it can access your network. You do not need to enter its MAC address on this page. NETGEAR recommends that you leave this radio button selected.
   • Block all new devices from connecting. With this setting, if you add a new device, before it can access your network, you must enter its MAC address for an Ethernet connection and its MAC address for a WiFi connection in the allowed list. For more information, see Manage Network Access Control Lists on page 123.

The access rule does not affect previously blocked or allowed devices. It applies only to devices joining your network in the future after you apply these settings.
9. To manage access for currently connected computers and devices:
   • If you blocked all new devices from connecting, to allow the computer or device that
     you are currently using to continue to access the network, select the check box next
     to your computer or device in the table, and click the **Allow** button.
   • To either continue to allow or to block other computers and devices that are currently
     connected, select the check box next to the computer or device in the table, and click
     either the **Allow** button or the **Block** button.

10. Click the **Apply** button.
    Your settings are saved.

### Manage Network Access Control Lists

You can use access control to block or allow access to your network. An access control list
(ACL) functions with the MAC addresses of wired and WiFi devices that can either access
your entire network or are blocked from accessing your entire network.

The modem router can detect the MAC addresses of devices that are connected to the
network and list the MAC addresses of devices that were connected to the network.

Each network device owns a MAC address, which is a unique 12-character physical address, containing
the hexadecimal characters 0–9, a–f, or A–F (uppercase or lowercase) only, and separated by colons (for example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the
label of the WiFi card or network interface device. If you cannot see the label, you can display
the MAC address using the network configuration utilities of the computer. You might also
find the MAC addresses through the web management interface of the modem router (see
*View Devices Currently on the Network* on page 237).

### Add Devices to or Remove Them from the Allowed List

If you set up an access list that blocks all new devices from accessing your network, you
must specify which devices are allowed to access your network.

➢ **To add or remove devices that are allowed:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and
   password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.

5. Select ADVANCED > Security > Access Control.
   The Access Control page displays.

6. Click the View list of allowed devices not currently connected to the network link.

A table displays the detected device names, MAC addresses, and connection types of the devices that are not connected but allowed to access the network.

7. To add a device to the allowed list, do the following:
   a. Click the Add button.
      The Add Allowed Device page displays.
   b. Enter the MAC address and device name for the device that you want to allow.
   c. Click the Add button on the Add Allowed Device page.
      The device is added to the allowed list on the Access Control page.

8. To remove a device from the allowed list, do the following:
   a. Select the check box for the device.
   b. Click the Remove from the list button.
      The device is removed from the allowed list.

9. Click the Apply button.
    Your settings are saved.
Add Devices to or Remove Them from the Blocked List

If you set up an access list that allows all new devices to access your network but you want to block some devices from accessing your network, you must specify the devices that you want to block.

To add or remove devices that are blocked:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Security > Access Control.
   The Access Control page displays.
6. Click the View list of blocked devices not currently connected to the network link.

A table displays the detected device names, MAC addresses, and connection types of the devices that are not connected and blocked from accessing the network.
7. To add a device to the blocked list, do the following:
   a. Click the Add button.
      The Add Blocked Device page displays.
   b. Enter the MAC address and device name for the device that you want to block.
   c. Click the Add button on the Add Blocked Device page.
      The device is added to the blocked list on the Access Control page.

8. To remove a device from blocked list, do the following:
   a. Select the check box for the device.
   b. Click the Remove from the list button.
      The device is removed from the blocked list.

9. Click the Apply button.
   Your settings are saved.

Use Keywords to Block Internet Sites

You can block keywords and domains (websites) to prevent certain types of HTTP traffic from accessing your network. By default, keyword blocking is disabled and no domains are blocked.

Set Up Blocking

You can set up blocking of specific keywords and domains to occur continuously or according to a schedule.

➢ To set up keyword and domain blocking:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
      A login window opens.
   3. Enter the user name and password for the modem router.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   4. Click the OK button.
      The BASIC Home page displays.
   5. Select ADVANCED > Security > Block Sites.
6. Specify a keyword blocking option:
   • **Per Schedule.** Use keyword blocking according to a schedule that you set.
     
     For more information, see [Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules](#) on page 136.
   
   • **Always.** Use keyword blocking continuously.

7. In the **Type keyword or domain name here** field, enter a keyword or domain. Here are some sample entries:
   
   • Specify XXX to block http://www.badstuff.com/xxx.html.
   
   • Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.
   
   • Enter a period (.) to block all Internet browsing access.

8. Click the **Add Keyword** button.
   
   The keyword or domain is added to the **Block sites containing these keywords or domain names** field (which is also referred to as the blocked list).

9. To add more keywords or domains, repeat **Step 7** and **Step 8**.
   
   The keyword list supports up to 32 entries.

10. Click the **Apply** button.
    
    Your settings are saved.
Remove a Keyword or Domain from the Blocked List

If you no longer need a keyword or domain on the blocked list, you can remove the keyword or domain.

➢ **To remove a keyword or domain from the blocked list:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the **OK** button.
     The BASIC Home page displays.
  5. Select **ADVANCED > Security > Block Sites**.
     The Block Sites page displays.
  6. In the **Block sites containing these keywords or domain names** field, select the keyword or domain that you want to remove.
  7. Click the **Delete Keyword** button.
     The keyword or domain is removed from the blocked list.
  8. Click the **Apply** button.
     Your settings are saved.

Remove All Keywords and Domains from the Blocked List

You can simultaneously remove all keywords and domains from the blocked list.

➢ **To remove all keywords and domains from the blocked list:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the **OK** button.
     The BASIC Home page displays.
  5. Select **ADVANCED > Security > Block Sites**.
Control Access to the Internet

The Block Sites page displays.

6. Click the **Clear List** button.
   All keywords and domains are removed from the blocked list.

7. Click the **Apply** button.
   Your settings are saved.

**Specify a Trusted Computer**

You can exempt one trusted device from blocking and logging. The device that you exempt must be assigned a fixed (static) IP address.

➢ **To specify a trusted device:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   A login window opens.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **ADVANCED > Security > Block Sites**.
6. Scroll down and select the **Allow trusted IP address to visit blocked sites** check box.

7. In the **Trusted IP Address** field, enter the IP address of the trusted device.
   
   The first three octets of the IP address are automatically populated and depend on the IP address that is assigned to the modem router on the LAN Setup page.

8. Click the **Apply** button.
   
   Your settings are saved.

---

**Manage Simple Outbound Firewall Rules for Services and Applications**

A firewall protects one network (the trusted network, such as your LAN) from another (the untrusted network, such as the Internet), while allowing communication between the two.

The modem router provides one default *outbound* firewall rule: It allows all access to the Internet (that is, the WAN). You can add simple rules to prevent access to specific services and applications on the Internet. In addition, you can specify if a rule applies to one user, a range of users, or all users on your LAN.

The modem router lists many default services and applications that you can use in outbound rules. You can also add an outbound firewall rule for a custom service or application.

For information about blocking specific keywords, URLs, or sites, see *Use Keywords to Block Internet Sites* on page 126. This type of blocking is another aspect of the outbound firewall.

For information about *inbound* firewall rules, see *Manage Port Forwarding and Port Triggering* on page 257.

---

**Note:** Service blocking means the same thing as applying outbound firewall rules.

---

**Add an Outbound Firewall Rule**

You can add an outbound firewall rule to prevent access to a specific service or application on the Internet.

- **To add an outbound firewall rule:**
  
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     
     A login window opens.
  3. Enter the user name and password for the modem router.

---
The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home page displays.


6. In the Service Blocking section, specify how the modem router applies outbound rules:
   • Per Schedule. The modem router applies outbound rules according to a schedule that you set.
     For more information, see Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules on page 136.
   • Always. The modem router applies outbound rules continuously.

7. Below the Service Table, click the Add button.

8. From the Service Type menu, select service or application to be covered by this rule.
If the service or application does not display in the list, you can add it (see Add an Outbound Firewall Rule for a Custom Service or Application on page 132).

9. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP addresses:
   • **Only This IP Address.** Enter the required address in the fields to apply the rule to a single device on your LAN.
   • **IP Address Range.** Enter the required addresses in the start and end fields to apply the rule to a range of devices.
   • **All IP Addresses.** All computers and devices on your LAN are covered by this rule.
     By default, the All IP Addresses radio button is selected.

10. Click the **Add** button.
    The new rule is added to the Service Table on the Block Services page.

---

**Add an Outbound Firewall Rule for a Custom Service or Application**

The modem router lists many default services and applications that you can use in outbound rules. If the service or application is not predefined, you specify a custom service or application in an outbound rule.

➢ **To add an outbound firewall rule for a custom service or application:**

1. Find out which protocol and port number or range of numbers the service or application uses.
   You can usually find this information by contacting the publisher of the service or application or through online user or news groups.

2. Launch a web browser from a computer or WiFi device that is connected to the network.

3. Type **http://www.routerlogin.net**.
   A login window opens.

4. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

5. Click the **OK** button.
   The BASIC Home page displays.

6. Select **ADVANCED > Security > Block Services.**
7. If this is the first time that you add an outbound firewall rule, in the Service Blocking section, specify how the modem router applies outbound rules:
   • **Per Schedule.** The modem router applies outbound rules according to a schedule that you set.
     
     For more information, see *Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules* on page 136.
   
   • **Always.** The modem router applies outbound rules continuously.

8. Below the Service Table, click the **Add** button.

9. From the **Service Type** menu, select **User Defined**.
10. Specify a new outbound rule as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Select the protocol (TCP or UDP) that is associated with the service or application. If you are unsure, select TCP/UDP.</td>
</tr>
<tr>
<td>Starting Port</td>
<td>Enter the start port for the service or application.</td>
</tr>
<tr>
<td>Ending Port</td>
<td>If the service or application uses a range of ports, enter the end port for the range. If the service or application uses a single port, repeat the port number that you entered in the Starting Port field.</td>
</tr>
<tr>
<td>Service Type/User Defined</td>
<td>Enter the name of the custom service or application.</td>
</tr>
</tbody>
</table>

11. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP addresses:
   - **Only This IP Address.** Enter the required address in the fields to apply the rule to a single device on your LAN.
   - **IP Address Range.** Enter the required addresses in the start and end fields to apply the rule to a range of devices.
   - **All IP Addresses.** All computers and devices on your LAN are covered by this rule. By default, the All IP Addresses radio button is selected.

12. Click the Add button.
   The new rule is added to the Service Table on the Block Services page.

### Change an Outbound Firewall Rule

You can change an existing outbound firewall rule.

- **To change an outbound firewall rule:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is admin. The default password is password. The user name and password are case-sensitive.
  4. Click the OK button.
     The BASIC Home page displays.
  5. Select **ADVANCED > Security > Block Services.**
     The following figure shows two rules in the Service Table.
Control Access to the Internet

6. In the Service Table, select the radio button for the rule.

7. Click the **Edit** button.
   
The Block Services Setup page displays.

8. Change the settings.
   
   For more information about the settings, see *Add an Outbound Firewall Rule for a Custom Service or Application* on page 132.

9. Click the **Accept** button.
   
   Your settings are saved. The changed rule displays in the Service Table on the Block Services page.

---

**Remove an Outbound Firewall Rule**

You can remove an outbound firewall rule that you no longer need.

➢ **To remove an outbound firewall rule:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.
   
   A login window opens.

3. Enter the user name and password for the modem router.
   
   The user name is *admin*. The default password is *password*. The user name and password are case-sensitive.

4. Click the **OK** button.
   
   The BASIC Home page displays.

5. Select **ADVANCED > Security > Block Services**.
   
   The following figure shows two rules in the Service Table.
6. In the Service Table, select the radio button for the rule.
7. Click the Delete button.
   The rule is removed from the Service Table.

Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules

You can set up a schedule that you can apply to keyword blocking (see Use Keywords to Block Internet Sites on page 126) and outbound firewall rules (see Manage Simple Outbound Firewall Rules for Services and Applications on page 130).

If applied, the schedule specifies the days and time that keyword blocking and outbound firewall rules are active.

By default, no schedule is set and you can either enable or disable this feature.

➢ To set up a schedule for blocking:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Security > Schedule.
6. Set up the schedule for blocking:
   - **Days to Block.** Select the check box for each day that you want to block access or specify that blocking occurs on every day by selecting the Every Day check box.
     
     By default, the Every Day check box is selected.
   
   - **Time of Day to Block.** Select a start and end time for blocking in 24-hour format or select the All Day check box for 24-hour blocking.
     
     By default, the All Day check box is selected.

7. From the **Time Zone** menu, select your time zone.

8. If you live in an area that observes daylight saving time, select the Automatically adjust for daylight savings time check box.

   **Note:** If the modem router synchronizes its internal clock with a time server on the Internet and you selected the correct time zone, the Current Time field displays the correct date and time.

9. Click the **Apply** button.

   Your settings are saved.
Set Up Security Event Email Notifications

The modem router can email you its logs of its activity. The log records router activity and security events such as attempts to access blocked sites or services.

➢ To set up email notifications:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Security > E-mail.

6. Select the Turn E-mail Notification On check box.
7. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send alerts and logs through e-mail</strong></td>
<td></td>
</tr>
<tr>
<td>Your Outgoing Mail Server</td>
<td>Enter the name of your ISP’s outgoing (SMTP) mail server (such as mail.myISP.com). You might be able to find this information on the configuration page of your email program. If you leave this field blank, the modem router cannot send log and alert messages.</td>
</tr>
<tr>
<td>Send to This E-mail Address</td>
<td>Enter the email address to which logs and alerts must be sent.</td>
</tr>
<tr>
<td>Outgoing Mail Server Port Number</td>
<td>Enter the port number for your ISP’s outgoing mail server. The default port number is 25.</td>
</tr>
<tr>
<td>My mail server requires authentication</td>
<td>If your ISP’s outgoing email server requires authentication, select this check box and specify the following settings: • In the User Name field, enter the user name for your ISP’s outgoing email server. • In the Password field, enter the password for your ISP’s outgoing email server.</td>
</tr>
<tr>
<td>Send Alert Immediately</td>
<td>By default, this check box is selected and email alerts are sent immediately when someone attempts to visit a blocked site.</td>
</tr>
<tr>
<td><strong>Send logs according to this schedule</strong></td>
<td></td>
</tr>
<tr>
<td>To send logs based on a schedule, select one of the following options from the menu: • <strong>When log is full.</strong> This is the default selection. • <strong>Hourly.</strong> Logs are sent every hour. • <strong>Daily.</strong> Logs are sent every day. From the Time menu, specify the time of day, and select the am or pm radio button. • <strong>Weekly.</strong> Logs are sent every week. From the Day menu, select the day. From the Time menu, specify the time of day, and select the am or pm radio button. If you do not want logs to be sent at all, select the None option from the menu.</td>
<td></td>
</tr>
</tbody>
</table>

8. Click the **Apply** button.

Your settings are saved.

Logs are sent automatically. If the log fills before the specified time, it is sent. After the log is sent, it is cleared from the modem router memory. If the modem router cannot email the log and the log buffer fills, the modem router overwrites the log.
This chapter describes how you can optimize the modem router’s performance and manage the traffic flows through the modem router.

This chapter contains the following sections:

- Optimize Traffic with Internet Access QoS
- Manage Default and Custom QoS Rules
- Manage Wi-Fi Multimedia Quality of Service
- Manage Implicit Beamforming
- Improve Network Connections with Universal Plug and Play
Optimize Traffic with Internet Access QoS

You can use Quality of Service (QoS) rules to assign different priorities to Internet traffic, applications, services, and devices on your LAN. The modem router provides default QoS rules. You add custom QoS rules and manage both default and custom QoS rules (see Manage Default and Custom QoS Rules on page 142).

NETGEAR recommends that you enable Internet access QoS only if you use streaming Internet. When Internet access QoS assigns a high priority to streaming video, it also assigns lower priority to the rest of your Internet traffic. That means that other tasks such as downloading content from the Internet take longer.

➢ To enable Internet access QoS:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > QoS Setup.

![QoS Setup](image)

7. Specify the uplink bandwidth settings by doing one of the following:
   • If you know the uplink bandwidth of your Internet connection, type it in the Uplink bandwidth Maximum field.
• If you are not sure, click the SpeedTest button.
   The speed test checks your uplink bandwidth and automatically enters the detected
   uplink bandwidth in the Uplink bandwidth Maximum field.

8. Click the Apply button.
   Your settings are saved.

Manage Default and Custom QoS Rules

QoS rules apply when you enable Internet access QoS (see Optimize Traffic with Internet
Access QoS on page 141).

You can add custom QoS rules and change and remove both default and custom QoS rules.
You can add QoS rules for services and applications but also for specific devices on your
network.

You can set up custom rules for the following components:

• Application or online game (see Create a Custom QoS Rule for an Application or Online
  Game on page 143)
• Ethernet LAN port of the modem router (see Create a Custom QoS Rule for a Modem
  Router LAN Port on page 145)
• Device on the LAN by MAC address (see Create a Custom QoS Rule for a MAC Address
  on page 146)

View the Default QoS Rules

The modem router provides default QoS rules for common applications and games.

➢ To view the default QoS rules:
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type http://www.routerlogin.net.
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is admin. The default password is password. The user name and
     password are case-sensitive.
  4. Click the OK button.
     The BASIC Home page displays.
  5. Select ADVANCED > Setup > QoS Setup.
     The QoS Setup page displays.
  6. Click the Set Up QoS Rule button.
7. Scroll down to see more QoS rules.
   For information about changing a default QoS rule, see Change a Default or Custom QoS Rule on page 149.

Create a Custom QoS Rule for an Application or Online Game

If the application or online game for which you want to assign a traffic priority is not part of the default QoS rules, you can add a custom QoS rule.

➢ To create a QoS policy for an application or online game:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
      A login window opens.
   3. Enter the user name and password for the modem router.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   4. Click the OK button.
      The BASIC Home page displays.
   5. Select ADVANCED > Setup > QoS Setup.
      The QoS Setup page displays.
6. Click the **Set Up QoS Rule** button.
   The QoS Priority Rule list page displays.

7. Scroll down and click the **Add Priority Rule** button.
   The QoS - Priority Rules page displays.

8. From the **Priority Category** menu, select one of the following options:
   - **Applications**. When you select **Applications** from the **Priority Category** menu, the Applications menu lets you select existing applications, but scroll down to the bottom of the menu to select **Add a new application**.

   ![QoS - Priority Rules](image)

   - **Online Gaming**. When you select **Online Gaming** from the **Priority Category** menu, the Applications menu lets you select existing games, but scroll down to the bottom of the menu to select **Add a new game**.

   ![QoS - Priority Rules](image)

9. Specify the new QoS rule as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority Policy for</td>
<td>Enter a name for the QoS rule.</td>
</tr>
<tr>
<td>Priority</td>
<td>Select the priority (<strong>Highest</strong>, <strong>High</strong>, <strong>Normal</strong>, or <strong>Low</strong>) that must be assigned to the application or game.</td>
</tr>
</tbody>
</table>
Create a Custom QoS Rule for a Modem Router LAN Port

You can add a custom QoS rule that applies only to a specific LAN port of the modem router. The rule affects any device that is connected to the LAN port.

➢ To create a QoS policy for a LAN port of the modem router:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > QoS Setup.
   The QoS Setup page displays.
6. Click the Set Up QoS Rule button.
   The QoS Priority Rule list page displays.
7. Scroll down and click the Add Priority Rule button.
   The QoS - Priority Rules page displays.
8. From the Priority Category menu, select Ethernet LAN Port.
9. From the LAN Port menu, select the LAN port (1, 2, 3, or 4) for which you want to configure the QoS policy.

   The QoS Policy for field updates automatically.

10. From the Priority menu, select the priority (Highest, High, Normal, or Low) that must be assigned to the LAN port.

11. Click the Apply button.

    Your settings are saved. The new rule is added to the table on the QoS Priority Rule list page. However, if you restart the modem router, the QoS rule is lost.

12. On the QoS Priority Rule list page, click the Apply button.

    Your settings are saved and the new QoS rule remains available after you restart the modem router.

**Create a Custom QoS Rule for a MAC Address**

You can add a custom QoS rule that applies only to a specific MAC address for a device on the LAN.

➢ To create a QoS policy for a specific MAC address:

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type http://www.routerlogin.net.

   A login window opens.

3. Enter the user name and password for the modem router.

   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.

   The BASIC Home page displays.

5. Select ADVANCED > Setup > QoS Setup.

   The QoS Setup page displays.

6. Click the Set Up QoS Rule button.

   The QoS Priority Rule list page displays.
7. Scroll down and click the **Add Priority Rule** button.

   The QoS - Priority Rules page displays.

8. From the **Priority Category** menu, select **MAC Address**.

9. In the **QoS Policy for** field, type a descriptive name for the new policy.

10. If the device for which you want to create a QoS policy is displayed in the MAC Device List, select its radio button.

    The information from the MAC Device List automatically populates the **QoS Policy for**, **MAC Address**, and **Device Name** fields.

11. If the device does not display in the MAC Device List, click the **Refresh** button.

    If it still does not display, complete the **QoS Policy for**, **MAC Address**, and **Device Name** fields manually.

12. From the **Priority** menu, select the priority (**Highest**, **High**, **Normal**, or **Low**) that must be assigned to the MAC address.

13. Click the **Apply** button.

    Your settings are saved. The new rule is added to the table on the QoS Priority Rule list page. However, if you restart the modem router, the QoS rule is lost.

14. On the QoS Priority Rule list page, click the **Apply** button.

    Your settings are saved and the new QoS rule remains available after you restart the modem router.

**Change a MAC Address for a QoS Rule**

➢ **To change a MAC address on the MAC Device List for QoS rules:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type [http://www.routerlogin.net](http://www.routerlogin.net).

   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **ADVANCED > Setup > QoS Setup**.
   The QoS Setup page displays.

6. Click the **Set Up QoS Rule** button.
   The QoS Priority Rule list page displays.

7. Scroll down and click the **Add Priority Rule** button.
   The QoS - Priority Rules page displays.

8. From the **Priority Category** menu, select **MAC Address**.
   The MAC Device List displays.

9. In the MAC Device List, select the radio button next to the device that you want to change.
   The information from the MAC Device List automatically populates the **QoS Policy for**, **MAC Address**, and **Device Name** fields.

10. Change the MAC address, device name, or priority.
11. Click the **Edit** button.
    The new device information is saved in the MAC Device List.

   **Note:** You cannot change the MAC address for a device that was detected by the modem router and automatically added to the MAC Device List.

### Remove a MAC Address for a QoS Rule

To remove a MAC address from the MAC Device List for QoS rules:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > QoS Setup**.
   The QoS Setup page displays.
6. Click the **Set Up QoS Rule** button.
   The QoS Priority Rule list page displays.

7. Scroll down and click the **Add Priority Rule** button.
   The QoS - Priority Rules page displays.

8. From the **Priority Category** menu, select **MAC Address**.
   The MAC Device List displays.

9. In the MAC Device List, select the radio button next to the device that you want to remove.
10. Click the **Delete** button.
    The device information is removed from the MAC Device List.

**Note:** You cannot remove a device that was detected by the modem router and automatically added to the MAC Device List.

### Change a Default or Custom QoS Rule

You can change a default or custom QoS rule.

➢ **To change a default or custom QoS rule:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > QoS Setup**.
6. Select the radio button next to the QoS policy that you want to view or change.
7. Scroll down and click the **Edit** button.
   The QoS - Priority Rules page displays.
8. Change the policy settings.
   For default QoS rules, NETGEAR recommends that you change the priority only. For information about changing custom QoS rules, see the following sections:
   - *Create a Custom QoS Rule for an Application or Online Game* on page 143
   - *Create a Custom QoS Rule for a Modem Router LAN Port* on page 145
   - *Create a Custom QoS Rule for a MAC Address* on page 146
9. Click the **Apply** button.
   Your settings are saved. The rule is updated in the table on the QoS Priority Rule list page. However, if you restart the modem router, the changed to the QoS rule are lost.
10. On the QoS Priority Rule list page, click the **Apply** button.
    Your settings are saved and the updated QoS rule remains available after you restart the modem router.
**Remove a QoS Rule**

You can remove an individual custom or default QoS rule.

➢ **To remove an individual QoS rule:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**. A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button. The BASIC Home page displays.
5. Select **ADVANCED > Setup > QoS Setup**. The QoS Setup page displays.
6. Select the radio button for the application, game, LAN port, or MAC address.
7. Scroll down and click the **Delete** button.
   The QoS rule is removed.

**Remove All QoS Rules**

You can permanently remove all custom and default QoS rules.

⚠️ **WARNING:**

If you remove all QoS rules, both the custom and default QoS rules are permanently removed. The only way to get the default QoS rules back is by returning the modem router to factory default settings.

➢ **To remove all QoS rules:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**. A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button. The BASIC Home page displays.
5. Select **ADVANCED > Setup > QoS Setup**.
The QoS Setup page displays.

6. Scroll down and click the **Delete All** button.
All QoS rules are permanently removed.

**Manage Wi-Fi Multimedia Quality of Service**

Wi-Fi Multimedia Quality of Service (WMM QoS) prioritizes WiFi voice and video traffic over the WiFi link.

WMM QoS prioritizes WiFi data packets from different applications based on four access categories: voice, video, best effort, and background. For an application to receive the benefits of WMM QoS, WMM must be enabled on both the application and the client running that application. Legacy applications that do not support WMM and applications that do not require QoS are assigned to the best effort category, which receives a lower priority than voice and video.

WMM QoS is automatically enabled for the modem router. However, you can disable WMM QoS.

➢ **To disable WMM QoS:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > QoS Setup**.
   The QoS Setup page displays.
6. Clear the **Enable WMM (Wi-Fi multimedia) settings** check box.
7. Click the **Apply** button.
   Your settings are saved.
Manage Implicit Beamforming

The modem router supports beamforming to enhance the WiFi range and performance for your WiFi devices. When you enable beamforming and connect to the WiFi network, the modem router actively tracks your device and directs WiFi to your device, rather than just blasting it out in all directions.

The modem router uses explicit and implicit beamforming to improve WiFi performance. Explicit beamforming requires the devices to support beamforming. (Typically, 802.11ac devices support beamforming.) Implicit beamforming means that the modem router supports beamforming even with devices that do not support beamforming. The modem router supports implicit beamforming for both 2.4 GHz and 5 GHz devices, which means that the modem router can provide beamforming benefits of better range and performance for all WiFi devices, even older 802.11a/b/g/n devices and not just the latest WiFi devices.

➢ To enable implicit beamforming:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.
   The Wireless Settings page displays.
6. Scroll down to the very bottom of the page.
7. Select the Enable Implicit BEAMFORMING check box.
8. Click the Apply button.
   Your settings are saved.
Improve Network Connections with Universal Plug and Play

Universal Plug and Play (UPnP) helps devices such as Internet appliances and computers access the network and connect to other devices as needed. UPnP devices can automatically discover the services from other registered UPnP devices on the network.

If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time communications such as instant messaging or remote assistance, keep UPnP enabled, which it is by default.

➢ To manage Universal Plug and Play:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > UPnP. The UPnP page displays.
6. Select or clear the Turn UPnP On check box. By default, this check box is selected. UPnP for automatic device configuration can be enabled or disabled. If the Turn UPnP On check box is cleared, the modem router does not allow any device to automatically control router resources, such as port forwarding.
7. Enter the advertisement period in minutes. The advertisement period specifies how often the modem router broadcasts its UPnP information. This value can range from 1 to 1440 minutes. The default period is 30 minutes. Shorter durations ensure that control points detect current device status at the expense of more network traffic. Longer durations can compromise the freshness of the device status but can significantly reduce network traffic.
8. Enter the advertisement time to live in hops. The time to live for the advertisement is measured in hops (steps) for each UPnP packet sent. Hops are the steps a packet takes between routers. The number of hops can range from 1 to 255. The default value for the advertisement time to live is 4 hops, which should be fine for most home networks. If you notice that some devices are not being updated or reached correctly, it might be necessary to increase this value.
9. Click the Apply button.
The UPnP Portmap Table displays the IP address of each UPnP device that is accessing the modem router and which ports (internal and external) that device opened. The UPnP Portmap Table also displays what type of port is open and whether that port is still active for each IP address.

10. To refresh the information in the UPnP Portmap Table, click the **Refresh** button.
Share a Storage Device

This chapter describes how to access and manage a storage device attached to your modem router. ReadySHARE lets you access and share a USB storage device connected to the modem router. (If your storage device uses special drivers, it is not compatible.)

Note: You can use the USB port on the modem router only to connect a USB storage device such as a flash drive or hard drive or a printer. Do not connect a computer, USB modem, CD drive, or DVD drive to the modem router USB port.

The chapter includes the following sections:

- USB Device Requirements
- Connect a USB Device to the Modem Router
- Access a Storage Device Connected to the Modem Router
- Back Up Windows Computers with ReadySHARE Vault
- Back Up Mac Computers with Time Machine
- Manage Access to a Storage Device
- Enable FTP Access Within Your Network
- View Network Folders on a Device
- Add a Network Folder on a Storage Device
- Change a Network Folder, Including Read and Write Access, on a USB Drive
- Approve USB Devices
- Safely Remove a USB Device

Note: For more information about ReadySHARE features, visit netgear.com/readyshare.
USB Device Requirements

The modem router works with most USB-compliant external flash and hard drives. For the most up-to-date list of USB devices that the modem router supports, visit kbserver.netgear.com/readyshare.

Some USB external hard drives and flash drives require you to load the drivers onto the computer before the computer can access the USB device. Such USB devices do not work with the modem router.

The modem router supports the following file system types for full read/write access:

- FAT16
- FAT32
- NTFS
- NTFS with compression format enabled
- Ext2
- Ext3
- Ext4

The modem router supports the following file system types with read-only access:

- HFS
- HFS+

Connect a USB Device to the Modem Router

ReadySHARE lets you access and share a USB device that is connected to a USB port on the modem router. (If your USB device uses special drivers, it is not compatible.) One USB port is on the back panel of the modem router and another is on the right side panel.

Figure 8. USB ports on modem router
To connect a USB device:
1. Connect your USB storage device to the USB port on the modem router.
2. If your USB device uses a power supply, connect it.
   You must use the power supply when you connect the USB device to the modem router.
   When you connect the USB device to the USB port of the modem router, it might take up to two minutes before the USB device is ready for sharing. By default, the USB device is available to all computers on your local area network (LAN).

Access a Storage Device Connected to the Modem Router

From a computer or device on the network, you can access a storage device that is connected to the modem router.

To access the device from a Mac:
1. Connect a USB storage device to the USB port on the modem router.
   If your storage device uses a power supply, you must use it when you connect the device to the modem router.
   When you connect the storage device to the modem router’s port, it might take up to two minutes before the storage device is ready for sharing. By default, the device is available to all computers on your local area network (LAN).
2. On a Mac that is connected to the network, select Go > Connect to Server.
3. In the Server Address field, enter smb://readyshare.
4. When prompted, select the Guest radio button.
5. Click the Connect button.
   A window automatically opens and displays the files and folders on the device.

To access the device from a Windows computer:
1. Connect a USB storage device to the USB port on the modem router.
   If your storage device uses a power supply, you must use it when you connect the device to the modem router.
   When you connect the storage device to the modem router’s port, it might take up to two minutes before the storage device is ready for sharing. By default, the device is available to all computers on your local area network (LAN).
2. Launch a web browser from a computer that is connected to the network.
3. In the address field of the browser, enter \readyshare.
   Windows file manager automatically opens and displays the files and folders on the device.
Back Up Windows Computers with ReadySHARE Vault

The modem router comes with free backup software for all the Windows computers in your home. Connect a USB hard disk drive (HDD) to the modem router for centralized, continuous, and automatic backup.

The following operating systems support ReadySHARE Vault:

- Windows 7
- Windows 8
- Windows 8.1

To back up your Windows computer:

1. Connect a USB HDD to one of the USB ports on the modem router.
3. Scroll down to the A Happy Home Is Filled With Love And Safely Stored Data section.
4. Click the Download the installer and get started link.
5. Follow the onscreen instructions to download the utility file.
6. Launch the ReadySHAREVault-install.exe file and install the utility.
   - The Dashboard page displays.
7. Use the dashboard or the Backup tab to set up and run your backup.

Back Up Mac Computers with Time Machine

You can use Time Machine to back up your Mac computers onto a USB hard drive that is connected to the USB port on the modem router. You can access the connected storage device from your Mac with a wired or wireless connection to your modem router.

Set Up a USB Hard Drive on a Mac

NETGEAR recommends that you use a new USB HDD or format your old USB disk to do the Time Machine backup for the first time. Use a blank partition to prevent some issues during backup using Time Machine. The modem router supports GUID or MBR partitions.

To format your USB hard disk drive and specify partitions:

1. Physically connect the USB hard drive to your Mac.
2. On your Mac, go to Spotlight (or the magnifying glass) at the top right of the page and search for Disk Utility.
3. To format your USB device, open the Disk Utility, click the Erase tab, and click the Erase button.
4. Click the Partition tab.
5. Click the Partition Layout menu and set the number of partitions that you want to use.
6. Click the **Options** button.
   The Partition options display.

7. Select the **GUID Partition Table** or **Master Boot Record** radio button.

8. For the format, select **Mac OS Extended (Journaled)**.

9. Click the **OK** button.

10. Click the **Apply** button.
    Your settings are saved.

### Prepare to Back Up a Large Amount of Data

Before you back up a large amount of data with Time Machine, NETGEAR recommends that you follow this procedure.

➢ **To prepare to back up a large amount of data:**

1. Upgrade the operating system of the Mac computer.
2. Verify and repair the backup disk and the local disk.
3. Verify and repair the permissions on the local disk.
4. Set Energy Saver:
   a. From the **Apple** menu, select **System Preferences**.
   b. From the **View** menu, select **Energy Saver**.
   c. Click the **Power Adapter** tab.
   d. Select the **Wake for Wi-Fi network access** check box.
   e. Click the **Back arrow** to save the changes and exit the page.
5. Modify your security settings:
   a. From the **Apple** menu, select **System Preferences**.
   b. From the **View** menu, select **Security**.
   c. Click the **Advanced** button at the bottom of the page.
   d. Leave the **Log out after minutes of inactivity** check box cleared.
Use Time Machine to Back Up onto a Storage Device

You can use Time Machine to back up your Mac computers onto a USB hard disk drive that is connected to the USB port on the modem router.

➢ To back up your Mac onto a USB hard drive:

1. Prepare your USB device with a compatible format and partitions.
   - See Set Up a USB Hard Drive on a Mac on page 159.
   - If you plan to back up a large amount of data, see Prepare to Back Up a Large Amount of Data on page 160.

2. Insert your USB storage drive into the USB port on the modem router.
   - **Note**: If your USB device uses a power supply, you must use it when you connect the USB device to the modem router.

   When you connect the USB device to the USB port on the modem router, it might take up to two minutes before the USB device is ready for sharing. By default, the USB device is available to all computers on your local area network (LAN).

3. On your Mac computer, select Go > Connect to Server.

4. Type `afp://routerlogin.net`.

5. When prompted to enter your name and password, select the Guest radio button.

6. Click the Connect button.
   - A list of connected devices displays. This list includes the name admin when you log in as admin.

7. From the Apple menu, select System Preferences.

8. Open Time Machine.

9. Click the Select Backup Disk button and select your USB device from the list.

10. Click the Use for Backup button.
   - **Note**: If you do not see the USB partition that you want in the Time Machine disk list, go to Mac finder and click that USB partition. It displays in the Time Machine list.

11. When prompted to enter your name and password, select the Guest radio button and click the Connect button.

When the setup is complete, the Mac automatically schedules a full backup. You can back up immediately if you want.
Manage Access to a Storage Device

You can specify the device name, workgroups, and network folders for a storage device connected to the USB port on the modem router.

- **To specify the storage device access settings:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the **OK** button.
     The BASIC Home page displays.
  5. **Select** **ADVANCED > USB Functions > ReadySHARE Storage**.

The previous figure shows a USB device attached to the modem router.

6. In the **Network/Device Name** field, enter the name that is used to access the USB device or devices that are connected to the modem router.
By default, the name is readyshare.

7. In the **Workgroup** field, enter the name of the workgroup that the USB device or devices are members of.

By default, the name is WORKGROUP. The name works only in an operating system that supports NetBIOS, such as Microsoft Windows. If you are using a Windows workgroup rather than a domain, the workgroup name is displayed here.

8. Enable or disable access methods by selecting or clearing the corresponding check boxes and specifying access to the storage device as described in the following table.

<table>
<thead>
<tr>
<th>Access Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Connection</td>
<td>Enabled by default. You can type \readyshare to access the storage device within your network. If you change the name in the Network Device Name field from readyshare to another name, the link changes accordingly.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Enabled by default. You can type <a href="http://readyshare.routerlogin.net/shares">http://readyshare.routerlogin.net/shares</a> to access the USB device within your network and download or upload files. In this URL, readyshare is the name that is specified in the Network/Device Name field. If you change the name in the Network Device Name field from readyshare to another name, the link changes accordingly. You can also click the link that is shown in the Link column. The fixed port is number 80.</td>
</tr>
<tr>
<td>HTTPS (via internet)</td>
<td>Disabled by default. If you enable this feature, remote users can type https://&lt;public IP address&gt;/&lt;shares&gt; to access the USB device over the Internet. &lt;public IP address&gt; is the external or public IP address that is assigned to the modem router (for example, 1.1.10.102). This feature supports file uploading only. The default port is number 443, which you can change.</td>
</tr>
<tr>
<td>FTP</td>
<td>Enabled by default. You can type ftp://readyshare.routerlogin.net/shares to access the USB device within your network and download or upload files. In this URL, readyshare is the name that is specified in the Network/Device Name field. If you change the name in the Network Device Name field from readyshare to another name, the link changes accordingly. You can also click the link that is shown in the Link column. The fixed port is number 21.</td>
</tr>
<tr>
<td>FTP (via internet)</td>
<td>Disabled by default. If you enable this feature, remote users can type ftp://&lt;public IP address&gt;/shares to access the USB device over the Internet and download or upload files. &lt;public IP address&gt; is the external or public IP address that is assigned to the modem router (for example, 1.1.10.102). The default port is number 21, which you can change. If you set up Dynamic DNS (see <strong>Set Up and Manage Dynamic DNS</strong> on page 174), you can also type a URL domain name. For example, if your domain name is MyName and you use the NETGEAR DDNS server, you can type ftp://MyName.mynetgear.com to access the USB device over the Internet and download or upload files.</td>
</tr>
</tbody>
</table>

9. Click the **Apply** button.

Your settings are saved.
Enable FTP Access Within Your Network

File Transfer Protocol (FTP) lets you download (receive) and upload (send) large files faster.

**Note:** For information about using FTP to access a storage device over the Internet, see *Chapter 8, Access Storage Devices Through the Internet.*

➢ **To enable FTP access within your network:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > USB Functions > ReadySHARE Storage**.
The previous figure shows a USB device attached to the modem router.

6. Select the FTP check box.
7. Click the Apply button.
   Your settings are saved.

**View Network Folders on a Device**

You can view or change the network folders on a USB storage device connected to the modem router.

➢ **To view network folders:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select **ADVANCED > USB Functions > ReadySHARE Storage**.
The previous figure shows a USB device attached to the modem router.

6. The Available Networks Folder section shows the following settings:
   - **Share Name.** The default share name is USB_Storage.
   - **Read Access and Write Access.** The permissions and access controls on the network folder. All–no password (the default) allows all users to access the network folder. The password for admin is the same one that you use to log in to the modem router.
   - **Folder Name.** Full path of the network folder.
   - **Volume Name.** Volume name from the storage device.
   - **Total Space and Free Space.** The current utilization of the storage device.

### Add a Network Folder on a Storage Device

You can add network folders on a storage device connected to the USB port on the modem router.

➢ **To add a network folder:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > USB Functions > ReadySHARE Storage.**
The previous figure shows a USB device attached to the modem router.

6. In the Available Network Folders table, select a device.

7. Click the **Create Network Folder** button.

   ![Create Network Folder](image)

   If this pop-up window does not display, your web browser might be blocking pop-ups. If it is, change the browser settings to allow pop-ups.

8. From the **USB Device** menu, select the USB drive.

   **Note:** NETGEAR recommends that you do not attach more than one drive to each USB port (for example, through a USB hub).
9. Click the **Browse** button and in the **Folder** field, select the folder.
10. In the **Share Name** field, type the name of the share.
11. From the **Read Access** menu and the **Write Access** menu, select the settings that you want.

   All–no password (the default) allows all users to access the network folder. The other option is that only the admin user is allowed access to the network folder. The password for admin is the same one that you use to log in to the modem router.

12. Click the **Apply** button.

   The folder is added on the storage device.

13. Click the **Close Window** button.

   The pop-up window closes.

**Change a Network Folder, Including Read and Write Access, on a USB Drive**

You can change network folders on storage devices connected to the USB port on the modem router.

➢ **To change a network folder:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.

   A login window opens.

3. Enter the user name and password for the modem router.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

   The BASIC Home page displays.

5. Select **ADVANCED > USB Functions > ReadySHARE Storage**.
The previous figure shows a USB device attached to the modem router.

6. In the Available Network Folders table, select a device.
7. Click the **Edit** button.

8. Change the settings in the fields as needed.
   For more information about the settings, see *Add a Network Folder on a Storage Device* on page 166.
9. Click the **Apply** button.
Your settings are saved.

10. Click the Close Window button.

The pop-up window closes.

Approve USB Devices

For more security, you can set up the modem router to share only USB devices that you approve.

➢ To allow approved USB devices only to connect to the modem router and specify which USB devices are approved:

1. Make sure that the USB device or devices that you want to approve are attached to the modem router.
2. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Type http://www.routerlogin.net.

A login window opens.

4. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

5. Click the OK button.

The BASIC Home page displays.


![USB Settings](image-url)
7. Click the No radio button.
   By default the Yes radio button is selected. This setting lets you connect and access all your USB devices.
8. Click the Apply button.
   Your settings are saved.
9. Click the Approved Devices button.

10. In the Available USB Devices table, select the USB device that you want to approve.
11. Click the Add button.
    The USB device is added to the Approved USB Devices table.
12. To approve a second USB device that is attached to the modem router, repeat Step 10 and Step 11.
13. Select the Allow only approved devices check box.
14. Click the Apply button.
    Your settings are saved.

To approve another USB device that is not connected to one of the two USB ports, first remove one of the USB devices (see Safely Remove a USB Device on page 171), connect the other USB device, and repeat this procedure.

**Safely Remove a USB Device**

Before you physically disconnect a USB device from the USB port on the modem router, log in to the modem router, and take the drive offline.

➢ To remove a USB device safely:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
A login window opens.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **ADVANCED > USB Functions > ReadySHARE Storage**.

   ![Image showing USB Device](image)

   The previous figure shows a USB device attached to the modem router.

6. In the Available Network Folders table, select a device.

7. Click the **Safely Remove USB Device** button.
   The device goes offline and a pop-up window displays.

8. Click the **OK** button.

9. Physically disconnect the USB device.
Access Storage Devices Through the Internet

With Dynamic DNS, you can use the Internet and a personal domain name to access a USB storage device that is attached to a USB port on the modem router when you are not home. If you know the IP address of the modem router (and the IP address did not change), you can also access the USB storage device by using the IP address.

This chapter includes the following sections:

- Set Up and Manage Dynamic DNS
- Access Storage Devices Through the Internet

**Note:** For information about how to connect the device and specify its settings, see *Chapter 7, Share a Storage Device.*
Set Up and Manage Dynamic DNS

Internet service providers (ISPs) assign numbers called IP addresses to identify each Internet account. Most ISPs use dynamically assigned IP addresses. This means that the IP address can change at any time. You can use the IP address to access your network remotely, but most people do not know what their IP address is or when this address changes.

To make it easier to connect, you can get a free account with a Dynamic DNS service that lets you use a domain name to access your home network. To use this account, you must set up the modem router to use Dynamic DNS. Then the modem router notifies the Dynamic DNS service provider whenever its IP address changes. When you access your Dynamic DNS account, the service finds the current IP address of your home network and automatically connects you.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic DNS service does not work because private addresses are not routed on the Internet.

Your Personal FTP Server

With your customized free URL, you can use FTP to access your network when you are not home through Dynamic DNS. To set up your FTP server, you must register for a NETGEAR Dynamic DNS (DDNS) service account and specify the account settings (see Set Up a New Dynamic DNS Account on page 175).

➢ To set up your personal account and use FTP:

1. Get your NETGEAR Dynamic DNS domain name.
   For more information, see Set Up a New Dynamic DNS Account on page 175.

2. Make sure that your Internet connection is working.
   Your modem router must use a direct Internet connection. It cannot connect to a different router to access the Internet.

3. Connect a USB storage device to one of the USB ports of the modem router.

4. Set up FTP access in the modem router.
   For more information, see Set Up FTP Access Through the Internet on page 177.

5. On a remote computer with Internet access, you can use FTP to access your modem router using ftp://younname.mynetgear.com, in which youname is your specific domain name.
   For more information, see Access Storage Devices Through the Internet with FTP on page 179.
Set Up a New Dynamic DNS Account

NETGEAR offers you the opportunity to set up and register for a free Dynamic DNS account.

To set up Dynamic DNS and register for a free NETGEAR account:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. In the address field of your browser, enter http://routerlogin.net.
   A login window opens.
3. Type admin for the user name and type your password.
   If you did not yet personalize your password, type password for the password.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Dynamic DNS.
6. Select the Use a Dynamic DNS Service check box.
7. From the Service Provider menu, select NETGEAR.
8. Select the No radio button.
9. In the Host Name field, enter the name that you want to use for your URL.
   The host name is sometimes called the domain name. Your free URL includes the host name that you specify and ends with mynetgear.com. For example, specify MyName.mynetgear.com.
10. In the Email field, enter the email address that you want to use for your account.
11. In the **Password (6-32 characters)** field, enter the password that you want to use for your account.

12. Click the **Register** button.

13. Follow the onscreen instructions to register for your NETGEAR Dynamic DNS service.

**Specify a DNS Account That You Already Created**

If you already created a Dynamic DNS account with NETGEAR, No-IP, or Dyn, you can set up the modem router to use your account.

➢ **To set up Dynamic DNS if you already created an account:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. In the address field of your browser, enter `http://routerlogin.net`.
   A login window opens.

3. Type `admin` for the user name and type your password.
   If you did not yet personalize your password, type `password` for the password.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **ADVANCED > Advanced Settings > Dynamic DNS**.

6. Select the **Use a Dynamic DNS Service** check box.

7. From the **Service Provider** menu, select your provider.

8. Select the **Yes** radio button.
In the **Host Name** field, enter the host name (sometimes called the domain name) for your account.

Depending on the type of account, specify your user name or email address:

- For a No-IP or Dyn account, in the **User Name** field, enter the user name for your account.
- For a NETGEAR account, in the **Email** field, enter the email address for your account.

In the **Password (6~32 characters)** field, enter the password for your DDNS account.

Click the **Apply** button.

Your settings are saved.

To verify that your Dynamic DNS service is enabled in the modem router, click the **Show Status** button.

A message displays the Dynamic DNS status.

---

**Access Storage Devices Through the Internet**

If you connect a USB storage device to the modem router, you can access the USB device through the Internet when you are not home. After you gain access, you can use FTP to share files on the USB device.

To access devices from a remote computer:

1. Launch a web browser on a computer that is not on your home network.
2. Connect to your modem router on your home network:
   - To connect with Dynamic DNS, type the DNS name.
   - To connect without Dynamic DNS, type the modem router’s Internet port IP address. You can view the modem router’s Internet IP address on the BASIC Home page.

---

**Set Up FTP Access Through the Internet**

If you attach a storage device to the modem router, you can access the storage device from your network (see *Enable FTP Access Within Your Network* on page 164). You can also set up FTP access through the Internet so that you can access the storage device from outside your local network, for example, when you are not at home.

To set up FTP access through the Internet:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. In the address field of your browser, enter **http://routerlogin.net**.
A login window opens.

3. Type **admin** for the user name and type your password.
   
   If you did not yet personalize your password, type **password** for the password.

4. Click the **OK** button.
   
   The BASIC Home page displays.

5. Select **ADVANCED > USB Functions > ReadySHARE Storage**.

   ![USB Settings](image)

   The previous figure shows a USB device attached to the modem router.

6. Select the **FTP (via internet)** check box.

7. Click the **Apply** button.
   
   Your settings are saved.

8. To limit access to the admin user, do the following:
   
   a. In the Available Network Folders list, select a device.
      
      If only one device is connected, it is automatically selected.

   b. Click the **Edit** button.
c. In the **Read Access** menu, select **admin**.
The default setting is **All - no password**.

d. In the **Write Access** menu, select **admin**.
The default setting is **All - no password**.

e. Click the **Apply** button.
Your settings are saved.

f. Click the **Close Window** button.
The pop-up window closes.

### Access Storage Devices Through the Internet with FTP

If you attached a storage device to the modem router, before you can access the storage device through the Internet with FTP, you must first set it up (see *Set Up FTP Access Through the Internet* on page 177).

➢ **To access a USB device with FTP from a remote computer to download or upload a file:**

1. Take one of the following actions:
   - To download a file from a storage device connected to the modem router, launch a web browser.
   - To upload a file to a storage device connected to the modem router, launch an FTP client such as Filezilla.

2. Type `ftp://` and the Internet port IP address in the address field of the browser.
   For example, if your IP address is 10.1.65.4, type `ftp://10.1.65.4`.
   If you are using Dynamic DNS, type the DNS name.
   For example, type `ftp://MyName.mynetgear.com`. 
3. When prompted, log in:
   • To log in as admin, in the user name field, enter admin and in the password field, enter the same password that you use to log in to the modem router.
   • To log in as guest, in the user name field, enter guest.
     The guest user name does not need a password.

   The files and folders that your account can access on the USB device display. For example, you might see share/partition1/directory1.

4. Navigate to a location on the USB device.

5. Download or upload the file.
Use the Modem Router as a Media Server

The modem router comes set up to work as a ReadyDLNA media server. You can set up the modem router to play music from iTunes Server and media from TiVo.

This chapter contains the following sections:

- Specify ReadyDLNA Media Server Settings
- Play Media from a USB Device on TiVo
Specify ReadyDLNA Media Server Settings

By default, the modem router functions as a ReadyDLNA media server, which lets you view movies and photos on DLNA/UPnP AV-compliant media players, such as Xbox360, Playstation, and NETGEAR media players.

To specify media server settings:

1. Launch a web browser from a computer or wireless device that is connected to the network.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
   The BASIC Home page displays.
4. Select ADVANCED > USB Functions > ReadySHARE Storage.
   The USB Storage (Advanced Settings) page displays with the ReadySHARE tab selected.
5. Click the Media Server tab.

![Image of media server settings]

6. Specify the settings:
   • Enable Media Server. Select this check box to enable this device to function as a media server.
   • Enable TiVo support. Select this check box if you want to play ReadyNAS media or media from a USB device on your TiVo device.
     For more information, see the Play Media from a USB Device on TiVo on page 183.
   • Media Server Device Name. Specify the name of the media server.
     By default, the media server name is ReadyDLNA:6400.
7. Click the Apply button.
   Your changes are saved.
Play Media from a USB Device on TiVo

You can set up your TiVo to access media files stored on a USB device that is connected to your modem router. The TiVo must be on the same network as the modem router. This feature supports the following file formats:

- **Video.** See and play mpeg1, and mpeg2 files.
- **Music.** See and play MP3 files.
- **Pictures.** View images in jpg format.

You can use the TiVo (Series 2 and up) Home Media Option to play photos and music on your Windows or Mac computer in your TiVo user interface.

➢ **To set up the modem router to work with TiVo:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is **admin.** The default password is **password.** The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > USB Storage > Media Server.**
   The Media Server Settings page displays.
6. Make sure that the **Enable TiVo support** check box is selected.
7. If you changed the setting, click the **Apply** button.
   Your settings are saved.

➢ **To play videos:**

1. On the TiVo, select **TiVo Central > My Shows.**

2. Go to the bottom of the list and select the D6400.
   (In the following figure, the page shows not D6400 but R8000.)
➢ To play music or view photos:

1. On the TiVo, select TiVo Central > Music, Photos, & Showcases.

2. Select an item to play or watch.

   (In the following figure, the page shows not D6400 but R8000.)

➢ To copy TiVo files to a computer:

   Use the TiVo Desktop accessory, available at
Share a USB Printer

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port on your modem router. You can share this USB printer among the Windows and Mac computers on your network.

The chapter includes the following sections:

- Install the Printer Driver and Cable the Printer
- Download the ReadySHARE Printer Utility
- Install the ReadySHARE Printer Utility
- Use the Shared Printer
- View or Change the Status of a Printer
- Use the Scan Feature of a Multifunction USB Printer
- Change NETGEAR USB Control Center Settings
Install the Printer Driver and Cable the Printer

Some USB printer manufacturers (for example, HP and Lexmark) request that you do not connect the USB cable until the installation software prompts you to do so.

➢ To install the driver and cable the printer:
1. On each computer on your network that shares the USB printer, install the driver software for the USB printer.
   If the printer driver is not installed, contact the printer manufacturer.
2. Use a USB printer cable to connect the USB printer to USB port on the modem router.

Download the ReadySHARE Printer Utility

The utility works on Windows computers, Mac computers, smart phones, and tablets.

➢ To download the ReadySHARE Printer utility:
2. Scroll down to the Print From the Comfort of Your Home Network section at the bottom of the page.
3. Click one of the following links:
   • Download PC installer and get started. This is the utility for Windows computers.
   • Download Mac installer and get started. This is the utility for MAC computers.
   • Download the genie App and get started. This is the utility for smart phones and tablets.
4. Follow the onscreen instructions to download the ReadySHARE Printer utility setup file.
Install the ReadySHARE Printer Utility

You must install the ReadySHARE Printer utility on each computer that will share the printer. After you install it, the utility displays as NETGEAR USB Control Center on your computer.

➢ To install the utility:

1. If necessary, unzip the ReadySHARE Printer utility setup file.
2. Double-click the ReadySHARE Printer utility setup file that you downloaded.

3. Follow the wizard instructions to install NETGEAR USB Control Center.
   After the InstallShield Wizard completes the installation, the NETGEAR USB Control Center prompts you to select a language.

4. Select a language from the list and click the OK button.
Some firewall software, such as Comodo, blocks NETGEAR USB Control Center from accessing the USB printer. If you do not see the USB printer displayed on the page, you can disable the firewall temporarily to allow the utility to work.

5. Select the printer and click the **Connect** button.

   The printer status changes to Manually connected by *Mycomputer*. Now only the computer that you are using can use this printer.

6. Click the **Disconnect** button.

   The status changes to Available. Now all computers on the network can use the printer.

7. To exit the utility, select **System > Exit**.

**Use the Shared Printer**

For each computer, after you click the **Connect** and **Disconnect** buttons once, the utility automatically manages the printing queue. By default, the utility starts automatically whenever you log on to Windows and runs in the background.

➢ **To manually connect and print:**

1. Click the **NETGEAR USB Control Center** icon.

   The main page displays.

2. Click the **Connect** button.

   The printer status changes to Manually connected by *Mycomputer*. Now only the computer that you are using can use this printer.

3. Use the print feature in your application to print your document.

4. To release the printer so that all computers on the network can use it, click the **Disconnect** button.
To print and release the printer to any computer on the network:

1. To print your document, use the print feature in your application.
   The NETGEAR USB Control Center automatically connects your computer to the USB printer and prints the document. If another computer is already connected to the printer, your print job goes into a queue to wait to be printed.

2. If your document does not print, use the NETGEAR USB Control Center to check the status.
   See View or Change the Status of a Printer on page 189.

View or Change the Status of a Printer

To view or change the status:

1. Click the NETGEAR USB Control Center icon.

   ![NETGEAR USB Control Center](image)

   The Status column shows the status for each device:

   - **Available.** No print jobs are in progress. You can use the USB printer from any computer in the network.
   - **Connected.** Your computer is connected to the printer and will be released when your print job is done.
   - **Manually Connected by.** Only the connected computer can use the printer.
   - **Waiting to Connect.** Your computer is not connected to the shared printer yet.

2. To print from your computer when the status shows Manually connected by another computer, click the Disconnect button.
   The printer is released from the connection and the status changes to Available.

3. To print from your computer when the status shows Waiting to Connect, do the following:
   a. Click the Connect button.
      The printer status changes to Manually connected by Mycomputer. Now only your computer can use the printer.
   b. To allow the printer to be shared, click the Disconnect button.
      The printer is released from the connection and the status changes to Available.
Use the Scan Feature of a Multifunction USB Printer

If your USB printer supports scanning, you can also use the USB printer for scanning. For example, the USB printer displayed in the Windows Printers and Faxes window is ready for print jobs.

To use the scan feature of a multifunction USB printer:

1. Click the **NETGEAR USB Control Center** icon.

2. Make sure that the printer status shows as Available.

3. Click the **Network Scanner** button.

The scanner page displays so that you can use the USB printer for scanning.
Change NETGEAR USB Control Center Settings

You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows. You can also change the language and specify the time-out to release the printer connection.

➢ To turn off automatic NETGEAR USB Control Center startup:

1. Click the NETGEAR USB Control Center icon.

2. Select Tools > Configuration.

3. Clear the Automatically execute when logging on Windows check box.

4. Click the OK button.

Your settings are saved.
Change the NETGEAR USB Control Center Language

➢ To change the language:

1. Click the NETGEAR USB Control Center icon.
   The main page displays.
2. Select Tools > Configuration.
   The Control Center - Configuration page displays.
3. From the Language menu, select a language.
4. Click the OK button.
   The next time NETGEAR USB Control Center starts, the language changes.

Specify the Time-out

➢ To specify the time-out:

1. Click the NETGEAR USB Control Center icon.
   The main page displays.
2. Select Tools > Configuration.
   The Control Center - Configuration page displays.
3. In the Timeout field, type the number of minutes.
   The time-out is the number of minutes that a computer holds its connection to the printer when the connection is not being used.
4. Click the OK button.
   Your settings are saved.

Share a USB Printer
192
This chapter describes how you can manage the WAN and LAN network settings of the modem router.

The chapter includes the following sections:

- Change the Physical WAN Connection Preference
- Enable and Configure a VLAN
- Set Up a Bridge for a Port Group or VLAN Tag Group
- Enable Bridge Mode for an IPTV Device
- Manage the WAN Security Settings
- Set Up a Default DMZ Server
- Manage IGMP Proxying
- Manage NAT Filtering
- Manage the SIP Application-Level Gateway
- Manage the Modem Router’s LAN IP Address Settings
- Manage the Router Information Protocol Settings
- Manage Reserved LAN IP Addresses
- Change the Modem Router’s Device Name
- Manage the DHCP Server Address Pool
- Disable the Built-In DHCP Server
- Set Up and Manage Custom Static Routes

For information about the IPv4 Internet settings, IPv6 settings, and MTU size, see Chapter 3, Manage the Internet Settings Manually.
Change the Physical WAN Connection Preference

The modem router can autodetect the type of WAN connection. However, you can also set the WAN connection preference manually to either the DSL port or the Ethernet WAN port.

---

**Note:** The modem router does not support load balancing over ADSL and Ethernet WAN interfaces. Only one WAN interface (either the DSL port or the Ethernet WAN port) can be active at any time.

---

➢ **To change the WAN connection preference:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   
   A login window opens.
3. Enter the user name and password for the modem router.
   
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > WAN Setup**.
   
   The WAN Setup page displays.
6. From the **WAN Preference** menu, select one of the following options:
   
   • **Auto-Detect.** The modem router automatically detects whether the WAN connection is DSL over the DSL port or Ethernet over the Internet port. **Auto-Detect** is the default setting.
   
   • **Must use DSL WAN.** The modem router uses the DSL port for a DSL WAN connection. The Internet port is shut down.
   
   • **Must use Ethernet WAN.** The modem router uses the Internet port for an Ethernet WAN connection. The DSL port is shut down.
7. Click the **Apply** button.

   Your settings are saved.

Enable and Configure a VLAN

A network of computers and devices can behave as if they are connected to the same network even though they might actually be physically on different segments of a LAN. Virtual LANs (VLANs) are configured through software rather than hardware, which makes them very flexible.
If you enable a VLAN and if the network devices (hubs and switches) on your LAN support the VLAN (802.1Q) standard, the VLAN ID for the wireless access point is associated with all traffic coming from the modem router.

If you are subscribed to IPTV service, the modem router might require VLAN tags to distinguish between the Internet traffic and IPTV traffic.

**Note:** If your ISP provides directions on how to set up VLANs for IPTV and Internet service, follow those directions.

To enable and configure a VLAN for the virtual Internet interface and another VLAN for the virtual IPTV interface:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **Internet**.

The previous figure shows only the top of the Internet Setup page.
6. Configure a VLAN for the virtual Internet interface:
   a. From the menu above the Enable This Interface check box, select Internet.
   b. Make sure that the Enable This Interface check box is selected.
      By default, the check box is selected for the virtual Internet interface.
   c. Select the Use VLANID check box.
   d. Enter a VLAN ID that applies to the virtual Internet interface.
      The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is 0.
   e. To specify a priority for the VLAN, in the Priority (802.1p) field, enter a value from 0 to 7.
   f. Click the Apply button.
      Your settings are saved for the virtual Internet interface.

7. Configure a VLAN for the virtual IPTV interface:
   a. From the menu above the Enable This Interface check box, select IPTV.
   b. Select the Enable This Interface check box.
      By default, the check box is cleared for the virtual IPTV interface. However, if you already enabled the virtual IPTV interface (see Chapter 3, Manage the Internet Settings Manually), the check box is selected.
   c. Select the Use VLANID check box.
   d. Enter a VLAN ID that applies to the virtual IPTV interface.
      The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is 0.
   e. To specify a priority for the VLAN, in the Priority (802.1p) field, enter a value from 0 to 7.
   f. Click the Apply button.
      Your settings are saved for the virtual IPTV interface.

Set Up a Bridge for a Port Group or VLAN Tag Group

Some devices, such as an IPTV, cannot function behind the modem router's network address translation (NAT) service or firewall. Based on what your Internet service provider (ISP) requires, for the device to connect to the ISP’s network directly, you can enable the bridge between the device and the modem router’s Internet port or add new VLAN tag groups to the bridge.

Note: If your ISP provides directions on how to set up a bridge for IPTV and Internet service, follow those directions.
Set Up a Bridge for a Port Group

If the devices that are connected to the modem router’s Ethernet LAN port or WiFi network include an IPTV device, your ISP might require you to set up a bridge for a port group on the virtual Internet interface.

A bridge with a port group prevents packets that are sent between the IPTV device and the modem router’s physical Internet port from being processed through the modem router’s network address translation (NAT) service.

To configure a port group and enable the bridge:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > VLAN/Bridge Settings.
   The VLAN/Bridge Settings page displays.
6. Select the Enable VLAN/Bridge Group check box.
   The page expands.
7. Select the By bridge group radio button.
8. Select a **Wired Ports** check box or a **Wireless** check box:
   - If your device is connected to an Ethernet port on the modem router, select the **Wired Ports** check box that corresponds to the Ethernet port on the modem router to which the device is connected.
   - If your device is connected to your modem router’s WiFi network, select the **Wireless** check box that corresponds to the modem router’s WiFi network to which the device is connected.

   **Note:** You must select at least one **Wired Ports** or **Wireless** check box. You can select more than one check box.

9. Click the **Apply** button.
   Your settings are saved.

### Set Up a Bridge for a VLAN Tag Group

If the devices that are connected to the modem router’s Ethernet LAN ports or WiFi network include an IPTV device, your ISP might require you to set up a bridge for a VLAN tag group.

If you are subscribed to IPTV service, the modem router might require VLAN tags to distinguish between the Internet traffic and the IPTV traffic. A bridge with a VLAN tag group prevents packets that are sent between the IPTV device and the modem router’s physical Internet port from being processed through the modem router’s network address translation (NAT) service.

You can add VLAN tag groups to a bridge and assign VLAN IDs and priority values to each VLAN tag group.

➢ **To add a VLAN tag group and enable the bridge:**
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type **http://www.routerlogin.net**.
      A login window opens.
   3. Enter the user name and password for the modem router.
      The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
   4. Click the **OK** button.
      The BASIC Home page displays.
   5. Select **ADVANCED > Setup > VLAN/Bridge Settings**.
      The VLAN/Bridge Settings page displays.
   6. Select the **Enable VLAN/Bridge Group** check box.
By default, the **By VLAN tag group** radio button is selected.

7. Click the **Add** button.

8. Specify the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the VLAN tag group.</td>
</tr>
<tr>
<td></td>
<td>The name can be up to 10 characters.</td>
</tr>
<tr>
<td>VLAN ID</td>
<td>Enter a value from 1 to 4094.</td>
</tr>
<tr>
<td>Priority</td>
<td>Enter a value from 0 to 7.</td>
</tr>
</tbody>
</table>

Select the check box for a wired LAN port or WiFi port.
If your device is connected to an Ethernet port on the modem router, select the LAN port check box that corresponds to the Ethernet port on the modem router to which the device is connected.
If your device is connected to your modem router's WiFi network, select the WiFi check box that corresponds to the modem router's WiFi network to which the device is connected.

**Note:** You must select at least one LAN port or WiFi port. You can select more than one port.

9. Click the **Add** button.

The VLAN tag group is added.
10. Click the **Apply** button.
Your settings are saved.

### Enable Bridge Mode for an IPTV Device

The modem router provides one physical DSL WAN interface and one physical Ethernet WAN interface; either one or the other is enabled for Internet service. Whichever physical WAN interface is enabled, it can be divided into two *virtual* interfaces: the Internet interface and the IPTV interface. This section refers to these virtual interfaces. (For information about changing the *physical* WAN interfaces, see *Change the Physical WAN Connection Preference* on page 194.)

The modem router uses the virtual Internet interface for regular Internet service. Some devices, such as an IPTV, cannot function behind the modem router’s network address translation (NAT) service or firewall. In such a situation, the modem router can use the virtual IPTV interface for Internet Protocol television (IPTV) service. By default, the virtual Internet interface is enabled and the virtual IPTV interface is disabled. In most cases, if you are not subscribed to IPTV service, you do not need to enable the virtual IPTV interface.

Based on what your Internet service provider (ISP) requires, for a device such as an IPTV to connect to the ISP’s network directly, you can enable the bridge between the device and the modem router’s virtual IPTV interface. In bridge mode, the LAN 4 port on the back panel of the modem router is bound to the virtual IPTV interface. In bridge mode, you must connect the device to LAN port 4.

If your ISP provides IPTV service in addition to regular Internet service and you are subscribed to IPTV, you might need to configure and enable the IPTV virtual interface. You might also need to configure one or more VLANs and set up a bridge:

- For information about configuring VLANs, see *Enable and Configure a VLAN* on page 194.
- For information about setting up a bridge, see *Set Up a Bridge for a Port Group or VLAN Tag Group* on page 196.

For information about enabling and configuring the virtual IPTV interface, see one of the following sections:

- *Manually Set Up an ADSL Internet Connection* on page 47
- *Manually Set Up a VDSL Internet Connection* on page 57
- *Manually Set Up a Cable of Fiber Internet Connection* on page 66

➢ **To enable bridge mode for an IPTV device:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
A login window opens.
3. Enter the modem router user name and password.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home page displays.

5. Select **Internet**.

6. The Internet Setup page displays.

7. From the menu above the **Enable This Interface** check box, select **IPTV**.

![Internet Setup page](image)

The previous figure shows only the top of the Internet Setup page.

8. Make sure that the **Enable This Interface** check box is selected for the IPTV interface.
   If you already enabled and configured the IPTV interface, the check box is selected.

9. Select the **Bridge Mode (bind LAN4 to WAN2)** check box.
   The LAN 4 port is bound to the virtual IPTV interface.

10. Click the **Apply** button.
    Your settings are saved.

**Manage the WAN Security Settings**

The WAN security settings include port scan protection and denial of service (DoS) protection, which can protect your LAN against attacks such as Syn flood, Smurf Attack, Ping of Death, and many others. By default, DoS protection is disabled and a port scan is rejected.
You can also enable the modem router to respond to a ping to its WAN (Internet) port. This feature allows your modem router to be discovered. Enable this feature only as a diagnostic tool or if a specific reason exists.

➢ **To change the default WAN security settings:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > WAN Setup**.
   The WAN Setup page displays.
6. To enable port scan and DoS protection, clear the **Disable Port Scan and DoS Protection** check box.

   **Note:** Enabling port scan and DoS protection might affect the performance of the modem router.

7. To enable modem router to respond to a ping, select the **Respond to Ping on Internet Port** check box.
8. Click the **Apply** button.
   Your settings are saved.

### Set Up a Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and videoconferencing applications that are incompatible with Network Address Translation (NAT). The modem router is programmed to recognize some of these applications and to work correctly with them, but other applications might not function well. In some cases, one local computer can run the application correctly if the IP address for that computer is entered as the default DMZ server.

**WARNING:**

DMZ servers pose a security risk. A computer designated as the default DMZ server loses much of the protection of the firewall and is exposed to exploits from the Internet. If compromised, the DMZ server computer can be used to attack other computers on your network.
The modem router usually detects and discards incoming traffic from the Internet that is not a response to one of your local computers or a service or application for which you set up a port forwarding or port triggering rule. Instead of discarding this traffic, you can direct the modem router to forward the traffic to one computer on your network. This computer is called the default DMZ server.

➢ **To set up a default DMZ server:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
   The BASIC Home page displays.
4. Select **ADVANCED > Setup > WAN Setup**.
   The WAN Setup page displays.
5. Select the **Default DMZ Server** check box.
6. Enter the IP address of the server.
7. Click the **Apply** button.
   Your settings are saved.

**Manage IGMP Proxying**

IGMP proxying allows a computer on the local area network (LAN) to receive the multicast traffic it is interested in from the Internet. If you do not need this feature, leave it disabled, which is the default setting.

➢ **To enable IGMP proxying:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > WAN Setup**.
   The WAN Setup page displays.
6. Clear the **Disable IGMP Proxying** check box.
   By default, the **Disable IGMP Proxying** check box is selected and IGMP proxying is disabled.

7. Click the **Apply** button.
   Your settings are saved.

### Manage NAT Filtering

Network Address Translation (NAT) determines how the modem router processes inbound traffic. Secured NAT protects computers on the LAN from attacks from the Internet but might prevent some Internet games, point-to-point applications, or multimedia applications from working. Open NAT provides a much less secured firewall but allows almost all Internet applications to work. Secured NAT is the default setting.

➢ **To change the default NAT filtering settings:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > WAN Setup**. The WAN Setup page displays.
6. Select a NAT Filtering radio button:
   • **Secured.** Provides a secured firewall to protect the computers on the LAN from attacks from the Internet but might prevent some Internet games, point-to-point applications, or multimedia applications from functioning. By default, the **Secured** radio button is selected.
   • **Open.** Provides a much less secured firewall but allows almost all Internet applications to function.
7. Click the **Apply** button.
   Your settings are saved.
Manage the SIP Application-Level Gateway

The application-level gateway (ALG) for the Session Initiation Protocol (SIP) is enabled by default for enhanced address and port translation. However, some types of VoIP and video traffic might not work well when the SIP ALG is enabled. For this reason, the modem router provides the option to disable the SIP ALG.

➢ To disable the default SIP ALG:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > WAN Setup.
   The WAN Setup page displays.
6. Select the Disable SIP ALG check box.
   The SIP ALG is enabled by default.
7. Click the Apply button.
   Your settings are saved.

Manage the Modem Router’s LAN IP Address Settings

The modem router is preconfigured to use private IP addresses on the LAN side and to act as a DHCP server. The modem router’s default LAN IP configuration is as follows:

- **LAN IP address.** 192.168.0.1 (This is the same as www.routerlogin.net and www.routerlogin.com.)
- **Subnet mask.** 255.255.255.0

These addresses are part of the designated private address range for use in private networks and are suitable for most applications. The IP address and subnet mask identify which addresses are local to a specific device and which must be reached through a gateway or modem router. You might want to change these settings if you need a specific IP subnet that one or more devices on the network use, or if competing subnets use the same IP scheme.
To change the LAN IP address settings:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.

6. In the IP Address field, enter the LAN IP address for the modem router.
7. In the IP Subnet Mask field, enter the LAN subnet mask for the modem router.
8. Click the Apply button.
   Your settings are saved.
   If you changed the LAN IP address of the modem router, you are disconnected when the changes take effect.
   To reconnect, close your browser, relaunch it, and log in to the modem router at its new LAN IP address.
Manage the Router Information Protocol Settings

Router Information Protocol (RIP) lets the modem router exchange routing information with other routers. By default, RIP is enabled in both directions (in and out) without a particular RIP version.

To manage the RIP settings:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.
6. In the RIP direction menu, select one of the following options:
   - Both. The modem router broadcasts its routing table periodically and incorporates information that it receives. This is the default setting.
   - Out Only. The modem router broadcasts its routing table periodically but does not incorporate the RIP information that it receives.
   - In Only. The modem router incorporates the RIP information that it receives but does not broadcast its routing table.
7. In the **RIP Version** menu, select one of the following options:
   - **Disabled.** The RIP version is disabled. This is the default setting.
   - **RIP-1.** This format is universally supported. It is adequate for most networks, unless you are using an unusual network setup.
   - **RIP-2B or RIP-2M.** This format carries more information. Both RIP-2B and RIP-2M send the routing data in RIP-2 format. RIP-2B uses subnet broadcasting. RIP-2M uses multicasting.

8. Click the **Apply** button.
   
   Your settings are saved.

### Manage Reserved LAN IP Addresses

When you specify a reserved IP address for a computer on the LAN, that computer always receives the same IP address each time it accesses the modem router’s DHCP server.

#### Reserve a LAN IP address

You can assign a reserved IP address to a computer or server that requires permanent IP settings.

- **To reserve an IP address:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     
     A login window opens.
  3. Enter the user name and password for the modem router.
     
     The user name is **admin.** The default password is **password.** The user name and password are case-sensitive.
  4. Click the **OK** button.
     
     The BASIC Home page displays.
  5. Select **ADVANCED > Setup > LAN Setup.**
6. In the Address Reservation section, click the Add button.

7. Either select a device from the Address Reservation Table table by selecting the corresponding radio button or specify the reserved IP address information:
   - In the IP Address field, enter the IP address to assign to the computer or device. Choose an IP address from the modem router’s LAN subnet, such as 192.168.0.x.
   - In the MAC Address field, enter the MAC address of the computer or device.
   - In the Device Name field, enter the name of the computer or device.

8. Click the Add button.
   The reserved address is entered into the table on the LAN Setup page.

The reserved address is not assigned until the next time the computer or device contacts the modem router’s DHCP server. Reboot the computer or device, or access its IP configuration and force a DHCP release and renew.
Change a Reserved IP Address

You can change a reserved IP address entry.

➢ To change a reserved IP address entry:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.
   The LAN Setup page displays.
6. In the Address Reservation section, select the radio button next to the reserved address.
7. Click the Edit button.
   The Edit page displays.
8. Change the settings.
9. Click the Apply button.
   Your settings are saved.

Remove a Reserved IP Address Entry

You can remove a reserved IP address entry.

➢ To remove a reserved IP address entry:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.
The LAN Setup page displays.

6. In the Address Reservation section, select the radio button next to the reserved address.
7. Click the Delete button.
   The address entry is removed.

**Change the Modem Router’s Device Name**

The modem router’s default device name is D6400. This device name displays in a file manager when you browse your network.

➢ **To change the modem router’s device name:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is *admin*. The default password is *password*. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > LAN Setup**.
   The LAN Setup page displays.
6. In the **Device Name** field, enter a new name.
7. Click the Apply button.
   Your settings are saved.

**Manage the DHCP Server Address Pool**

By default, the modem router acts as a Dynamic Host Configuration Protocol (DHCP) server. The modem router assigns IP, DNS server, and default gateway addresses to all computers that are connected to its LAN and WiFi network. The assigned default gateway address is the LAN address of the modem router.

These addresses must be part of the same IP address subnet as the modem router’s LAN IP address. The default DHCP address pool is 192.168.0.2–192.168.0.254.

The modem router delivers the following parameters to any LAN device that requests DHCP:

- An IP address from the range that you define
- Subnet mask
- Gateway IP address (the modem router’s LAN IP address)
- DNS server IP address (the modem router’s LAN IP address)
To specify the pool of IP addresses that the modem router assigns:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Setup > LAN Setup.

![LAN Setup settings](image)

6. Make sure that the Use Router as DHCP Server check box is selected.
   This check box is selected by default.
7. Specify the range of IP addresses that the modem router assigns:
   • In the Starting IP Address field, enter the lowest number in the range.
     This IP address must be in the same subnet as the modem router. By default, the starting IP address is 192.168.0.2.
   • In the Ending IP Address field, enter the number at the end of the range of IP addresses.
     This IP address must be in the same subnet as the modem router. By default, the ending IP address is 192.168.0.254.
8. Click the Apply button.
   Your settings are saved.
Disable the Built-In DHCP Server

By default, the modem router functions as a DHCP server. The modem router assigns IP, DNS server, and default gateway addresses to all devices connected to the LAN. The assigned default gateway address is the LAN address of the modem router.

You can use another device on your network as the DHCP server or specify the network settings of all your computers.

**Note:** If you disable the DHCP server and no other DHCP server is available on your network, you must set your computer IP addresses manually so that they can access the modem router.

➢ To disable the built-in DHCP server:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   
   A login window opens.
3. Enter the user name and password for the modem router.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Setup > LAN Setup**.
   
   The LAN Setup page displays.
6. Clear the **Use Router as DHCP Server** check box.
7. Click the **Apply** button.
   
   Your settings are saved.

Set Up and Manage Custom Static Routes

Static routes provide detailed routing information to your modem router. Typically, you do not need to add static routes. You must configure static routes only for unusual cases such as when you use multiple routers or multiple IP subnets on your network.

As an example of when a static route is needed, consider the following case:

- Your primary Internet access is through an ADSL modem to an ISP.
- You use an ISDN router on your home network for connecting to the company where you are employed. This router’s address on your LAN is 192.168.0.100.
- Your company’s network address is 134.177.0.0.
When you first configured your modem router, two implicit static routes were created. A default route was created with your ISP as the gateway and a second static route was created to your local network for all 192.168.0.x addresses. With this configuration, if you attempt to access a device on the 134.177.0.0 network, your modem router forwards your request to the ISP. The ISP forwards your request to the company where you are employed, and the request is likely to be denied by the company’s firewall.

In this case, you must define a static route, instructing your modem router that 134.177.0.0 is accessed through the ISDN modem router at 192.168.0.100. Here is an example:

- Through the destination IP address and IP subnet mask, specify that this static route applies to all 134.177.x.x addresses.
- Through the gateway IP address, specify that all traffic for these addresses is forwarded to the ISDN modem router at 192.168.0.100.
- A metric value of 1 works fine because the ISDN modem router is on the LAN.

**Set Up a Static Route**

You can add a static route to a destination IP address and specify the subnet mask, gateway IP address, and metric.

➢ **To set up a static route:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > Static Routes**.
The previous figure shows two routes in the table as an example.

6. Click the **Add** button.

7. To make the route private, select the **Private** check box.
   
   A private static route is not reported in RIP.

8. To prevent the route from becoming active after you click the **Apply** button, clear the **Active** check box.

   In some situations, you might want to set up a static route but keep it disabled until a later time. By default, the **Active** check box is selected and a route becomes active after you click the **Apply** button.
9. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination IP Address</td>
<td>Enter the IP address for the final destination of the route.</td>
</tr>
<tr>
<td>IP Subnet Mask</td>
<td>Enter the IP subnet mask for the final destination of the route.</td>
</tr>
<tr>
<td></td>
<td>If the destination is a single host, enter 255.255.255.255.</td>
</tr>
<tr>
<td>Gateway IP Address</td>
<td>Enter the IP address of the gateway.</td>
</tr>
<tr>
<td></td>
<td>The IP address of the gateway must be on the same LAN segment as the modem router.</td>
</tr>
<tr>
<td>Metric</td>
<td>Enter a number from 1 through 15.</td>
</tr>
<tr>
<td></td>
<td>This value represents the number of routers between your network and the destination. Usually, a setting of 2 or 3 works, but if this is a direct connection, set it to 1.</td>
</tr>
</tbody>
</table>

10. Click the **Apply** button.
Your settings are saved. The static route is added to the table on the Static Routes page.

**Change a Static Route**

You can change an existing static route.

➢ **To change a static route:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > Static Routes**.
   The Static Routes page displays.
6. In the Static Routes table, select the radio button to the left of the route that you want to change.
7. Click the **Edit** button.
   The page adjusts.
8. Change the settings for the route.
   For more information about the settings, see **Set Up a Static Route** on page 214.
9. Click the **Apply** button.
   The route is updated in the table on the Static Routes page.
Remove a Static Route

You can remove an existing static route that you no longer need.

➢ **To remove a static route:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > Static Routes**.
   The Static Routes page displays.
6. In the Static Routes table, select the radio button to the left of the route that you want to remove.
7. Click the **Delete** button.
   The route is removed from the table on the Static Routes page.
This chapter describes how you can manage the settings for administering and maintaining your modem router and monitor the network.

The chapter includes the following sections:

- Update the Firmware of the Modem Router
- Manage the Configuration File of the Modem Router
- Recover the admin Password
- Return the Modem Router to Its Factory Default Settings
- View the Status and Statistics of the Modem Router
- Manage the Activity Log
- View Devices Currently on the Network
- Monitor and Meter Internet Traffic
- Manage the Modem Router Remotely
- Remotely Access the Modem Router Using the genie App
- Configure the Modem Router as a DSL Modem Only

For information about changing the admin password, see Change the admin Password on page 37.

For information about setting up password recovery, see Set Up Password Recovery on page 38.
Update the Firmware of the Modem Router

The modem router firmware is stored in flash memory.

You can check to see if new firmware is available and update the modem router to the new firmware. You can also visit the NETGEAR support website, download the firmware manually, and update the modem router to the new firmware.

Check for New Firmware and Update the Modem Router

For you to check for new firmware, the modem router must be connected to the Internet.

➢ To check for new firmware and update your modem router:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Administration > Router Update.
   The Firmware Update page displays.
6. Click the Check button.
   The modem router detects new firmware if any is available and displays a message asking if you want to download and install it.
7. To download and install the new firmware, click the Yes button.
   The modem router locates the firmware, downloads it, and begins the update.

WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

A progress bar shows the progress of the firmware upload process. The firmware upload process takes several minutes. When the upload is complete, your modem router restarts.
8. Verify that the modem router runs the new firmware version:
   a. Launch a web browser from a computer or WiFi device that is connected to the network.
   b. Type http://www.routerlogin.net.
      A login window opens.
   c. Enter the user name and password for the modem router.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   d. Click the OK button.
      The BASIC Home page displays.
      The firmware version is stated at the top right, under the Logout button.

9. To determine whether you must reconfigure the modem router after updating (which is unlikely but possible), visit downloadcenter.netgear.com, go to the support page for your product, and locate and read the new firmware release notes.

Manually Upload New Firmware and Update the Modem Router

Downloading firmware and updating the modem router are two separate tasks that are combined in the following procedure.

➢ To download new firmware manually and update your modem router:
1. Visit downloadcenter.netgear.com, locate the support page for your product, and download the new firmware.
2. Read the new firmware release notes to determine whether you must reconfigure the modem router after updating (which is unlikely but possible).
3. Launch a web browser from a computer or WiFi device that is connected to the network.
4. Type http://www.routerlogin.net.
   A login window opens.
5. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
6. Click the OK button.
   The BASIC Home page displays.
7. Select ADVANCED > Administration > Router Update.
   The Firmware Update page displays.
8. Locate and select the firmware file on your computer:
   a. Click the **Browse** button.
   b. Navigate to the firmware file.
      
      The file ends in `.chk`. An example of a firmware file name is `D6400-V1.0.0.22_1.0.22.chk`.
   c. Select the firmware file.

9. Click the **Upload** button.

   **WARNING:**

   To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

   A progress bar shows the progress of the firmware upload process. The firmware upload process takes several minutes. When the upload is complete, your modem router restarts.

10. Verify that the modem router runs the new firmware version:
   a. Launch a web browser from a computer or WiFi device that is connected to the network.
   b. Type **http://www.routerlogin.net**.
      
      A login window opens.
   c. Enter the user name and password for the modem router.
      
      The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
   d. Click the **OK** button.
      
      The BASIC Home page displays.

      The version firmware is stated at the top right, under the **Logout** button.
Manage the Configuration File of the Modem Router

The configuration settings of the modem router are stored within the modem router in a configuration file. You can back up (save) this file to your computer or restore it.

Back Up the Settings

You can save a copy of the current configuration settings.

➢ To back up the modem router's configuration settings:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
5. Select ADVANCED > Administration > Backup Settings. The Backup Settings page displays.
6. Click the Back Up button.
7. Choose a location to store the file on your computer. The name of the backup file is NETGEAR_D6400.cfg.
8. Follow the directions of your browser to save the file.

Restore the Settings

If you backed up the configuration file, you can restore the configuration from this file.

➢ To restore configuration settings that you backed up:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
5. Select **ADVANCED > Administration > Backup Settings**.
   The Backup Settings page displays.

6. Click the **Browse** button and navigate to and select the saved configuration file.
   The name of the backup file from which you can restore the configuration is
   `NETGEAR_D6400.cfg`.
   Follow the directions of your browser to locate and select the file.

7. Click the **Restore** button.
   The configuration is uploaded to the modem router. When the restoration is complete, the
   modem router reboots. This process takes about one minute.

**WARNING:**
To avoid the risk of corrupting the firmware, do not interrupt the
restoration. For example, do not close the browser, click a link, or
load a new page. Do not turn off the modem router. Wait until the
modem router finishes restarting and the Power LED turns solid green.

**Recover the admin Password**

NETGEAR recommends that you enable password recovery if you change the password for
the modem router user name admin. Then you can recover the password if it is forgotten.
This recovery process is supported in Internet Explorer, Firefox, and Chrome browsers, but
not in the Safari browser.

For information about setting up password recovery, see *Set Up Password Recovery* on
page 38. The following procedure works only if you did set up password recovery.

➢ **To recover your password:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. In the address field of your browser, type `www.routerlogin.net`.
   A login window opens.
3. Click the **Cancel** button.
   If password recovery is enabled, you are prompted to enter the serial number of the
   modem router. The serial number is on the product label of the modem router.
4. Enter the serial number of the modem router.
5. Click the **Continue** button.
   A page displays requesting the answers to your security questions.
6. Enter the saved answers to your security questions.
7. Click the **Continue** button.
   A page displays your recovered password.

8. Click the **Login again** button.
   A login window opens.

9. With your recovered password, log in to the modem router.

Return the Modem Router to Its Factory Default Settings

Under some circumstances (for example, if you lost track of the changes that you made to the modem router settings or you move the modem router to a different network), you might want to erase the configuration and reset it to factory default settings.

If you do not know the current IP address of the modem router, first try to use an IP scanner application to detect the IP address before you reset the modem router to factory default settings.

To reset the modem router to factory default settings, you can use either the **Reset** button on the back of the modem router or the Erase function. However, if you cannot find the IP address or lost the password to access the modem router, you must use the **Reset** button.

After you reset the modem router to factory default settings, the user name is admin, the password is password, the LAN IP address is 192.168.0.1 (which is the same as www.routerlogin.net and www.routerlogin.com), and the DHCP server is enabled. For a list of factory default settings, see Factory Settings on page 284.

Use the Reset Button

**CAUTION:**
This process erases all settings that you configured in the modem router.

- **To reset the modem router to factory default settings:**
  1. On the back of the modem router, locate the **Reset** button.
  2. Using a straightened paper clip, press and hold the **Reset** button for eight seconds.
  3. Release the **Reset** button.
The configuration is reset to factory default settings. When the reset is complete, the modem router reboots. This process takes about one minute.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the reset. For example, if you are connected to the web management interface, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

**Erase the Settings**

**CAUTION:**

This process erases all settings that you configured in the modem router.

- **To erase the settings:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the **OK** button.
     The BASIC Home page displays.
  5. Select **ADVANCED > Administration > Backup Settings**.
     The Backup Settings page displays.
  6. Click the **Erase** button.
  7. To confirm the action, click the **Yes** button.
     The configuration is reset to factory default settings. When the reset is complete, the modem router reboots. This process takes about one minute.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the reset. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.
View the Status and Statistics of the Modem Router

You can view information about the modem router, its broadband modem, and ports, and the status of the Internet connection and WiFi network. In addition, you can view traffic statistics for the various ports.

View Information About the Modem Router and the Internet, Modem, and WiFi Settings

You can view modem router information, the Internet port status, and WiFi settings.

➢ To view information about the modem router and the Internet, modem, and WiFi settings:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
The information onscreen uses the following color coding:

- A green flag ✅ indicates that the Internet port is configured correctly and connected to the Internet or that a WiFi network is up and enabled.
- A red X ❌ indicates that the Internet port is not configured and cannot get an Internet connection or that a WiFi network is down or disabled.
- An amber exclamation mark ⚠️ indicates that the Internet port is configured but cannot get an Internet connection (for example, because the cable is disconnected), that a WiFi network is enabled but unprotected, or that another situation that requires your attention occurred.

The following table describes the fields of the six panes on the ADVANCED Home page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Router Information</strong></td>
<td></td>
</tr>
<tr>
<td>Hardware Version</td>
<td>The modem router model.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>The version of the modem router firmware. If you upgrade the firmware in the modem router, the version changes.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GUI Language Version</td>
<td>The version of the modem router firmware. If you upgrade the firmware on</td>
</tr>
<tr>
<td></td>
<td>modem router, the version changes.</td>
</tr>
<tr>
<td>LAN Port</td>
<td>The settings of the LAN port. For information about how to configure the</td>
</tr>
<tr>
<td></td>
<td>LAN settings, see Manage the Modem Router's LAN IP Address Settings on page</td>
</tr>
<tr>
<td></td>
<td>205 and Disable the Built-In DHCP Server on page 213.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The Media Access Control (MAC) address. This address is the unique physical</td>
</tr>
<tr>
<td></td>
<td>address that is assigned to the Ethernet LAN port.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the Ethernet LAN port uses. The default IP address is</td>
</tr>
<tr>
<td></td>
<td>192.168.0.1.</td>
</tr>
<tr>
<td>DHCP</td>
<td>Displays whether the DHCP server of the modem router is enabled for devices</td>
</tr>
<tr>
<td></td>
<td>that are attached to the LAN.</td>
</tr>
<tr>
<td>Internet Port</td>
<td>The settings of Internet port. The Internet connection can run through the</td>
</tr>
<tr>
<td></td>
<td>DSL port with ADSL or VDSL service or through the WAN Ethernet port with</td>
</tr>
<tr>
<td></td>
<td>cable or fiber service. For information about how to configure the Internet</td>
</tr>
<tr>
<td></td>
<td>settings, see one of the following sections:</td>
</tr>
<tr>
<td></td>
<td>• Set Up Your Modem Router for DSL Service on page 21</td>
</tr>
<tr>
<td></td>
<td>• Set Up Your Modem Router for Cable or Fiber Service on page 29</td>
</tr>
<tr>
<td></td>
<td>• Manually Set Up an ADSL Internet Connection on page 47</td>
</tr>
<tr>
<td></td>
<td>• Manually Set Up a VDSL Internet Connection on page 57</td>
</tr>
<tr>
<td></td>
<td>• Manually Set Up a Cable of Fiber Internet Connection on page 66</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The Media Access Control (MAC) address. This address is the unique physical</td>
</tr>
<tr>
<td></td>
<td>address that is assigned to the Internet port.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the Internet port uses. If this field does not display</td>
</tr>
<tr>
<td></td>
<td>an address or displays 0.0.0.0 as the address, the modem router is not</td>
</tr>
<tr>
<td></td>
<td>connected to the Internet.</td>
</tr>
<tr>
<td>Connection</td>
<td>The type of Internet connection, which can be a PPPoE connection, PPPoA</td>
</tr>
<tr>
<td></td>
<td>connection, fixed IP address connection, or DHCP connection.</td>
</tr>
<tr>
<td>IP Subnet Mask</td>
<td>The IP subnet mask that the Internet port uses.</td>
</tr>
<tr>
<td>Domain Name Server</td>
<td>The IP address of the Domain Name System (DNS) server that the Internet</td>
</tr>
<tr>
<td></td>
<td>uses.</td>
</tr>
<tr>
<td>Wireless Settings (2.4GHz)</td>
<td>The settings of the WiFi port for the 2.4 GHz band of the main network.</td>
</tr>
<tr>
<td></td>
<td>For information about how to configure the settings of the main network,</td>
</tr>
<tr>
<td></td>
<td>see Manage the Basic WiFi Settings and WiFi Security of the Main Network on</td>
</tr>
<tr>
<td></td>
<td>page 93, Control the WiFi Radios on page 110, and Manage Advanced WiFi</td>
</tr>
<tr>
<td></td>
<td>Features on page 115.</td>
</tr>
<tr>
<td>Name (SSID)</td>
<td>The WiFi network name for the 2.4 GHz band of the main network.</td>
</tr>
<tr>
<td>Region</td>
<td>The location (country).</td>
</tr>
<tr>
<td>Channel</td>
<td>The channel that the 2.4 GHz band of the main network uses.</td>
</tr>
<tr>
<td>Mode</td>
<td>The WiFi mode in which the 2.4 GHz band operates for both the main network</td>
</tr>
<tr>
<td></td>
<td>and the guest network.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Wireless AP</td>
<td>Displays whether the 2.4 GHz band of the main network is enabled. If the 2.4 GHz band is disabled but the 5 GHz band is enabled, the WiFi LED on the front of the modem router lights blue. If both radios are off, the WiFi LED is off.</td>
</tr>
<tr>
<td>Broadcast Name</td>
<td>Displays whether the 2.4 GHz band of the main network broadcasts its SSID.</td>
</tr>
<tr>
<td>Wi-Fi Protected Setup</td>
<td>Displays whether the modem router keeps its existing WiFi settings when you use WPS to connect a device to the 2.4 GHz band of the main network:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configured</strong>. The modem router keeps its existing WiFi settings. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Not configured</strong>. The modem router generates a random SSID and passphrase and changes the security mode to WPA/WPA2-PSK mixed mode.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Manage the WPS Settings</em> on page 114.</td>
</tr>
</tbody>
</table>

### Wireless Settings (5GHz)

The settings of the WiFi port for the 5 GHz band of the main network. For information about how to configure the settings of the main network, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 93, *Control the WiFi Radios* on page 110, and *Manage Advanced WiFi Features* on page 115.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (SSID)</td>
<td>The WiFi network name for the 5 GHz band of the main network.</td>
</tr>
<tr>
<td>Region</td>
<td>The location (country).</td>
</tr>
<tr>
<td>Channel</td>
<td>The channel that the 5 GHz band of the main network uses.</td>
</tr>
<tr>
<td>Mode</td>
<td>The WiFi mode in which the 5 GHz band operates for both the main network and the guest network.</td>
</tr>
<tr>
<td>Wireless AP</td>
<td>Displays whether the 5 GHz band of the main network is enabled.</td>
</tr>
<tr>
<td></td>
<td>If the 5 GHz band is disabled but the 2.4 GHz band is enabled, the WiFi LED on the front of the modem router lights blue. If both radios are off, the WiFi LED is off.</td>
</tr>
<tr>
<td>Broadcast Name</td>
<td>Displays whether the 5 GHz band of the main network broadcasts its SSID.</td>
</tr>
<tr>
<td>Wi-Fi Protected Setup</td>
<td>Displays whether the modem router keeps its existing WiFi settings when you use WPS to connect a device to the 5 GHz band of the main network:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Configured</strong>. The modem router keeps its existing WiFi settings. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Not configured</strong>. The modem router generates a random SSID and passphrase and changes the security mode to WPA/WPA2-PSK mixed mode.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Manage the WPS Settings</em> on page 114.</td>
</tr>
</tbody>
</table>

### Guest Network (2.4 GHz)

The settings of the WiFi port for the 2.4 GHz band of the guest network. For information about how to configure the settings of the guest network, see *Manage the Basic WiFi Settings and WiFi Security of the Guest Network* on page 105.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (SSID)</td>
<td>The WiFi network name for the 2.4 GHz band of the guest network.</td>
</tr>
</tbody>
</table>
You can view the traffic statistics for the ports of the modem router, change the polling frequency, and stop traffic polling.

To view the traffic statistics for the ports of the modem router:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home page displays.
6. In the Internet Port pane, click the Show Statistics button.
The following table describes the fields and columns of the Show Statistics pop-up window.

<table>
<thead>
<tr>
<th>Field or Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Up Time</td>
<td>The time elapsed since the modem router was last restarted.</td>
</tr>
<tr>
<td>Port</td>
<td>The statistics for the WAN (Internet over Ethernet) port, LAN (Ethernet) ports, WLAN b/g/n ports, and WLAN a/n/ac ports. For each port, the page displays the information that is described in this table.</td>
</tr>
<tr>
<td>Status</td>
<td>The link status of the port.</td>
</tr>
<tr>
<td>TxPkts</td>
<td>The number of packets transmitted on this port since reset or manual clear.</td>
</tr>
<tr>
<td>RxPkt</td>
<td>The number of packets received on this port since reset or manual clear.</td>
</tr>
<tr>
<td>Collisions</td>
<td>The number of signal collisions that occurred on the port. A collision occurs when the port attempts to send data at the same time as the device that is connected to the port.</td>
</tr>
<tr>
<td>Tx B/s</td>
<td>The number of bytes transmitted per second on the port.</td>
</tr>
<tr>
<td>Rx B/s</td>
<td>The number of bytes received per second on the port.</td>
</tr>
<tr>
<td>Up Time</td>
<td>The time elapsed since this port acquired the link.</td>
</tr>
<tr>
<td>ADSL Link</td>
<td>The interval at which the statistics are updated on this page.</td>
</tr>
<tr>
<td>Connection Speed</td>
<td>The downstream and upstream data rates in Kbps.</td>
</tr>
<tr>
<td>Line Attenuation</td>
<td>The downstream and upstream line attenuation (LATN) in dB. The LATN expresses the signal quality.</td>
</tr>
<tr>
<td>Noise Margin</td>
<td>The downstream and upstream signal-to-noise-margin (SNRM) in dB. The SNRM expresses the signal quality in relation to interference.</td>
</tr>
</tbody>
</table>
To change the traffic statistics polling frequency or stop polling:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and
   password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home page displays.
6. In the Internet Port pane, click the Show Statistics button.
   A pop-up window displays.
7. Change the polling frequency or stop polling:
   - To change the polling frequency:
     a. In the Poll Interval field, enter a time in seconds.
     b. Click the Set Interval button.
   - To stop polling, click the Stop button.

View, Renew, or Release a TCP/IP Internet Connection
You can view information about a TCP/IP Internet connection of the modem router and renew
or release such a connection. This information displays only if the modem router connects to the
ISP network over a TCP/IP connection (see Specify a Cable or Fiber Connection Without a
Login Requirement on page 66).

To view the TCP/IP Internet connection status or renew or release the TCP/IP Internet
connection:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and
   password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home page displays.

6. In the Internet Port pane, click the Connection Status button.
   The fields that display depend on the type of Internet connection.
   The following pop-up window shows the fields for an established TCP/IP connection with DHCP.

   ![Connection Status](image)

   The following table describes the fields of the Connection Status pop-up window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address that is assigned by the ISP to the modem router.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>The subnet mask that is assigned by the ISP to the modem router.</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>The IP address of the default gateway of the ISP that the modem router</td>
</tr>
<tr>
<td></td>
<td>communicates with.</td>
</tr>
<tr>
<td>DHCP Server</td>
<td>The IP address of the DHCP server of the ISP that issues the IP address to</td>
</tr>
<tr>
<td></td>
<td>the modem router.</td>
</tr>
<tr>
<td>DNS Server</td>
<td>The IP address of the Domain Name System (DNS) server of the ISP that</td>
</tr>
<tr>
<td></td>
<td>provides translation of network names to IP addresses.</td>
</tr>
<tr>
<td>Lease Obtained</td>
<td>The time at which the modem router obtained the DHCP lease. (The type of</td>
</tr>
<tr>
<td></td>
<td>DHCP connection determines whether this field displays onscreen.)</td>
</tr>
<tr>
<td>Lease Expires</td>
<td>The time at which the DHCP lease expires. (The type of DHCP connection</td>
</tr>
<tr>
<td></td>
<td>determines whether this field displays onscreen.)</td>
</tr>
</tbody>
</table>

7. To renew the Internet connection when the connection is active, click the Renew button.
8. To terminate the Internet connection when the connection is active, click the Release button.
9. Click the Close Window button.
   The pop-up window closes.
View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection

You can view information about a PPPoE or PPPoA Internet connection of the modem router and establish or terminate such a connection. This information displays only if the modem router connects to the ISP network over a PPPoE connection or PPPoA connection. The following sections describe Internet connections that use PPPoe and PPPoA:

- Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service on page 52
- Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 61
- Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service on page 71

To view the PPPoE or PPPoA Internet connection status or connect or disconnect the PPPoE or PPPoA Internet connection:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home. The ADVANCED Home page displays.
6. In the Internet Port pane, click the Connection Status button. The Connection Status pop-up window displays. The fields that display depend on the type of connection (PPPoE or PPPoA).

The following table describes the fields of the Connection Status pop-up window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Time</td>
<td>The time elapsed since the connection was established.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>The status can be Connected or Disconnected.</td>
</tr>
<tr>
<td>Negotiation</td>
<td>The negotiation can be a series of dashes, which indicates that the connection is not established, or successful (Success).</td>
</tr>
<tr>
<td>Authentication</td>
<td>The authentication can be a series of dashes, which indicates that the connection is not established, or successful (Success).</td>
</tr>
</tbody>
</table>
7. To establish the Internet connection when the connection is down, click the **Connect** button.
8. To terminate the Internet connection when the connection is active, click the **Disconnect** button.
9. Click the **Close Window** button.
   The pop-up window closes.

### Manage the Activity Log

The log is a detailed record of the websites that users on your network accessed or attempted to access and many other modem router actions. Up to 256 entries are stored in the log. You can also manage which activities are logged.

### View and Manage the Log

- To view and manage the log:
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login window opens.
  3. Enter the modem router user name and password.
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
     The BASIC Home page displays.
  4. Select **ADVANCED > Administration > Logs**.
The Logs page shows the following information:

- **Action.** The action that occurred, such as whether Internet access was blocked or allowed.
- **Source.** The name, IP address, or MAC address of the target device, application, or website for this log entry.
- **Target.** The name, IP address, or MAC address of the target device, application, or website for this log entry.
- **Date and time.** The date and time at which the action occurred.

5. To refresh the log page, click the **Refresh** button.
6. To clear the log entries, click the **Clear Log** button.
7. To email the log immediately, click the **Send Log** button.

The modem router emails the logs to the address that you specified (see *Set Up Security Event Email Notifications* on page 138).
Specify Which Activities Are Logged

You can specify which activities are logged. These activities display in the log.

- To manage which activities are logged:
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the OK button.
     The BASIC Home page displays.
  5. Select **ADVANCED > Administration > Logs**.
     The Logs page displays.
  6. Scroll down and select the check boxes that correspond to the activities that you want to be logged.
     By default, all check boxes are selected.
  7. Clear the check boxes that correspond to the activities that do not want to be logged.
  8. Click the Apply button.
     Your settings are saved.

View Devices Currently on the Network

You can view the active wired devices, 2.4 GHz WiFi devices, and 5 GHz WiFi devices in the network. If you do not recognize a device, it might be an intruder. If it is an intruder, make sure that your WiFi security is set up correctly (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93) or set up access control to secure your network (see Allow or Block Access to Your Network on page 121).

- To display the wired and WiFi devices:
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login window opens.
  3. Enter the user name and password for the modem router.
     The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the OK button.
The BASIC Home page displays.

5. Select **Attached Devices**.

The Attached Devices page displays.

Wired devices are connected to the modem router with Ethernet cables. WiFi devices are connected to the modem router through the WiFi network, either in the 2.4 GHz band or the 5 GHz band.

The following table describes the fields on the Attached Devices page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The access control status (Allowed or Blocked).</td>
</tr>
<tr>
<td>Device Name</td>
<td>The device name, if detected.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the modem router assigned to the device when it joined the network. This address can change when a device is disconnected and rejoins the network.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The unique MAC address of the device. The MAC address does not change and is usually shown on the product label.</td>
</tr>
<tr>
<td>Connection Type</td>
<td>The type of connection for the device (Wired or Wireless).</td>
</tr>
</tbody>
</table>

6. To refresh the information onscreen, click the **Refresh** button.

The information onscreen is updated.

**Monitor and Meter Internet Traffic**

Traffic metering allows you to monitor the volume of Internet traffic that passes through the modem router Internet port. With the traffic meter utility, you can set limits for traffic volume, set a monthly limit, and get a live update of traffic usage.

**Start the Traffic Meter Without Traffic Volume Restrictions**

You can monitor the traffic volume without setting a limit.

➢ **To start or restart the traffic meter without configuring traffic volume restrictions:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.

   A login window opens.
3. Enter the user name and password for the modem router.

   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Traffic Meter**.

6. Select the **Enable Traffic Meter** check box.

   The buttons, fields, and check boxes on the page become available.

   By default, no traffic limit is specified and the traffic volume is not controlled.

7. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

8. If you want the traffic counter to start immediately, click the **Restart Counter Now** button.

9. Click the **Apply** button.

   Your settings are saved and the WiFi connection restarts. Any WiFi devices that were connected to the network must reconnect.

   The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see **View the Traffic Statistics and Traffic Status** on page 239.

**View the Traffic Statistics and Traffic Status**

If you enabled the traffic meter (see **Start the Traffic Meter Without Traffic Volume Restrictions** on page 238), you can view the traffic statistics and traffic status.

- **To view the traffic statistics and status of the traffic meter:**

  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.

     A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home page displays.

5. Select ADVANCED > Advanced Setup > Traffic Meter.
   The Traffic Meter page displays.


![Internet Traffic Statistics Table]

The Internet Traffic Statistics section displays when the traffic counter was started and what the traffic balance is. The table displays information about the connection time and traffic volume in MB.

7. To refresh the information onscreen, click the Refresh button.
   The information onscreen is updated.

8. To display more information about the data traffic and to change the polling interval, click the Traffic Status button.
   The Traffic Status pop-up window displays.

Restrict Internet Traffic by Volume
You can record and restrict the traffic by volume in MB. This is useful when your ISP measures your traffic in volume.

➢ To record and restrict the Internet traffic by volume:
   1. Launch a web browser from a computer or WiFi device that is connected to the network.
   2. Type http://www.routerlogin.net.
      A login window opens.
3. Enter the user name and password for the modem router.

The user name is \textit{admin}. The default password is \texttt{password}. The user name and password are case-sensitive.

4. Click the \texttt{OK} button.

The BASIC Home page displays.

5. Select \texttt{ADVANCED > Advanced Setup > Traffic Meter}. 

6. Select the \texttt{Enable Traffic Meter} check box.

7. Select the \texttt{Traffic volume control by} radio button.

The buttons, fields, and check boxes on the page become available.

By default, no traffic limit is specified and the traffic volume is not controlled.

8. From the corresponding menu, select an option:
   - \texttt{Download only}. The restriction is applied to incoming traffic only.
   - \texttt{Both directions}. The restriction is applied to both incoming and outgoing traffic.

9. In the \texttt{Monthly limit} field, enter how many MBytes (MB) per month are allowed.

10. If your ISP charges you for extra data volume when you make a new connection, enter the extra data volume in MB in the \texttt{Round up data volume for each connection by} field.

11. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

12. In the Traffic Control section, enter a value in minutes to specify when the modem router issues a warning message before the monthly limit in hours is reached.

   This setting is optional. The modem router issues a warning when the balance falls under the minutes that you enter. By default, the value is 0 and no warning message is issued.
13. Select one or more of the following actions to occur when the limit is reached:
   • **Turn the Internet LED to flashing green/amber.** This setting is optional. When the traffic limit is reached, the Internet LED blinks alternating green and amber.
   • **Disconnect and disable the Internet connection.** This setting is optional. When the traffic limit is reached, the Internet connection is disconnected and disabled.

14. Click the **Apply** button.

   Your settings are saved and the WiFi connection restarts. Any WiFi devices that were connected to the network must reconnect.

   The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see **View the Traffic Statistics and Traffic Status** on page 239.

### Restrict Internet Traffic by Connection Time

You can record and restrict the traffic by connection time. This is useful when your ISP measures your connection time.

➢ **To record and restrict the Internet traffic by time:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.

   A login window opens.

3. Enter the user name and password for the modem router.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

   The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Traffic Meter**.
6. Select the **Enable Traffic Meter** check box.

The buttons, fields, and check boxes on the page become available. By default, no traffic limit is specified and the traffic volume is not controlled.

7. Select the **Connection time control** radio button.

    **Note:** The modem router must be connected to the Internet for you to be able to select the **Connection time control** radio button.

8. In the **Monthly limit** field, enter how many hours per month are allowed.

    **Note:** The modem router must be connected to the Internet for you to be able to enter information in the **Monthly limit** field.

9. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

10. In the Traffic Control section, enter a value in minutes to specify when the modem router issues a warning message before the monthly limit in hours is reached.

    This setting is optional. The modem router issues a warning when the balance falls under the minutes that you enter. By default, the value is 0 and no warning message is issued.

11. Select one or more of the following actions to occur when the limit is reached:

    - **Turn the Internet LED to flashing green/amber.** This setting is optional. When the traffic limit is reached, the Internet LED alternates blinking green and amber.
    - **Disconnect and disable the Internet connection.** This setting is optional. When the traffic limit is reached, the Internet connection is disconnected and disabled.

12. Click the **Apply** button.

    Your settings are saved.
The Internet Traffic Statistics section helps you to monitor the data traffic. For more information, see View the Traffic Statistics and Traffic Status on page 239.

**Unblock the Traffic Meter After the Traffic Limit Is Reached**

If you configured the traffic meter to disconnect and disable the Internet connection after the traffic limit is reached, you cannot access the Internet until you unblock the traffic meter.

> **CAUTION:**
> If your ISP set a traffic limit, your ISP might charge you for the overage traffic.

➢ To unblock the traffic meter:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Traffic Meter.
   The Traffic Meter page displays.
6. In the Traffic Control section, clear the Disconnect and disable the Internet connection check box.
7. Click the Apply button.
   Your settings are saved.

**Manage the Modem Router Remotely**

The remote management feature lets you access your modem router securely over the Internet to view or change its settings. You must know the modem router’s WAN IP address to use this feature. For information about remote access using Dynamic DNS, see Chapter 8, Access Storage Devices Through the Internet.
Note: Be sure to change the password for the user name admin to a secure password. The ideal password contains no dictionary words from any language and contains uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters. See Change the admin Password on page 37.

➢ To set up remote management:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Remote Management.

6. Select the Turn Remote Management On check box.
7. In the Allow Remote Access By section, specify the external IP addresses to be allowed to access the modem router’s remote management.

Note: For enhanced security, restrict access to as few external IP addresses as practical.
Select one of the following radio buttons and configure the options accordingly:

- To allow access from a single IP address on the Internet, select the **Only This Computer** radio button. Enter the IP address to be allowed access.
- To allow access from a range of IP addresses on the Internet, select the **IP Address Range** radio button. Enter a beginning and ending IP address to define the allowed range.
- To allow access from any IP address on the Internet, select the **Everyone** radio button. This radio button is selected by default.

8. Specify the port number for accessing the web management interface.

The default port number is 8443, which is a common alternate for HTTPS. For greater security, enter a custom port number for the remote web management interface. Choose a number from 1024 to 65535, but do not use the number of any common service port.

9. Click the **Apply** button.

Your settings are saved.

➢ To use remote access:

1. Launch a web browser on a computer that is not on your home network.
2. Enter your modem router’s WAN IP address into your browser’s address or location field followed by a colon (:) and the custom port number.

   For example, if your external address is 100.168.110.147 and you use port number 8443, enter `https://100.168.110.147:8443` in your browser.

**Remotely Access the Modem Router Using the genie App**

The genie app allows you to remotely access the modem router and change its key settings using the genie app that is installed on a computer or mobile device. Before you can use the remote genie feature, you must update your modem router’s firmware to the latest firmware and download the latest genie app for your computers or mobile device. To download the latest genie app for your computer or mobile device, visit [www.NETGEAR.com/genie](http://www.NETGEAR.com/genie).

For more information about how to set up remote access using the genie app, visit [http://kb.netgear.com/app/answers/detail/a_id/26253/](http://kb.netgear.com/app/answers/detail/a_id/26253/).

**Configure the Modem Router as a DSL Modem Only**

By default, the modem router functions both as a modem and a router. You can change the operation mode to a mode in which the modem router functions as a DSL modem only with the routing, firewall, wireless support, and traffic meter features disabled.

A typical use of such a mode is when the modem router is used for DSL connectivity only behind a router, firewall, or security device manager that provides routing, firewall, wireless support, and traffic meter features.
To configure the modem router as a DSL modem only:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Device Mode.
   The Device Mode page displays.
6. From the Device Mode menu, select Modem (Modem Only).
   The default selection is Router (Modem + Router).
7. Click the Apply button.
   Your settings are saved. The modem router restarts in modem-only mode.
You can use OpenVPN software to remotely access your modem router using virtual private networking (VPN). This chapter explains how to set up and use VPN access.

This chapter includes the following sections:

- **Set Up a VPN Connection**
- **Use VPN to Access the Modem Router’s USB Device and Media**
- **Use VPN to Access Your Internet Service at Home**
Set Up a VPN Connection

A virtual private network (VPN) lets you use the Internet to securely access your network when you are not home. This type of VPN access is called a client-to-gateway tunnel. The computer is the client, and the modem router is the gateway. To use the VPN feature, you must log in to the modem router and enable VPN, and you must install and run VPN client software on the computer.

Note: The modem router does not support iOS or Android VPN client software.

VPN uses DDNS or a static IP address to connect with your modem router.

To use a DDNS service, register for an account with a host name (sometimes called a domain name). You use the host name to access your network. The modem router supports these accounts: NETGEAR, No-IP, and Dyn. See Set Up and Manage Dynamic DNS on page 174.

If your Internet service provider (ISP) assigned a static WAN IP address (such as 50.196.x.x or 10.x.x.x) that never changes to your Internet account, the VPN can use that IP address to connect to your home network.

Specify VPN Service in the Modem Router

You must specify the VPN service settings in the modem router before you can use a VPN connection.

➢ To specify the VPN service:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   
   A login window opens.
3. Enter the modem router user name and password.
   
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > VPN Service.
   
   The VPN Service page displays.
6. Select the Enable VPN Service check box.
   
   By default, the VPN uses the UDP service type and uses port 12974. If you want to customize the service type and port, NETGEAR recommends that you change these settings before you install the OpenVPN software.
7. To change the service type, scroll down and select the TCP radio button.
8. To change the port, scroll down to the Service Port field, and type the port number that you want to use.

   **Note:** For information about configuring the type of access, see Use VPN to Access Your Internet Service at Home on page 254.

9. Click the Apply button.
   
   Your changes are saved. VPN is enabled in the modem router, but you must install and set up OpenVPN software on your computer before you can use a VPN connection (see Install OpenVPN Software on Your Computer on page 250).

### Install OpenVPN Software on Your Computer

You must install this software on each computer that you plan to use for VPN connections to your modem router.

- **To install VPN client software:**
  2. In the Windows Installer section of the page, double-click the openVPN-install-xxx.exe link.
  3. Download the file.
  4. To install the Open VPN software on your computer, click the openVPN-install-xxx.exe file.

   ![OpenVPN installation wizard](image)

   5. Click the Next button.
   6. Read the License Agreement and click the I Agree button.
7. Leave the check boxes selected as shown in the previous figure, and click the **Next** button.

8. To specify the destination folder, click the **Browse** button, select a destination folder, and click the **Next** button.

9. Click the **Install** button.

   The page displays the progress of the installation and then displays the final installation page.

10. Click the **Finish** button.
11. Unzip the configuration files that you downloaded and copy them to the folder where the VPN client is installed on your device.

For a client device with Windows 64-bit system, the VPN client is installed at C:\Program files\OpenVPN\config\ by default.

12. For a client device with Windows, modify the VPN interface name to NETGEAR-VPN:
   a. In Windows, select Start > Control Panel > Network and Internet > Network Connections.
   b. In the local area connection list, find the local area connection with the device name TAP-Windows Adapter.
   c. Select the local area connection and change its name (not its device name) to NETGEAR-VPN.

If you do not change the VPN interface name, the VPN tunnel connection will fail.

Use a VPN Tunnel

After you set up the modem router to use VPN and install the OpenVPN application on your computer, you can open a VPN tunnel from your computer to your modem router over the Internet.

For the VPN tunnel to work, the local LAN IP address of the remote router must use a different LAN IP scheme from that of the local LAN where your VPN client computer is connected. If both networks use the same LAN IP scheme, when the VPN tunnel is established, you cannot access your home router or your home network with the OpenVPN software.

The default LAN IP address scheme for the modem router is 192.x.x.x. The most common IP schemes are 192.x.x.x, 172.x.x.x, and 10.x.x.x. If you experience a conflict, change the IP scheme either for your home network or for the network with the client VPN computer. For information about changing these settings, see Manage the Modem Router’s LAN IP Address Settings on page 205.

➢ To open a VPN tunnel:

1. Launch the OpenVPN application with administrator privileges.
The **OpenVPN** icon displays in the Windows taskbar.

**Tip:** You can create a shortcut to the VPN program, then use the shortcut to access the settings and select the **run as administrator** check box. Then every time you use this shortcut, OpenVPN automatically runs with administrator privileges.

2. Right-click the **OpenVPN** icon.

3. Select **Connect**.

   The VPN connection is established. You can do the following:
   - Launch a web browser and log in to your modem router.
   - Use Windows file manager to access the modem router’s USB device and download files.

**Use VPN to Access the Modem Router’s USB Device and Media**

➢ To access a USB device and download files:

1. In Windows file manager, select the **Network** folder.
The network resources display. The ReadySHARE icon is in the Computer section and the remote ReadyDLNA: D6400 icon is in the Media Devices section (if DLNA is enabled in the modem router).

2. If the icons do not display, click the Refresh button to update the page.

If the local LAN and the remote LAN are using the same IP scheme, the remote ReadyDLNA: D6400 icon does not display in the Media Devices section and the D6400 (Gateway) icon does not display in the Network Infrastructure section.

3. To access the USB device, click the ReadySHARE icon.
4. To access media on the modem router’s network, click the ReadyDLNA: D6400 icon.

Use VPN to Access Your Internet Service at Home

When you are away from home and you access the Internet, you usually use a local Internet service provider. For example, at a coffee shop you might be given a code that lets you use the coffee shop’s Internet service account to surf the web.

The modem router lets you use a VPN connection to access your own Internet service when you are away from home. You might want to do this if you travel to a geographic location that does not support all the Internet services that you use at home. For example, your Netflix account might work at home but not in a different country.

Set Up VPN Client Internet Access in the Modem Router

By default, the modem router is set up to allow VPN connections only to your home network but you can change the setting to allow Internet access. Accessing the Internet remotely through a VPN might be slower than accessing the Internet directly.

➢ To allow VPN clients to use your home Internet service:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > VPN Service.
   The VPN page displays.
6. Select the Enable VPN Service radio button.
Use VPN to Access Your Network

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

7. Scroll down to the Clients will use this VPN connection to access section, and select the **All sites on the Internet & Home Network** radio button.

When you access the Internet with the VPN connection, instead of using a local Internet service, you use the Internet service from your home network.

**Note:** By default, the **Auto** radio button is selected. The Auto option uses an automatic detection system that enables VPN access only for necessary services and sites and might not include full Internet access.

8. Click the **Apply** button.

Your settings are saved.

9. Click the **For Windows** or **For Non Windows** button and download the configuration files for your VPN clients.

10. Unzip the configuration files and copy them to the folder where the VPN client is installed on your device.

    For a client device with Windows 64-bit system, the VPN client is installed at `C:\Program files\OpenVPN\config\` by default.

**Block VPN Client Internet Access in the Modem Router**

By default, the modem router is set up to allow VPN connections only to your home network, not to the Internet service for your home network. If you changed this setting to allow Internet access, you can change it back.

- **To allow VPN clients to access only your home network:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     
     A login window opens.
  3. Enter the modem router user name and password.
     
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
  4. Click the **OK** button.
     
     The BASIC Home page displays.
  5. Select **ADVANCED > Advanced Setup > VPN Service**.
     
     The VNP page displays.
  6. Select the **Enable VPN Service** radio button.
  7. Scroll down to the Clients will use this VPN connection to access section, and select the **Home Network only** radio button.
  8. Click the **Apply** button.

Your settings are saved.
9. Click For Windows or For Non Windows button and download the configuration files for your VPN clients.

10. Unzip the configuration files and copy them to the folder where the VPN client is installed on your device.

For a client device with Windows 64-bit system, the VPN client is installed at C:\Program files\OpenVPN\config\ by default.

Use a VPN Tunnel to Access Your Internet Service at Home

➢ To access your Internet service:

1. Set up the modem router to allow VPN access to your Internet service.
   See Set Up VPN Client Internet Access in the Modem Router on page 254.

2. On your computer, launch the OpenVPN application.
   The OpenVPN icon displays in the Windows taskbar.

3. Right-click the icon and select Connect.

4. When the VPN connection is established, launch your web browser.
Manage Port Forwarding and Port Triggering

You can use outbound firewall rules, port forwarding, and port triggering to set up rules for Internet traffic for services and applications. You need networking knowledge to set up these features.

This chapter includes the following sections:

- Manage Port Forwarding to a Local Server for Services and Applications
- Manage Port Triggering for Services and Applications
Manage Port Forwarding to a Local Server for Services and Applications

If a server is part of your network, you can allow certain types of incoming traffic to reach the server. For example, you might want to make a local web server, FTP server, or game server visible and available to the Internet.

The modem router can forward incoming traffic with specific protocols to computers on your local network. You can specify the servers for applications and you can also specify a default DMZ server to which the modem router forwards all other incoming protocols (see Set Up a Default DMZ Server on page 202).

Forward Incoming Traffic for a Default Service or Application

You can forward traffic for a default service or application to a computer on your network.

➢ To forward incoming traffic for a default service or application:

1. Decide which type of service, application, or game you want to provide.
2. Find the local IP address of the computer on your network that will provide the service.
   The server computer must always receive the same IP address. To specify this setting, use the reserved IP address feature. See Manage Reserved LAN IP Addresses on page 208.
3. Launch a web browser from a computer or WiFi device that is connected to the network.
4. Type http://www.routerlogin.net.
   A login window opens.
5. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
6. Click the OK button.
   The BASIC Home page displays.
7. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
8. Make sure that the Port Forwarding radio button is selected.

9. From the Service Name menu, select the service or application.
   
   If the service or application that you want to add is not in the menu, create a port forwarding rule with a custom service or application (see Add a Port Forwarding Rule with a Custom Service or Application on page 259).

10. In the Server IP Address field, enter the IP address of the computer that must provide the service or that runs the application.

11. Click the Add button.

   Your settings are saved. The rule is added to the table on the Port Forwarding / Port Triggering page.

---

Add a Port Forwarding Rule with a Custom Service or Application

The modem router lists default services and applications that you can use in port forwarding rules. If the service or application is not predefined, you can add a port forwarding rule with a custom service or application.

➢ To add a port forwarding rule with a custom service or application:

1. Find out which port number or range of numbers the service or application uses.

   You can usually find this information by contacting the publisher of the service or application or through user groups or news groups.

2. Launch a web browser from a computer or WiFi device that is connected to the network.
3. Type http://www.routerlogin.net. 
   A login window opens.
4. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
5. Click the OK button.
   The BASIC Home page displays.
6. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering page displays.
7. Make sure that the Port Forwarding radio button is selected.
8. Click the Add Custom Service button.

9. Specify a new port forwarding rule with a custom service or application as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>Enter the name of the custom service or application.</td>
</tr>
<tr>
<td>Service Type</td>
<td>Select the protocol (TCP or UDP) that is associated with the service or application. If you are unsure, select TCP/UDP.</td>
</tr>
<tr>
<td>External Starting Port</td>
<td>Enter the external start port number that the service or application uses.</td>
</tr>
<tr>
<td>External Ending Port</td>
<td>Enter the external end port number that the service or application uses.</td>
</tr>
<tr>
<td>Internal Starting Port</td>
<td>Specify the internal start port by one of these methods:</td>
</tr>
<tr>
<td></td>
<td>• Leave the Use the same port range for Internal port check box selected.</td>
</tr>
<tr>
<td></td>
<td>• Clear the Use the same port range for Internal port check box and enter the internal start port number that the service or application uses.</td>
</tr>
</tbody>
</table>
10. Click the **Apply** button.
   
   Your settings are saved. The rule is added to the table on the Port Forwarding / Port Triggering page.

### Change a Port Forwarding Rule

You can change an existing port forwarding rule.

- **To change a port forwarding rule:**
  1. Launch a web browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.

     A login window opens.
  3. Enter the user name and password for the modem router.

     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
  4. Click the **OK** button.

     The BASIC Home page displays.
  5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.

     The following figure shows two port forwarding rules.
6. Make sure that the **Port Forwarding** radio button is selected.

7. In the table, select the radio button next to the service or application name.

8. Click the **Edit Service** button.

   The Ports - Custom Services page displays.

9. Change the settings.

   For more information about the settings, see *Add a Port Forwarding Rule with a Custom Service or Application* on page 259.

10. Click the **Apply** button.

    Your settings are saved. The changed rule displays in the table on the Port Forwarding / Port Triggering page.

### Remove a Port Forwarding Rule

You can remove a port forwarding rule that you no longer need.

To remove a port forwarding rule:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.

   A login window opens.
3. Enter the user name and password for the modem router.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.
   The following figure shows two port forwarding rules.

6. Make sure that the **Port Forwarding** radio button is selected.

7. In the table, select the radio button next to the service or application name.

8. Click the **Delete Service** button.
   The rule is removed from the table.

**Application Example: Make a Local Web Server Public**

If you host a web server on your local network, you can use port forwarding to allow web requests from anyone on the Internet to reach your web server.

➢ **To make a local web server public:**

1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP address reservation.
   In this example, your modem router always gives your web server an IP address of 192.168.1.55.

2. On the Port Forwarding / Port Triggering page, configure the modem router to forward the HTTP service to the local address of your web server at **192.168.1.55**.
   HTTP (port 80) is the standard protocol for web servers.
3. (Optional) Register a host name with a Dynamic DNS service, and specify that name on the Dynamic DNS page of the modem router.

Dynamic DNS makes it much easier to access a server from the Internet because you can enter the name in the web browser. Otherwise, you must know the IP address that the ISP assigned, which typically changes.

**How the Modem Router Implements the Port Forwarding Rule**

The following sequence shows the effects of a port forwarding rule:

1. When you enter the URL www.example.com in your browser, the browser sends a web page request message with the following destination information:
   - **Destination address.** The IP address of www.example.com, which is the address of your modem router.
   - **Destination port number.** 80, which is the standard port number for a web server process.

2. The modem router receives the message and finds your port forwarding rule for incoming port 80 traffic.

3. The modem router changes the destination in the message to IP address 192.168.1.123 and sends the message to that computer.

4. Your web server at IP address 192.168.1.123 receives the request and sends a reply message to your modem router.

5. Your modem router performs Network Address Translation (NAT) on the source IP address and sends the reply through the Internet to the computer or WiFi device that sent the web page request.

**Manage Port Triggering for Services and Applications**

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

- An application must use port forwarding to more than one local computer (but not simultaneously).
- An application must open incoming ports that are different from the outgoing port.

With port triggering, the modem router monitors traffic to the Internet from an outbound “trigger” port that you specify. For outbound traffic from that port, the modem router saves the IP address of the computer that sent the traffic. The modem router temporarily opens the incoming port or ports that you specify in your rule and forwards that incoming traffic to that destination.

Port forwarding creates a static mapping of a port number or range of ports to a single local computer. Port triggering can dynamically open ports to any computer when needed and close the ports when they are no longer needed.
Add a Port Triggering Rule

The modem router does not provide default services and applications for port triggering rules. You must define a custom service or application for each port triggering rule.

➢ To add a port triggering rule:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering page displays.
6. Select the Port Triggering radio button.
7. Click the Add Service button.

8. Specify a new port triggering rule with a custom service or application as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>Enter the name of the custom service or application.</td>
</tr>
</tbody>
</table>
| Service User   | From the Service User menu, select Any, or select Single address and enter the IP address of one computer:  
|                | • Any. This is the default setting and allows any computer on the Internet to use this service.  
|                | • Single address. Restricts the service to a particular computer.           |
| Service Type   | Select the protocol (TCP or UDP) that is associated with the service or application. |
Manage Port Forwarding and Port Triggering

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Change a Port Triggering Rule

9. Click the **Apply** button.

   Your settings are saved. The rule is added to the Port Triggering Portmap Table on the Port Forwarding / Port Triggering page and is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggering Port</td>
<td>Enter the number of the outbound traffic port that must open the inbound ports.</td>
</tr>
<tr>
<td><strong>Inbound Connection</strong></td>
<td></td>
</tr>
<tr>
<td>Connection Type</td>
<td>Select the protocol (<strong>TCP</strong> or <strong>UDP</strong>) that is associated with the inbound connection. If you are unsure, select <strong>TCP/UDP</strong>.</td>
</tr>
<tr>
<td>Starting Port</td>
<td>Enter the start port number for the inbound connection.</td>
</tr>
<tr>
<td>Ending Port</td>
<td>Enter the end port number for the inbound connection.</td>
</tr>
</tbody>
</table>

**Field**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggering Port</td>
<td>Enter the number of the outbound traffic port that must open the inbound ports.</td>
</tr>
<tr>
<td><strong>Inbound Connection</strong></td>
<td></td>
</tr>
<tr>
<td>Connection Type</td>
<td>Select the protocol (<strong>TCP</strong> or <strong>UDP</strong>) that is associated with the inbound connection. If you are unsure, select <strong>TCP/UDP</strong>.</td>
</tr>
<tr>
<td>Starting Port</td>
<td>Enter the start port number for the inbound connection.</td>
</tr>
<tr>
<td>Ending Port</td>
<td>Enter the end port number for the inbound connection.</td>
</tr>
</tbody>
</table>

**To change a port triggering rule:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.
   
   The Port Forwarding / Port Triggering page displays.
6. Select the **Port Triggering** radio button.
   
   The following figure shows two port triggering rules.
7. In the Port Triggering Portmap Table, select the radio button next to the service or application name.
8. Click the **Edit Service** button.
   The Port Triggering - Services page displays.
9. Change the settings.
   For more information about the settings, see *Add a Port Triggering Rule* on page 265.
10. Click the **Apply** button.
    Your settings are saved. The changed rule displays in the Port Triggering Portmap Table on the Port Forwarding / Port Triggering page.

**Disable or Remove a Port Triggering Rule**

You can disable or remove a port triggering rule that you no longer need.

➢ **To disable or remove a port triggering rule:**
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
The BASIC Home page displays.

5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.

The Port Forwarding / Port Triggering page displays.

6. Select the **Port Triggering** radio button.

The following figure shows two port triggering rules.

![Port Forwarding / Port Triggering Page](image)

7. To disable the rule, do the following:
   a. In the Enable column of the Port Triggering Portmap Table, clear the check box next to the service or application name.
   b. Click the **Apply** button.

   Your settings are saved.

8. To remove the rule entirely, do the following:
   a. In the Port Triggering Portmap Table, select the radio button next to the service or application name.
   b. Click the **Delete Service** button.

   The rule is removed from the Port Triggering Portmap Table.

### Specify the Time-Out Period for Port Triggering

The time-out period for port triggering controls how long the inbound ports stay open when the modem router detects no activity. A time-out period is required because the modem router cannot detect when the service or application terminates.
To specify the time-out for port triggering:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering page displays.
6. Select the Port Triggering radio button.
   The port triggering settings display.
7. In the Port Triggering Time-out field, enter a value up to 9999 minutes.
   The default setting is 20 minutes.
8. Click the Apply button.
   Your settings are saved.

Disable Port Triggering

By default, port triggering is enabled. You can disable port triggering temporarily without removing any port triggering rules.

To disable port triggering:
1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering page displays.
6. Select the Port Triggering radio button.
The port triggering settings display.

7. Select the **Disable Port Triggering** check box.
   
   If this check box is selected, the modem router does not apply port triggering rules even if you specified them.

8. Click the **Apply** button.
   
   Your settings are saved.

**Application Example: Port Triggering for Internet Relay Chat**

Some application servers, such as FTP and IRC servers, send replies to multiple port numbers. Using port triggering, you can tell the modem router to open more incoming ports when a particular outgoing port starts a session.

An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at destination port 6667. The IRC server not only responds to your originating source port but also sends an "identify" message to your computer on port 113. Using port triggering, you can tell the modem router, "When you initiate a session with destination port 6667, you must also allow incoming traffic on port 113 to reach the originating computer."

The following sequence shows the effects of this port triggering rule:

1. You open an IRC client program to start a chat session on your computer.
2. Your IRC client composes a request message to an IRC server using a destination port number of 6667, the standard port number for an IRC server process. Your computer then sends this request message to your modem router.
3. Your modem router creates an entry in its internal session table describing this communication session between your computer and the IRC server. Your modem router stores the original information, performs Network Address Translation (NAT) on the source address and port, and sends this request message through the Internet to the IRC server.
4. Noting your port triggering rule and observing the destination port number of 6667, your modem router creates another session entry to send any incoming port 113 traffic to your computer.
5. The IRC server sends a return message to your modem router using the NAT-assigned source port (for example, port 33333) as the destination port and the IRC server also sends an “identify” message to your modem router with destination port 113.
6. When your modem router receives the incoming message to destination port 33333, it checks its session table to see if a session is active for port number 33333. Finding an active session, the modem router restores the original address information replaced by NAT and sends this reply message to your computer.
7. When your modem router receives the incoming message to destination port 113, it checks its session table and finds an active session for port 113 associated with your computer. The modem router replaces the message’s destination IP address with your computer’s IP address and forwards the message to your computer.
8. When you finish your chat session, your modem router eventually senses a period of inactivity in the communications. The modem router then removes the session information from its session table, and incoming traffic is no longer accepted on port numbers 33333 or 113.
This chapter provides information to help you diagnose and solve problems you might experience with your modem router. If you do not find the solution here, check the NETGEAR support site at support.netgear.com for product and contact information.

This chapter contains the following sections:

- Quick Tips for Troubleshooting
- Troubleshoot with the LEDs
- You Cannot Log In to the Modem Router
- Troubleshoot the Internet Connection
- Changes Are Not Saved
- Troubleshoot the WiFi Connectivity
- Troubleshoot Your Network Using the Ping Utility
Quick Tips for Troubleshooting

The following table includes tips for troubleshooting some common problems.

Table 4. Quick tips for troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your network is unresponsive or does not function normally.</td>
<td>Restart your network:</td>
</tr>
<tr>
<td></td>
<td>1. Turn off and unplug the DSL, cable, or fiber modem.</td>
</tr>
<tr>
<td></td>
<td>2. Turn off the modem router.</td>
</tr>
<tr>
<td></td>
<td>3. Plug in the DSL, cable, or fiber modem and turn it on. Wait two minutes.</td>
</tr>
<tr>
<td></td>
<td>4. Turn on the modem router and wait two minutes.</td>
</tr>
<tr>
<td></td>
<td>If network problems still occur, make sure that your ISP does not require you to use the MAC address of the computer that was used to initially register the ISP account. If your ISP does require that you do this, you must change the modem router MAC address that the modem router uses. For more information, see one of the following sections:</td>
</tr>
<tr>
<td></td>
<td>• <a href="#">Manually Set Up an ADSL Internet Connection</a> on page 47</td>
</tr>
<tr>
<td></td>
<td>• <a href="#">Manually Set Up a VDSL Internet Connection</a> on page 57</td>
</tr>
<tr>
<td></td>
<td>• <a href="#">Manually Set Up a Cable of Fiber Internet Connection</a> on page 66</td>
</tr>
<tr>
<td>Your cannot connect over an Ethernet cable to the modem router.</td>
<td>• Make sure that the Ethernet cables are securely plugged in.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that your computer or device does not use a static IP address but is configured to receive an IP address automatically with DHCP. (For most devices, DHCP is the default setting.)</td>
</tr>
<tr>
<td>You cannot connect over WiFi to the modem router.</td>
<td>• Make sure that the WiFi settings in your WiFi device and modem router match exactly.</td>
</tr>
<tr>
<td></td>
<td>For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of the modem router and WiFi computer must match exactly. The default SSID and password are on the product label (see <a href="#">Bottom Panel Product Label</a> on page 15).</td>
</tr>
<tr>
<td></td>
<td>• Make sure that your WiFi device supports the security that you are using for your WiFi network (WEP, WPA, or WPA2). For information about WiFi security settings, see <a href="#">Manage the Basic WiFi Settings and WiFi Security of the Main Network</a> on page 93.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the modem router is not too far from your WiFi device or too close:</td>
</tr>
<tr>
<td></td>
<td>- Move your WiFi device near the modem router but at least 6 feet (1.8 meters) away and see if the signal strength improves.</td>
</tr>
<tr>
<td></td>
<td>- Make sure that the WiFi signal is not blocked by objects between the modem router and your WiFi device.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the WiFi LED on the modem router is not off.</td>
</tr>
<tr>
<td></td>
<td>If this LED is off, both WiFi radios might be disabled. For more information about the WiFi radios, see <a href="#">Control the WiFi Radios</a> on page 110.</td>
</tr>
</tbody>
</table>
Troubleshooting

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Table 4. Quick tips for troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot connect over WiFi to the modem router. (continued)</td>
<td>• Make sure that the modem router’s SSID broadcast is not disabled. If the modem router’s SSID broadcast is disabled, the WiFi network name is hidden and does not display in your WiFi device’s scanning list. To connect to a hidden network, you must enter the network name and the WiFi password. For more information about the SSID broadcast, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93. • Make sure that your WiFi device does not use a static IP address but is configured to receive an IP address automatically with DHCP. (For most devices, DHCP is the default setting.)</td>
</tr>
</tbody>
</table>

Troubleshoot with the LEDs

When you turn on the power, the LEDs light as described here.

1. When power is first applied, the Power LED lights solid amber 🕛.
2. After about 50 seconds, the following occurs:
   • The Power LED lights solid green 🕛, indicating that the startup procedure finished.
   • The WiFi LED lights solid blue 🌈, indicating the WiFi network is available.
3. After approximately one minute, the DSL LED blinks green 🚄 to indicate that the modem router is negotiating the best possible speed on the DSL line. If the negotiation completes and a DSL link is established, the LED turns solid green. If you do not use a DSL modem but a cable or fiber modem, the LED remains off.
4. When the DSL, cable, or fiber connection is established, the Internet LED blinks amber 🕛. When an Internet connection is established, the Internet LED lights solid green 🕛.

Note: Whether the USB LED 🔄 lights depends on whether a USB device is connected to one of the USB ports.

Power LED Remains Solid Amber

When you turn on the modem router, the Power LED turns solid amber 🕛. After about 50 seconds, the Power LED lights solid green 🕛, indicating that the startup procedure finished. If the LED still does not turn green after two minutes, a power-on self-test (POST) failure occurred or the modem router is malfunctioning.

If the Power LED does not turn green, do the following:

1. Turn the power off and back on to see if the modem router recovers.
2. If the Power LED still does not turn green, reset the modem router to factory default settings.

For more information, see Use the Reset Button on page 224.
If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware problem, contact technical support at netgear.com/support.

**Power LED Is Off**

If the Power LED and other LEDs remain off when you turn on the modem router, do the following:

- Check that the Power On/Off button on the back is in the on position, that is, it is pushed in.
- Check that the power cord is correctly connected to your modem router and that the power supply adapter is correctly connected to a functioning power outlet.
- Check that you are using the 12 VDC 2.5A power adapter that NETGEAR supplied for this product.

If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware problem, contact technical support at netgear.com/support.

**WiFi LED Is Off**

If the WiFi LED stays off, check to see if both radios on the modem router are disabled (see [Control the WiFi Radios](page 110)). By default, both radios are enabled and the WiFi LED lights solid blue.

**You Cannot Log In to the Modem Router**

If you are unable to log in to the modem router from a computer on your local network and use the modem router’s web pages, check the following:

- If you are using an Ethernet-connected computer, check the Ethernet connection between the computer and the modem router.
- If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.0.2–192.168.0.254 range.
- Make sure that your computer can reach the modem router’s DHCP server. Recent versions of Windows and Mac OS generate and assign an IP address if the computer cannot reach a DHCP server. These autogenerated addresses are in the range of 169.254.x.x. If your IP address is in this range, check the connection from the computer to the modem router and reboot your computer.
- If your modem router’s IP address was changed and you do not know the current IP address, use an IP scanner application to detect the IP address. If you still cannot find the IP address, clear the modem router’s configuration to factory defaults. This sets the modem router’s IP address to 192.168.0.1. For more information, see [Return the Modem Router to Its Factory Default Settings](page 224) and [Factory Settings](page 284).
• Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using Internet Explorer, click the **Refresh** button to be sure that the Java applet is loaded.
• Try quitting the browser and launching it again.
• Make sure that you are using the correct login information. The user name is **admin**, and the default password is **password**. Make sure that Caps Lock is off when you enter this information.
• If you are attempting to set up your modem router behind an existing router in your network, set up the modem router as a WiFi access point (see *Use the Modem Router as a WiFi Access Point* on page 117).

**Troubleshoot the Internet Connection**

If your modem router cannot access the Internet, check the DSL connection, then the WAN TCP/IP connection.

**Troubleshoot the DSL Link**

If your modem router is unable to access the Internet, first determine whether the DSL link with the service provider is working. The DSL LED indicates the state of this connection.

**DSL LED Is Green**

If the DSL link LED lights green 🟥, the ADSL connection is good. You can be confident that the service provider connected your line correctly and that your wiring is correct.

**DSL LED Is Blinking Green**

If the DSL LED is blinking green 🌈, your modem router is attempting to make a DSL (ADSL or VDSL) connection with the service provider. If the modem router establishes a DSL connection, the DSL LED turns solid green. This connection process generally lasts several minutes.

If the DSL LED does not turn solid green, disconnect all telephones on the line. If this solves the problem, reconnect the telephones one at a time, being sure to use a microfilter on each telephone. If the microfilters are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a green DSL LED, a problem with your wiring might exist. If the telephone company tested the ADSL or VDSL signal at your network interface device (NID), then wiring in your house might be of poor quality.

**DSL LED Is Off or Internet LED Is Off**

If the DSL LED is off 🟥, the Internet LED is off 🌈, or both are off, disconnect all telephones on the line. If this solves the problem, reconnect the telephones one at a time, being sure to use a microfilter on each telephone. If the microfilters are connected correctly, you can connect all your telephones.
If disconnecting telephones does not result in a green DSL LED, check the following:

- Check that the telephone company made the connection to your line and tested it.
- Verify that you are connected to the correct telephone line. If more than one phone line is installed, be sure that you are connected to the line with the ADSL or VDSL service. It might be necessary to use a swapper if your ADSL or VDSL signal is on pins 1 and 4 or the RJ-11 jack. The modem router uses pins 2 and 3.

**Internet LED Is Off**

If the Internet LED is off, the modem router cannot connect to the Internet. Verify the following:

- Check that your login credentials are correct or that the information you entered for the ISP connection is correct. For more information, see one of the following sections:
  - Manually Set Up an ADSL Internet Connection on page 47
  - Manually Set Up a VDSL Internet Connection on page 57
  - Manually Set Up a Cable of Fiber Internet Connection on page 66
- Check to see if your ISP is experiencing a problem—it might not be that the modem router cannot connect to the Internet, but rather that your ISP cannot provide an Internet connection.

**Obtain an Internet IP Address**

If the modem router cannot access the Internet but the Internet LED is green, see if the modem router can obtain an Internet IP address from the ISP. Unless the modem router is assigned a static IP address, the modem router requests an IP address from the ISP. You can determine whether the request was successful using the modem router’s web pages.

➢ To check the Internet IP address:

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login window opens.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home page displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home page displays.
6. In the Internet Port pane, check that the IP Address field shows a valid IP address.
   If the field shows 0.0.0.0, your modem router did not obtain an IP address from your ISP.
If your modem router cannot obtain an IP address from the ISP, the problem might be one of the following:

- Your Internet service provider (ISP) might require a login program. Ask your ISP whether they require PPP over Ethernet (PPPoE) or some other type of login.
- If you selected a login program, the service name, user name, or password might be incorrectly set. For more information, see Troubleshoot PPPoE or PPPoA on page 278.
- Your ISP might check for your computer's host name. Assign the computer host name of your ISP account as the account name. For more information, see one of the following sections:
  - Manually Set Up an ADSL Internet Connection on page 47
  - Manually Set Up a VDSL Internet Connection on page 57
  - Manually Set Up a Cable of Fiber Internet Connection on page 66
- If your ISP allows only one Ethernet MAC address to connect to Internet and checks for your computer's MAC address, inform your ISP that you bought a new network device and ask them to use the modem router's MAC address.
- Configure your modem router to clone your computer's MAC address. For more information, see one of the following sections:
  - Manually Set Up an ADSL Internet Connection on page 47
  - Manually Set Up a VDSL Internet Connection on page 57
  - Manually Set Up a Cable of Fiber Internet Connection on page 66

**Troubleshoot PPPoE or PPPoA**

If you use a PPPoE or PPPoA connection to your ISP, make sure that the connection works.

➢ **To verify that your PPPoE or PPPoA connection is working:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**. A login window opens.
3. Enter the user name and password for the modem router. The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button. The BASIC Home page displays.
5. Select **ADVANCED > ADVANCED Home**. The ADVANCED Home page displays.
6. In the Internet Port pane, check that the IP Address field shows a valid IP address and that the Connection field shows PPPoE or PPPoA.

7. In the Internet Port pane, click the **Connection Status** button.
   
   The Connection Status pop-up window displays.

8. Check the following:
   - The Connection Status field shows Connected.
   - The Connection Time field does not show 00:00:00.

If all of the information is correct, your PPPoE or PPPoA connection is working.

➤ **To reconnect if your PPPoE or PPPoA connection does not function:**

1. Launch a web browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   
   A login window opens.
3. Enter the user name and password for the modem router.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home page displays.
5. Select **ADVANCED > ADVANCED Home**.
   
   The ADVANCED Home page displays.
6. In the Internet Port pane, click the **Connection Status** button.
   
   The Connection Status pop-up window displays.
7. Click the **Connect** button.
   
   The modem router attempts to reconnect.

If you cannot connect after several minutes, you might be using an incorrect service name, user name, or password. Or your ISP might not be able to provide an Internet connection.

Unless you connect manually, the modem router does not authenticate using PPPoE or PPPoA until data is transmitted to the network.

**Troubleshoot Internet Browsing**

If your modem router can obtain an IP address but your computer is unable to load any web pages from the Internet, it might be for one of the following reasons:

- The traffic meter is enabled, and the limit was reached.

By configuring the traffic meter not to block Internet access when the traffic limit is reached, you can resume Internet access (see **Unblock the Traffic Meter After the Traffic Limit Is Reached** on page 244). If your ISP sets a usage limit, they might charge you for the overage.
• Your computer might not recognize any DNS server addresses.

A DNS server is a host on the Internet that translates Internet names (such as www addresses) to numeric IP addresses. Typically your ISP provides the addresses of one or two DNS servers for your use. If you entered a DNS address when you set up the modem router, reboot your computer and verify the DNS address. Alternatively, you can configure your computer manually with DNS addresses, as explained in your operating system documentation.

• The modem router might not be configured as the TCP/IP router on your computer.

For information about TCP/IP problems, see Troubleshoot Your Network Using the Ping Utility on page 281.

If your computer obtains its information from the modem router by DHCP, reboot the computer and verify the modem router address.

Changes Are Not Saved

If the modem router does not save the changes that you make on the modem router’s web pages, do the following:

• When entering configuration settings, always click the Apply button before moving to another page or tab or your changes are lost.

• Click the Refresh or Reload button in the web browser. It is possible that the changes occurred but that the old settings remain in the web browser’s cache.

Troubleshoot the WiFi Connectivity

If you are experiencing trouble connecting over WiFi to the modem router, try to isolate the problem:

• Make sure that the WiFi settings in your WiFi device and modem router match exactly.

For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of the modem router and WiFi computer must match exactly. The default SSID and password are on the product label (see Bottom Panel Product Label on page 15).

• Does the WiFi device that you are using find your WiFi network?

If not, check the WiFi LED on the front of the modem router. If this LED is off, both WiFi radios might be disabled. For more information about the WiFi radios, see Control the WiFi Radios on page 110.

• If you disabled the modem router’s SSID broadcast, your WiFi network is hidden and does not display in your WiFi client’s scanning list. (By default, SSID broadcast is enabled.) For more information, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93.
• Does your WiFi device support the security that you are using for your WiFi network (WEP, WPA, or WPA2)? For information about changing the WiFi security, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 93.

**Tip:** If you want to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

If your WiFi device finds your network but the signal strength is weak, check these conditions:

• Is your modem router too far from your WiFi device or too close? Place your WiFi device near the modem router but at least 6 feet (1.8 meters) away and see whether the signal strength improves.

• Are objects between the modem router and your WiFi device blocking the WiFi signal?

### Troubleshoot Your Network Using the Ping Utility

Most network devices and routers contain a ping utility that sends an echo request packet to the designated device. The device then responds with an echo reply. You can easily troubleshoot a network using the ping utility in your computer or workstation.

#### Test the LAN Path to Your Modem Router

You can ping the modem router from your computer to verify that the LAN path to your modem router is set up correctly.

**To ping the modem router from a Windows computer:**

1. From the Windows taskbar, click the **Start** button and select **Run**.
2. In the field provided, enter `ping` followed by the IP address of the modem router, as in this example:
   
   ping 192.168.0.1

3. Click the **OK** button.

A message such as the following one displays:

Pinging <IP address> with 32 bytes of data

If the path is working, you see this message:

Reply from < IP address >: bytes=32 time=NN ms TTL=xxx

If the path is not working, you see this message:

Request timed out
If the path is not functioning correctly, one of the following problems might be occurring:

- **Wrong physical connections**
  For a wired connection, make sure that the numbered LAN port LED is lit for the port to which you are connected.
  
  Check that the appropriate LEDs are on for your network devices. If your modem router and computer are connected to a separate Ethernet switch, make sure that the link LEDs are lit for the switch ports that are connected to your computer and modem router.

- **Wrong network configuration**
  Verify that the Ethernet card driver software and TCP/IP software are both installed and configured on your computer.
  
  Verify that the IP address for your modem router and your computer are correct and that the addresses are on the same subnet.

---

**Test the Path from Your Computer to a Remote Device**

After you verify that the LAN path works correctly, test the path from your computer to a remote device:

1. From the Windows toolbar, click the **Start** button and select **Run**.
2. In the field provided, enter `ping -n 10 IP address`
   where `IP address` is the IP address of a remote device such as your ISP’s DNS server.

If the path is functioning correctly, replies as described in *Test the LAN Path to Your Modem Router* on page 281 display. If you do not receive replies, do the following:

- Check that the IP address of your modem router is listed as the default router in your computer. If the IP configuration of your computer is assigned by DHCP, this information is not visible in your computer’s Network Control Panel. Verify that the IP address of the modem router is listed as the default router.
- Check that the network address of your computer (the portion of the IP address specified by the netmask) is different from the network address of the remote device.
- If your ISP assigned a host name to your computer, enter that host name as the account name (see *Manually Set Up an ADSL Internet Connection* on page 47).
- Your ISP might be rejecting the Ethernet MAC addresses of all but one of your computers.

Many broadband ISPs restrict access by allowing traffic only from the MAC address of your modem, but some additionally restrict access to the MAC address of a single computer connected to that modem. In this case, configure your modem router to clone or spoof the MAC address from the authorized computer (see *Manually Set Up an ADSL Internet Connection* on page 47).
Supplemental Information

This appendix covers the following topics:

- Factory Settings
- Technical Specifications
Factory Settings

You can reset the modem router to the factory default settings that are shown in the following table.

For more information about resetting the modem router to its factory settings, see Return the Modem Router to Its Factory Default Settings on page 224.

Table 5. D6400 modem router factory default settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Router login</strong></td>
<td></td>
</tr>
<tr>
<td>User name (case-sensitive)</td>
<td>admin</td>
</tr>
<tr>
<td>Login password (case-sensitive)</td>
<td>password</td>
</tr>
<tr>
<td><strong>Internet connection</strong></td>
<td></td>
</tr>
<tr>
<td>WAN MAC address</td>
<td>Use default hardware address</td>
</tr>
<tr>
<td>WAN MTU size</td>
<td>1500</td>
</tr>
<tr>
<td>Port speed</td>
<td>Autosensing</td>
</tr>
<tr>
<td><strong>Local network (LAN)</strong></td>
<td></td>
</tr>
<tr>
<td>LAN IP address</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>DHCP server</td>
<td>Enabled</td>
</tr>
<tr>
<td>DHCP range</td>
<td>192.168.0.2 to 192.168.0.254</td>
</tr>
<tr>
<td>DHCP starting IP address</td>
<td>192.168.0.2</td>
</tr>
<tr>
<td>DHCP ending IP address</td>
<td>192.168.0.254</td>
</tr>
<tr>
<td>DMZ</td>
<td>Disabled</td>
</tr>
<tr>
<td>Time zone</td>
<td>• North America: Pacific Standard Time</td>
</tr>
<tr>
<td></td>
<td>• Europe: GMT</td>
</tr>
<tr>
<td></td>
<td>• Other continents: Varies by region</td>
</tr>
<tr>
<td>Time adjusted for daylight saving time</td>
<td>Disabled</td>
</tr>
<tr>
<td><strong>Main WiFi network</strong></td>
<td></td>
</tr>
<tr>
<td>WiFi communication</td>
<td>Enabled</td>
</tr>
<tr>
<td>SSID name</td>
<td>See product label</td>
</tr>
<tr>
<td>SSID broadcast</td>
<td>Enabled</td>
</tr>
<tr>
<td>Security</td>
<td>WPA2-PSK (AES)</td>
</tr>
</tbody>
</table>
Table 5. D6400 modem router factory default settings (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>WiFi network key (passphrase)</td>
<td>See product label</td>
</tr>
<tr>
<td>Country/region</td>
<td>• North America: United States</td>
</tr>
<tr>
<td></td>
<td>• Europe: Europe</td>
</tr>
<tr>
<td></td>
<td>• Other continents: Varies by region</td>
</tr>
<tr>
<td>RF channel</td>
<td>Auto. The available channels depend on the region.</td>
</tr>
<tr>
<td>Transmission speed</td>
<td>Auto&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>Operating mode</td>
<td>• Up to 300 Mbps at 2.4 GHz</td>
</tr>
<tr>
<td></td>
<td>• Up to 1300 Mbps at 5 GHz</td>
</tr>
<tr>
<td>Guest WiFi network</td>
<td></td>
</tr>
<tr>
<td>WiFi communication</td>
<td>Disabled</td>
</tr>
<tr>
<td>SSID name</td>
<td>• 2.4 GHz band: NETGEAR-Guest</td>
</tr>
<tr>
<td></td>
<td>• 5 GHz band: NETGEAR-5G-Guest</td>
</tr>
<tr>
<td>SSID broadcast</td>
<td>Enabled</td>
</tr>
<tr>
<td>Security</td>
<td>None (open network)</td>
</tr>
<tr>
<td>Allow guests to access main network</td>
<td>Disabled</td>
</tr>
<tr>
<td>General WiFi settings</td>
<td></td>
</tr>
<tr>
<td>Radio transmission power</td>
<td>100 percent, nonconfigurable</td>
</tr>
<tr>
<td>20/40 MHz coexistence</td>
<td>Enabled</td>
</tr>
<tr>
<td>Fragmentation length</td>
<td>2346</td>
</tr>
<tr>
<td>CTS/RTS threshold</td>
<td>2347</td>
</tr>
<tr>
<td>Preamble mode</td>
<td>Long Preamble</td>
</tr>
<tr>
<td>WPS</td>
<td></td>
</tr>
<tr>
<td>WPS capability</td>
<td>Enabled</td>
</tr>
<tr>
<td>Modem router’s PIN</td>
<td>Enabled, see the modem router’s web pages (path ADVANCED &gt; Advanced Setup &gt; Wireless Settings)</td>
</tr>
<tr>
<td>Keep Existing Wireless Settings</td>
<td>Enabled</td>
</tr>
</tbody>
</table>

<sup>1</sup> Maximum WiFi signal rate derived from IEEE Standard 802.11 specifications. Actual throughput can vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate.
### Technical Specifications

#### Table 6. D6400 modem router specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data and routing protocols</td>
<td>TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, PPTP, Bigpond, Dynamic DNS, UPnP, and SMB</td>
</tr>
<tr>
<td>Power adapter</td>
<td>• North America: 120V, 60 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• UK, Australia: 240V, 50 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• Europe: 230V, 50 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• All regions: 12V @ 2.5 A output</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Dimensions: 191 mm x 198.5 mm x 65 mm (7.5 in. x 7.8 in. x 2.6 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>Weight: 422 g (0.93 lb)</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>0° to 40°C (32º to 104ºF)</td>
</tr>
<tr>
<td>Operating humidity</td>
<td>90% maximum relative humidity, noncondensing</td>
</tr>
<tr>
<td>Electromagnetic emissions</td>
<td>• EN 55022:2010/AC:2011, Class B</td>
</tr>
<tr>
<td></td>
<td>• CISPR 22:2008, Class B</td>
</tr>
<tr>
<td></td>
<td>• AS/NZS CISPR 22:2009/Amdt 1:2010, Class B</td>
</tr>
<tr>
<td>LAN</td>
<td>Four RJ-45 LAN ports supporting 10BASE-T, 100BASE-TX, and 1000BASE-T</td>
</tr>
<tr>
<td>WAN</td>
<td>One RJ-45 Internet port supporting 10BASE-T, 100BASE-TX, and 1000BASE-T</td>
</tr>
<tr>
<td>DSL</td>
<td>One RJ-11 DSL port for ADSL or VDSL service</td>
</tr>
<tr>
<td>WiFi</td>
<td>Maximum WiFi signal rate complies with the IEEE 802.11 standard. See the</td>
</tr>
<tr>
<td></td>
<td>footnote for the table in Factory Settings on page 284.</td>
</tr>
<tr>
<td>Radio data rates</td>
<td>Auto-rate sensing</td>
</tr>
<tr>
<td>Data encoding standards</td>
<td>• IEEE 802.11ac 2.0</td>
</tr>
<tr>
<td></td>
<td>• IEEE 802.11n version 2.0</td>
</tr>
<tr>
<td></td>
<td>• IEEE 802.11n 256QAM IEEE 802.11g, IEEE 802.11b 2.4 GHz</td>
</tr>
<tr>
<td></td>
<td>• IEEE 802.11n, IEEE 802.11a 5.0 GHz</td>
</tr>
<tr>
<td>Maximum computers per WiFi network</td>
<td>Limited by the amount of WiFi network traffic generated by each node (typically 50–70 nodes).</td>
</tr>
</tbody>
</table>
### Table 6. D6400 modem router specifications (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Operating frequency range | - 2.4 GHz band  
- US: 2.412–2.462 GHz  
- Europe: 2.412–2.472 GHz  
- Australia: 2.412–2.472 GHz  
- Japan: 2.412–2.472 GHz  
- 5 GHz band  
- US: 5.18–5.24 + 5.745–5.825 GHz  
- Europe: 5.18–5.24 GHz and DFS (5.25–5.35 + 5.47–5.725, excluding 5.60–5.65)  
- Australia: 5.18–5.24 + 5.745–5.825 GHz and DFS (5.25–5.35 + 5.47–5.725, excluding 5.60–5.65)  
- Japan: 5.18–5.24 GHz |
| 802.11 security          | WPA2-PSK, WPA/WPA2, WPA/WPA2 Enterprise, and WEP |
| xDSL data rate           | - VDSL2, VDSL, ADSL2+, ADSL2, and ADSL multimode  
- Up to 100 Mbps, both upstream and downstream  
- Supports Annex A, I, L, and M  
- Supports all VDSL2 profiles: 8a, 8b, 8c, 8d, 12a, 12b, and 17a  
- Supports G.INP  
- Enables Seamless Rate Adaptation (SRA)  
- VDSL2 interface compliance with ITU-T993.2  
- G.992.1 (G.dmt), Annex A compliant  
- G.992.2 (G.lite), Annex A compliant  
- ANSI T1.413 compliant  
- G.992.3 (ADSL2) compliant, Annex A, L, and M  
- G.992.5 (ADSL2+) compliant, supporting Annex A and M  
- G.993.2 compliant, Annex A  
- G.993.5 (Vectoring)  
- ATM and PTM (dual-priority) |